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Introduction

Introduction
This document explains how to configure Cisco Unified Workforce Optimization Quality
Management in Cisco Unified CCX environment.
Cisco Unified Workforce Optimization Quality Management (Quality Management) is a
comprehensive recording solution that addresses the common needs for recording customer
interactions—whether it is for compliance, quality management, or both.
The Quality Management Administrator User Guide contains the information you need to
successfully configure Quality Management Administrator, including:
n

Assigning user roles

n

Setting up groups

n

Creating evaluation forms, manage evaluation forms

n

Setting up workflows for recording customer contacts

n

Setting up recording archiving

n

Maintaining the Quality Management system

Quality Management Administrator controls how devices are configured, calls are recorded,
and who has access to Call Recording and Quality Management.
Call Recording provides a solution to record all calls—commonly done to meet regulatory
compliance requirements or to handle customer disputes. Call Recording makes the task of
recording, archiving, and retrieving 100% of customer calls more manageable in the following
ways:
n

An organization can choose to record all calls for everyone, or for specific teams of
agents and knowledge workers configured in the system

n

Archive parameters are flexible and storage is secure

n

Advanced query options let users find recordings quickly and easily among thousands of
logged interactions

Quality Management helps businesses refine their processes and improve their bottom line in
the following ways:
n

Increase revenue by improving customer satisfaction and increasing customer loyalty

n

Provide consistent, high-quality customer experiences
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n

Identify customer needs and expectations

n

Reduce labor costs for agent identifications

Getting Started
This topic provides the essential information for accessing Quality Management Administrator,
synchronizing the databases, and understanding the automated update feature.

Logging into Quality Management Administrator
This task describes how to log in to Quality Management Administrator.
Quality Management Administrator is installed on the Quality Management Base Services
server by default during a normal install. You can also install it on a client desktop, the Client
Desktop Application Deployment Guide for more information.
1. Choose Start > All Programs >Cisco > WFO >Quality Management Administrator.
The Administrator Login dialog box appears.

2. Complete the dialog box as follows, and then click OK or press the Enter key.
l

In a non-Active Directory environment, type administrator in the User Name field
and the password that was set up during system installation in the Password
field.
Note: The username, administrator, is a default username. You cannot
change it. The Username field is not case sensitive and the Password field
is case sensitive.

l

In an Active Directory environment, type an AD Account username in the User
Name field, the password associated with the AD Account user in the Password
field, and the domain that is associated with AD Account user in the Domain field.
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Note: The Username field is not case sensitive but the Password and
Domain fields are case sensitive.
Quality Management Administrator validates your login credentials.

Changing the Administrator Password
This feature only allows you to change the administrator password in a non-Active Directory
environment.
The administrator password must be between 1 and 32 alphanumeric characters long. The
password is case sensitive. The password should remain confidential. If your password is no
longer confidential, change the password.
n

From the menu bar, choose Settings > Change Administrator Password, complete the
fields in the Change Password dialog box, and then click OK.

Synchronizing Databases
Teams, agents, supervisors, and devices must be set up in Unified CCX before you can
synchronize the Unified CCX database with the Quality Management database.
Quality Management automatically synchronizes the following databases at 10-minute
intervals.
n

Unified CCX database

n

Quality Management database

Use this task if you need to manually synchronize the databases.
n

On the menu bar, choose File > Synchronize Databases.
The synchronization process starts. While the process is running, Quality Management
changes the menu option from Synchronize Databases to Synchronize Databases
(Running) and disables the option.
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Note: You might see a Microsoft Windows Security Alert saying that the
Windows Firewall blocked Java(TM) 2 Platform Standard Edition (SE) binary. To
add an exception for this binary, click Unblock and try again.
When the process is complete, Quality Management returns the menu option to
Synchronize Databases and enables the option.

Logging Out of Quality Management Administrator
n

To log out and leave Quality Management Administrator running, choose File > Log Off,
and then click OK.
You are logged out of Quality Management Administrator and the application remains
available.

n

To log back in when Quality Management Administrator is running, choose File > Administrator Login, type administrator in the User Name field and the administrator password
in the Password field, and then click OK.

n

To log out and close Quality Management Administrator, choose File > Exit or click the
Close

in the upper right corner of the window.

Automated Updates
You can enable automated updates in Quality Management. When a newer version of Quality
Management is installed on the servers, the automated update feature updates all instances of
the client applications (Quality Management Administrator and Desktop Recording service)
when you start a client application. A dialog box notifies you that your instance of Quality
Management Administrator will be updated. Click OK and follow the prompts.
Note: If the automated update process is running, do not start another client application.
If you do, another instance of the automated update process might start.
When the update completes, click OK, and then restart the client application.
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Note: If you cancel an update, the update fails. However, you still see a message that
the upgrade has completed. The next time you start the client application, the automated
update process runs again.
Depending on the version you are upgrading from, Quality Management might not allow you to
use automated updates. When automated updates are not allowed, you will see the following
message on the client desktop:
You are trying to update to a version that does not
allow over the top updates.
Automated update logs are located on the client desktop in the following folder:
n

Windows XP: C:\Documents and Settings\<username>\Local Settings\Temp\Calabrio
Quality Management Software Update Log.txt

n

Windows 7: C:\Users\<username>\AppData\Local\Temp\Calabrio Quality
Management Software Update Log.txt

n

Windows 8.1: C:\Users\<username>AppData\Local\Temp\Calabrio Quality
Management Software Update Log.txt

where <username> is the user’s login ID.
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The Quality Management Administrator interface has two panes. The left pane is a navigation
tree. The right pane displays the node that you selected in the left pane.

Moving Within the Navigation Tree
Use the following mouse or keyboard actions to move within the navigation tree.

Mouse
n

Double-click an icon/node name to expand or collapse the tree.

n

Click the plus sign (+) to the left of the folder icon to expand the tree.

n

Click the minus sign (–) to the left of the folder icon to collapse the tree.
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Keyboard
n

Press the Up and Down arrow keys to move from one node to the next.

n

Press the Left arrow key to collapse the tree.

n

Press the Right arrow key to expand the tree.

Sorting Tables
Data that appears in a table can be sorted by as many columns as there are in the table. The
sort can be ascending or descending.
The small triangles at the right of the column heading display the direction of the sort. These
arrows also change size depending on the column’s position in the sort. The triangle in the
primary sort column is biggest, the one in the secondary sort column is slightly smaller, and so
on.

Sorting a Table by One Column
n

To sort a table by one column, click the column heading.

n

To reverse the sort order, click the column heading again.

Sorting a Table by Multiple Columns
1. Press the Ctrl key and click the primary sort column heading.
2. Continue holding down the Ctrl key and click any other column headings you want to
sort the table by.
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Use the System Configuration to configure and modify the Quality Management environment.
There are two ways to access the System Configuration:
n

System Configuration Setup (PostInstall.exe)—use the System Configuration Setup
when installing or upgrading Quality Management. The steps you see in the System
Configuration Setup tool depend on the environment in which you install Quality
Management and the options that you choose to configure.
Note: The Inclusion List does not appear in the System Configuration Setup tool.
It is located under the System Configuration node in Quality Management
Administrator.

n

System Configuration in Quality Management Administrator—use System Configuration
when modifying or changing Quality Management.
If you are running Quality Management Administrator on a client desktop, some features
are disabled under System Configuration. You can only modify these features from
Quality Management Administrator or System Configuration Setup on the Base server.

Modifying the System Configuration
The following task describes how to modify the system configuration information.
1. Choose one of the following options:
l

l

Start System Configuration Setup from the executable PostInstall.exe in
C:\Program Files\Cisco\WFO_QM\bin, and then select the window you want to
modify.
From Quality Management Administrator, expand the System Configuration
node in the navigation tree, and then select the window you want to modify.

The selected window appears in the right pane.
2. Complete the fields.
3. Click Save.
Modifications take effect after you save your changes.
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System Database
Use the System Database window to configure connection information for the Quality
Management system database (system database).

Note: You can only change the information in the System Database window from the
System Configuration Setup (PostInstall.exe) or Quality Management Administrator on
the Base server. The System Database window in Quality Management Administrator
on a client desktop is read-only.

System Database fields

Field
Host
Name/IP
Address

Description
The hostname or IP address of the system database server
(the server on which SQL Server is installed).
If you need to specify a configured port on the system
database server, choose Host Name and use the following
format in the IP Address field:
<IP address or hostname>:<port number>
where <IP address or hostname> is the IP address or
hostname and <port number> is the configured port number
of the system database server.
EXAMPLE: 10.188.252.11:1455
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Field

Description

SQL
Instance
Name

The SQL instance name of the SQL Server. Leave this field
blank if you want to use the default instance.

Username

The username used by the DB Proxy service to access the
system database. See “Microsoft SQL Server” in the
Installation Guide for more information.

Password

The password used by the DB Proxy service to access the
system database. See “Microsoft SQL Server” in the Server
Installation Guide for more information.

Configuration Settings Used By Services
If you change the settings on the System Database window, the following table shows when
your changes take effect.
When services start using the changed configuration settings
Service

Configuration settings applied when...

Data API
Service

Restart the service.

DB Proxy
Service

Restart the service.

Sync
Service

No restart required. The next sync period (every 10 minutes)
applies the configuration settings.

Cisco Unified CC Database
Use the Cisco Unified CC Database window to configure connection information to the
Microsoft SQL server for the Cisco Unified Contact Center Express (Unified CCX) database.
Quality Management uses this information to sync agents and teams from Cisco Unified CCX.
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Sync, Data API, and MANA uses the settings in the Cisco Unified CC Database window.
Note: You can only change the information in the Cisco Unified CC Database window
from the System Configuration Setup (PostInstall.exe) or Quality Management
Administrator on the Base server. The Cisco Unified CC Database window in Quality
Management Administrator on a client desktop is read-only.
If you modify the information in the Cisco Unified CC Database window after the initial
installation and configuration, you must restart the Sync services before your changes take
effect.
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Cisco Unified CC Database fields and buttons

Field
Side A
Server
Name

Description
The name of the Unified CCX server for the Side A (primary)
Cisco Unified CC database.
If the server name contains a hyphen (-), replace the hyphen
with an underscore (_) when you enter the server name in this
field. This ensures the correct configuration of the file name.
System Configuration Setup appends _uccx to the name that
appears in this field the next time you run System
Configuration Setup.
Note: Do not remove _uccx from the name.

Side B
Server
Name

The name of the Unified CCX server for the Side B
(secondary) redundant Cisco Unified CC database, if one
exists.
If the server name contains a hyphen (-), replace the hyphen
with an underscore (_) when you enter the server name in this
field. This ensures the correct configuration of the file name.
System Configuration Setup appends _uccx to the name that
appears in this field the next time you run System
Configuration Setup.
Note: Do not remove _uccx from the name.

DB
Instance
Name

The name of the Cisco Unified CCX database. The name is
<side A server name>_uccx and the field is disabled by
default.

Port

The port number used by the Cisco Unified CCX database.
The port number is 1504 and the field is disabled by default.

25

System Configuration
Field
User

Description
Login ID used to access the Cisco Unified CC database and
synchronize users. This user must have write permission to
the database. The login ID is uccxworkforce by default.
Note: If you are using Cisco MediaSense, use
uccxhruser for the login ID. This login ID has the
permissions required to synchronize users and
reconcile contacts. The uccxworkforce login ID does not
have permission to use contactcalldetail and
agentconnectiondetail tables that are required for
reconciliation.

Password

Password used by uccxworkforce to access the Cisco Unified
CC database.

Filters

Allows you to determine what data is synced and determines
which devices are available in a telephony implementation.
See Touch-Point Filtering for more information.

Configuration Settings Used By Services
If you change the settings on the Cisco Unified CC Database window, the following table
shows when your changes take effect.

26

System Configuration
When services start using the changed configuration settings

Service
Sync Service

Configuration settings applied when...
No restart is required:
n

After the initial installation

n

After you fix incorrect sync information

The next sync period applies the configuration settings without
restarting the Sync service.
When there are substantial changes to the database, best practice
recommends updating the settings in the Cisco Unified CC Database
in the following order:
1. Stop the Sync service and the Upload Controller service.
2. Back up the SQMDB catalog.
3. Change the configuration settings on the Cisco Unified CC
Database window.
4. Start the Sync service.
5. Verify the data by looking for mass deactivations.
6. Restart the Upload Controller service. Restarting the Upload
Controller services adds new calls to the database.
MANA Service

The next polling period applies the configuration settings.

Data API service

Restart the Data API service.

Touch-Point Filtering
Touch-Point Filtering allows you to determine what data is synced and determines which
devices are available in a telephony implementation. A “touch point” is a 3rd party system that
has data that can be synced with Quality Management for recording purposes. The ability to
filter this data so that Quality Management sees only a subset of the touch point’s data is useful
in the following environments:
n

Multi-tenancy environments where a single ACD/telephony implementation is used by
multiple customers and each customer has their own Quality Management installation.

n

Environments where an ACD/telephony implementation has more data than Quality
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Management requires. For example:
l

l

Only a subset of all extensions are assigned to agents and therefore required for
recording purposes.
Quality Management will only be used by a subset of the call center.

By default, all teams and users are synced and available to be configured in Quality
Management Administrator. Touch-Point Filtering allows you to you to configure filters so that
Quality Management only has access to the ACD/Telephony data that matches the filter. The
available filters depend on the ACD and telephony implementations.
When you add a filter, the ACD Filter dialog box appears. The fields associated with this dialog
box are described in the following table.
ACD Filter fields

Field

Description

Name

The name of the ACD filter.

Prefix Type

The type of prefix that Touch-Point Filtering will use to filter the data.
In this instance, the data is filtered by Team Name.

Prefix Value

The name of the team. No wildcards are allowed.
EXAMPLE: If you enter Team1, both Team1 and Team10 will
be synced.

Trim Prefix

Remove the prefix before adding synced information to the Quality
Management database. Your options are as follows:
n

True—removes the prefix. True is the default value.

n

False—keeps the prefix

EXAMPLE: QM_TeamA becomes TeamA.

Extension
Range
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The range of device extensions that you want to include in the sync.

System Configuration
Field
Device
Name
Range

Description
The range of device names that you want to include in the sync.

Telephony Groups
A telephony group consists of at least one signaling source, one signaling group, one signaling
server, one recording cluster, and devices.
Quality Management allows you to add backups for the signaling source, signaling group,
signaling server, recording cluster, and devices. Adding any one of these backups is optional.
However, Cisco recommends using backups for resiliency purposes.
Note: Some telephony group types do not support a backup signaling source.
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The Telephony Groups window allows you to add, modify, and delete the following telephony
group types:
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n

Cisco MediaSense clusters

n

Recording CUBE SIP CTI services

n

Unified CM clusters

System Configuration

Telephony Groups fields and buttons

Field

Description

Add

Add a telephony group.

Rename

Rename the selected telephony group.

Delete

Delete the selected telephony group.

Revert Recent
Changes

Restore previous configuration settings.
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Field
Show Gateway
Recordings Prior to
Reconciliation

Description
When selected, this check box allows archive users to view
root calls in the Recordings application before the calls are
reconciled, including all PCI events. When cleared, calls do
not appear in the Recordings application until reconciliation is
complete and all PCI events are excluded. This check box is
clear by default.

Telephony Group Considerations
The following table describes what is supported based on telephony group type.
Telephony Group
Type

UnifiedCM

Changes

A telephony group can have any number of signaling groups.
Each CTI service in a signaling group can have a separately
administered list of Unified CM CTI Managers to connect to for
JTAPI.
A signaling group can have any number of Recording Clusters.

All Others

All other telephony group types can support multiple telephony
groups, but they are restricted to a single signaling group and Recording Cluster per telephony group. CUBE supports primary and backup
signaling services, but MediaSense supports only a single signaling
service.

Telephony Group Configuration
The Telephony Group Configuration dialog box appears when you add a telephony group. It
allows you to assign a name to the telephony group and associate it with a telephony signaling
method.
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Telephony Group Configuration fields
Field

Description

Name

The name of the telephony group. The name must be unique.

Telephony Group
Type

The telephony signaling method associated with the telephony
group. The available telephony types are as follows:
n

CUBE

n

UnifiedCM

n

MediaSense

Unified CM Configuration
The Unified CM Configuration dialog box appears when you add or edit a telephony group with
a Unified CM telephony type. It allows you to configure a Cisco Unified CM cluster.

The Cisco Unified CM window also allows you to configure the following users:
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n

Simple Object Access Protocol (SOAP) Administrative XML Layer (AXL) user

n

Unified CM Java Telephony Application Programming Interface (JTAPI) user

These users are used by the Computer Telephony Integration (CTI) service to log in to Unified
CM.
A Unified CM cluster comprises a set of Unified CM servers that share the same database and
resources and has one or more CTI Managers. The CTI Manager is a service that runs on
Unified CM and handles JTAPI events for every Unified CM in the cluster. For more
information on CTI Managers, see Signaling Groups.
You can specify one or more Unified CM telephony groups.
Note: A Unified CM telephony group requires at least one CTI Manager.
You enter each Unified CM in the Unified CM telephony group in System Configuration Setup
so that the Desktop Recording service can find the location of the Recording CTI service.
Quality Management stores an association between the Recording CTI service and the Unified
CMs in the cluster. If a Unified CM is not in the list, the Desktop Recording service will not know
where to register for events.
Note: Adding a new Unified CM telephony group here does not actually add a Unified
CM cluster. It creates the association between the Recording CTI service and the
Unified CMs in the cluster.

Unified CM Configuration fields and buttons

Field
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Description

Name

The name of the telephony group.

Telephony Group Type

The telephony signaling method for Unified CM. The field
displays UnifiedCM by default.

System Configuration
Field
Endpoint only does
Screen Recording

Enable Network
Recording

Description
When selected this check box indicates that the Unified CM telephony group is being used for screen recording only. This only
applies when you are using one of the following recording methods:
n

Network Recording

n

Cisco CUBE Recording via SIP Recording

n

Cisco MediaSense Recording

When selected this check box indicates that the Unified CM telephony group is using Network Recording and the Recording CTI
service will listen for SIP messages. The Recording CTI service
will not listen for SIP messages when the check box is cleared.
You can install the Recording CTI service and CUBE SIP CTI
service on the same machine if you clear the Enable Network
Recording check box.
EXAMPLE: You are recording voice through Gateway
Recording (using the CUBE SIP CTI service) and
recording screen from a single server.

Note: The Recording CTI service and CUBE SIP CTI
service will interfere with each other while listening for
SIP messages if the Enable Network Recording check
box is selected.

CDR Configuration

Allows you to enable the Unified CM’s Call Detail Records
(CDR) Report. See CDR Configuration for more information.

SOAP AXL Access
Username

The AXL (Administrative XML Layer) authentication username
on the publisher for this cluster. The SOAP AXL account is used
to access devices in Unified CM from the VoIP Devices window.
This username is created when you configure Unified CM.
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Field

Description

SOAP AXL Access
Password

The AXL authentication password on the publisher. This
password is created when you configure Unified CM.

SOAP AXL Access Version

The Unified CM version on the publisher.
Note: An error message will appear if the Version field is
not configured.

JTAPI Username

The JTAPI username for CTI. All phone devices, used for
recording are associated with this application user (end user).
The Recording CTI service logs into the Unified CM with this
user. The username must be between 1 and 32 alphanumeric
characters. This field is enabled when you choose CTI or Mixed
from the Telephony Signaling Method drop-down list.

JTAPI Password

The JTAPI user’s password for CTI. This must be between 1
and 32 alphanumeric characters. This field is enabled when you
choose CTI or Mixed from the Telephony Signaling Method
drop-down list.

IP Address

The host name or IP address of the subscriber (if any) Unified
CMs. You can enter one publisher Unified CM, and one or more
subscriber Unified CMs.
Note: When using hostnames, verify the server can
resolve the name of the subscribers. If the hostname
cannot be resolved, the Recording CTI service cannot log
in.

Publisher
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The field indicates whether or not the provided Host Name/IP
address is associated with the publisher CTI Manager. If the field
is blank, the Host Name/IP address is associated with a subscriber CTI Manager.
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Field

Description

Add

Add a new publisher or subscriber. See Subscriber
Configuration for more information.

Delete

Remove the selected publisher or subscriber.

Find Subscribers

Use the AXL user to locate subscribers associated with the
publisher entered. This is a good way to validate the AXL user
and to populate the list of subscribers, if any are found.

CDR Information Formats for the QM3002 Notification Trigger
You can specify in which format you want to display the CDR information in the CDR
Configuration dialog box. Examples of the available formats are listed here.
In these reports, call durations are expressed in milliseconds.
If the agent is listed as “Unknown” it means the agent has not successfully logged in to a PC
that has the Desktop Recording service. It is probable that the agent was not configured
correctly. Notifications for unknown agents are filtered out if the “Notify on users configured in
QM” check box is enabled.
CDR Configuration
CDR Configuration allows you to enable the Unified CM’s Call Detail Records (CDR) Report.
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CDR Configuration dialog box fields

Field
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Description

Unified
CM
Version

Select the version of the Cisco Unified CM you are using.

Host
Name/IP
Address

Choose host name or IP address, and then enter the
information for the Unified CM.

Username

The name of the user with rights to access the CAR reports.

Password

The password of the user with rights to access the CAR
reports.

System Configuration
Field

Description

Ignored
Extensions

Displays the list of ignored extensions. Quality Management
does not send notifications about extensions that appear in
this list. Select one of the following options to modify the
extensions that appear in this list.
n

Add—add a new extension to the list

n

Remove—delete an extension from the list

n

Edit—modify a selected extension in the list

Summary Only

Status Report
Start Time: 01/11/2008 15:25:53
End Time:

01/11/2008 16:25:53

Extensions with Missed Calls:
Ext

Agent

Found

Missed

% Missed

1545

JonesM

0

8

100%

2201

SmithB

0

15

100%

Detail (Tab Delimited)

Status Report
Start Time: 01/11/2008 15:23:41
End Time:

01/11/2008 16:23:41

Extensions with Missed Calls:
Ext

Agent

Found

Missed

% Missed

1545

JonesM

0

8

100%

2201

SmithB

0

16

100%

Missed Calls (all times in GMT):
CallID

Agent

Ext

ANI

DNIS

StartTime

Duration

16778554

JonesM

1545

2671 1545

01/11/2008

03:29:3613000

16778560

JonesM

1545

2671 1545

01/11/2008

03:29:5214000

16778561

JonesM

1545

2671 1545

01/11/2008

03:30:097000

16778594

JonesM

1545

2671 1545

01/11/2008

03:36:0112000

16778596

JonesM

1545

2671 1545

01/11/2008

03:36:1811000
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Detail (Plain Text)

Status Report
Start Time: 01/11/2008 15:24:57
End Time:

01/11/2008 16:24:57

Extensions with Missed Calls:
Ext

Agent

Found Missed

% Missed

1545

JonesM

0

8

100%

2201

SmithB

0

16

100%

Missed Calls (all times in GMT):
Call ID = 16778554
Agent = JonesM
Ext

= 1545

ANI

= 2671

DNIS

= 1545

Start

= 01/11/2008 03:29:36

End

= 01/11/2008 03:29:49

Duration= 13 sec
Call ID = 16778560
Agent = JonesM
Ext

= 1545

ANI

= 2671

DNIS

= 1545

Start

= 01/11/2008 03:29:52

End

= 01/11/2008 03:30:06

Duration= 14 sec
Managing Ignored Extensions

Select a UnifiedCM telephony group from the list of telephony groups in the Telephony Groups
window, click CDR Configuration, and choose one of the following options:
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n

To add an ignored extension, click Add in the Ignored Extensions section, enter the
extension in the field, and then click OK.

n

To edit an ignored extension, select the extension from the Ignored Extensions list, click
Edit, make the necessary changes in the Edit Extension dialog box, and then click OK

System Configuration
n

To remove an ignored extension, select an extension from the Ignored Extensions list
and click Remove.

Configuring the QM3002 Notification Trigger

This task describes how to configure the QM3002 notification trigger.
1. Click CDR Configuration in the Unified CM Configuration window for a UnifiedCM
telephony group type.
The Configuration dialog box appears.
2. Select the version of the Cisco Unified CM you are using from the Unified CM dropdown list.
3. Choose Host Name or IP Address, and then enter the information for the Unified CM.
4. Type the Unified CM username and password.
Enter the name and password of the user with rights to access the CAR reports.
5. Add the extensions that you do not want to receive notifications. See Managing Ignored
Extensions for more information
6. Configure the properties for the notification.
7. Click OK.
Subscriber Configuration
Use the Subscriber Configuration dialog box to add a Unified CM server to the Cisco Unified
CM cluster.
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Subscriber Configuration fields

Field
Host Name/IP
Address

Description
The host name or IP address of the publisher or subscriber (if any)
Unified CMs. You can enter up to 8 subscriber Unified CMs.
Note: When using hostnames, verify the server can resolve
the name of the publisher or subscribers. If the hostname
cannot be resolved, the Recording CTI service cannot log in.

Is Publisher

Select this check box if the provided Host Name/IP address is associated with the publisher CTI Manager. Only one publisher CTI Manager is allowed. This check box is disabled when a publisher CTI
Manager is configured.
Note: A publisher CTI Manager must be configured before you
can add subscriber CTI Managers.

MediaSense Configuration
The MediaSense Configuration dialog box appears when you edit a telephony group with a
MediaSense telephony type. It allows you to configure the Cisco MediaSense cluster
associated with the telephony group. Quality Management uses this information to download
call recordings from Cisco MediaSense.
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MediaSense Configuration fields

Field

Description

Name

The name of the telephony group.

Telephony Group Type

The telephony signaling method for Cisco
MediaSense. The field displays MediaSense by
default.

Primary MediaSense API Server
IP Address or Hostname

The hostname or IP address of the primary Cisco
MediaSense API server.

Secondary MediaSense API
Server IP Address or Hostname

The hostname or IP address of the secondary Cisco
MediaSense API server.

MediaSense Subscription Service
IP Address or Hostname

The hostname or IP address for the MediaSense
Subscription service.

MediaSense Subscription Service
Port

The MediaSense port number used by the MediaSense Subscription service. Default = 8440.

Authentication Username

The username for the Cisco MediaSense API server.

Authentication Password

The password for the Cisco MediaSense API server.
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Signaling Groups
A signaling group consists of one or more signaling services.
See Telephony Group Considerations for additional information on signaling groups.
For the UnifiedCM telephony group, you can specify a primary and backup CTI Manager
through Quality Management. Any Unified CM that has the CTI Manager running on the
subscriber can be your primary or backup CTI Manager.
Note: You can configure any machine as the primary CTI Manager, but it is a good idea
to avoid using the publisher, because it already has the highest load. Using another
server as the primary CTI Manager helps avoid decreasing the Unified CM
performance.

Signaling Group fields and buttons

Field

Description

Primary Signaling Details
Host Name/IP Address

The hostname or IP address of the primary signaling service.
A primary hostname or IP address is required.
This signaling service can belong to more than one signaling
group.

CUCM CTI Managers for
JTAPI

The IP address of one or more primary CTI Managers. The
CTI Manager is a service that runs on Unified CM and
handles JTAPI events for every Unified CM in the cluster.
This option only appears for the CTI service.

Backup Signaling Details

44

System Configuration
Field
Host Name/IP Address

Description
The hostname or IP address of the backup signaling service.
A backup hostname or IP address is optional.
This signaling service can belong to more than one signaling
group.
Note: The signaling service remains on the backup
server until you manually initiate fail back to the
primary server.
This option is not available for the Cisco MediaSense
Subscription service.

CUCM CTI Managers for
JTAPI

The IP address of one or more backup CTI Managers. The
CTI Manager is a service that runs on Unified CM and
handles JTAPI events for every Unified CM in the cluster.
This option only appears for the CTI service.

Additional Associated Servers

IP addresses for the remaining subscribers that are not
associated with the primary and backup
CUCM CTI Manager for JTAPI.

Buttons
Up Arrow or Down Arrow

Use the Up or Down arrow buttons to move the CUCM
CTI Managers to the desired location.
This button only appears for the CTI service.

Add +

Allows you to add a CUCM CTI Manager.
This button only appears for the CTI service.

Delete -

Allows you to delete a selected CUCM CTI Manager.
This button only appears for the CTI service.
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Recording Clusters
Quality Management supports Recording Clusters. A Recording Cluster is a group of one or
more Voice Record servers. A Voice Record server indicates which Recording Cluster it
belongs to when it connects to a signaling service.
You can assign a Voice Record servers to a Recording Cluster. When configuring a Recording
Cluster remember the following points:
n

If you have knowledge workers in a CUBE or MediaSense Recording environment who
require screen recording, you need to create a Recording Cluster that connects to a CTI
server and has no Voice Record servers assigned to it.

n

You can assign one or more Voice Record servers to a Recording Cluster. A Recording
Cluster requires at least one primary Voice Record server. See Telephony Group
Considerations for additional information on recording clusters.
A primary signaling service will exhaust the capacity of all primary Voice Record servers
before sending calls to secondary Voice Record servers. A backup signaling service will
exhaust the capacity of all secondary Voice Record servers before sending calls to
primary Voice Record servers. This allows primary/backup signaling services and
primary/secondary Voice Record servers to be split geographically while keeping the
traffic as local as possible. Significant traffic should only traverse the WAN in specific
failure scenarios.

n

A Voice Record server can only belong to one Recording Cluster.

n

You can move Voice Record servers between Recording Clusters.

Important: You must run System Configuration Setup (PostInstall.exe) on all Voice
Record servers before you can assign a Voice Record server to a Recording Cluster. If
you do not run System Configuration Setup on the Voice Record servers the Select
Record Servers dialog box will be empty.

Recording Clusters fields and buttons

Field
Primary Record
Servers
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Description
The primary Voice Record server assigned to this recording
cluster.

System Configuration
Field

Description

Secondary Record
Servers

The secondary Voice Record Server assigned to this
recording cluster.

Left Arrow < or Right
Arrow >

Use the left or right arrow buttons to move the selected Voice
Record Server to the desired location.

Add

Allows you to add one or more Voice Record Server as
primary or secondary record servers.

Remove

Allows you to delete a selected Voice Record Server.

Managing Telephony Groups
n

To add a telephony group, perform the following steps:
1. From the Telephony Groups window, select the Telephony Groups node, click
Add, complete the fields, and then click OK to create a telephony group.
2. If there are fields associated with the new telephony group, complete the fields.
Note: You cannot continue to the next step until you complete the fields.
3. Expand the new telephony group node, click Signaling Groups, click Add, complete the field, and then click OK to create a signaling group.
4. Complete the fields for the signaling group.
Note: You cannot continue to the next step until you complete the fields.
5. Expand the new signaling group node, click Recording Clusters, click Add, complete the field, and then click OK to create the new recording cluster.
6. Complete the fields for the Recording Cluster and then click Save.

n

To rename a telephony group, signaling group, or Recording Cluster, click the object,
click Rename, and then click Save.

n

To remove a telephony group, signaling group, or Recording Cluster, click the object,
click Delete, and then click Save.
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Configuration Settings Used By Services
If you change the settings for a telephony group, shows when your changes take effect.
When services start using the changed configuration settings
Telephony Group Type
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Service

Configuration settings applied when...

CUBE

CUBE SIP CTI Service

Restart the service.

MediaSense

Monitoring and Recording MediaSense Subscription service

Restart the service.

System Configuration

Telephony Group Type

UnifiedCM

Service

Configuration settings applied when...

Recording CTI Service

Restart the service.

Quality Management
Administrator (VoIP
Devices)

Reload the VoIP Device window.

Network Recording Service

No restart required. The next polling
period applies the configuration settings.

Desktop Recording service

Restart the service.

Recording CTI Service

Restart the service.

Quality Management
Administrator (VoIP
Devices)

Reload the VoIP Device window.

Network Recording service

Restart the service.
Note: If you add a backup
Recording CTI Service from
the System Configuration
Setup utility while in Update
Mode, you must restart the
Network Recording service.

Desktop Recording service

Restart the service.

Enterprise Settings
Use the Enterprise Settings window to configure Quality Management.
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Note: The Active Directory section appears in the Enterprise Settings window only if
your system is configured to use Active Directory.
You can use Enterprise Settings window to do the following:
n
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Share login fields with other products. See the following topics for more information:
l

Sharing Unified Workforce Optimization with Multiple Products

l

Share Login Fields

n

Configure the locale for your system if your version of Quality Management supports
other languages in addition to English. See Locale for more information.

n

Choose the default audio format for your recordings. See Audio Format for more information.

n

Specify when the DB Cleaner service runs. See Cleanup for more information.

System Configuration
n

View license information and update software licenses, if you are not using an ACD, by
importing a new software license file. See License for more information.

n

Configure Microsoft Active Directory domains (in an Active Directory system only). See
Active Directory for more information.

n

Configure the method (SMTP or SNMP) used to notify administrators or supervisors of a
system problem and decide if emailing reports will be allowed. See Integration
Configuration for more information.

n

Configure the report logo that appears in reports generated in the Reporting application.
See Report Logo Configuration for more information.
Note: The Report Logo Configuration button is only enabled from System
Configuration Setup (PostInstall.exe) or Quality Management Administrator on
the Base server.

n

Configure session timeouts for Call Recording and Quality Management and Quality
Management Administrator. See Session Timeout Options for more information.

n

Configure the security mode to allow only secure and encrypted connections. See Service Security Mode for more information.

Configuration Settings Used By Services
If you change the settings on the Enterprise Settings window, the following table shows when
your changes take effect.
When services start using the changed configuration settings

Service

Configuration
settings applied
when...

All Clients (Enable Updates change)

Restart the client
application.

Quality Management Administrator (AD
Authentication and Administrator session timeout
change)

Log into Quality
Management
Administrator.
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Service
Unified Workforce Optimization (AD
Authentication and localization changes)

Configuration
settings applied
when...
Start the Data API
service.

Sharing Unified Workforce Optimization with Multiple Products
Unified Workforce Optimization allows you to access several different products from a single
login page. You can choose to access all products with a single password or separate
passwords for each product when you run the System Configuration Setup tool.

Share Login Fields
You can choose to allow access to one or more of the following products from Unified
Workforce Optimization:
n

Quality Management

n

WFM

You can also choose to share common login fields for these products by selecting the Share
Login Fields with Other Products check box. If you select this option for each product, users are
prompted for a single set of common login credentials.
If a user is not configured for multiple Cisco products or the user wants to log into both of the
Cisco products with different login credentials, the user can select the Separate Product Logins
check box in the Login window.
If you do not select the Share Login Fields with Other Products check box, users are prompted
for separate login credentials for each Cisco product.
Cisco recommends using shared login fields when the users use the same username and
password for both products.
See the Application User Guide for more information on single-user login authentication.

Locale
Use the Locale section to enable the default language in the Unified Workforce Optimization
interface. Users can change the default language when they log in to Unified Workforce
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Optimization.
Note: The Locale section only appears when multiple locales are available.

Changing the Default Locale
The following task describes how to change the default locale for the Unified Workforce
Optimization interface.
n

Select the desired language from the Locale drop-down list.

Storage Configuration
Use Storage Configuration to manage the storage of recordings.

Audio Format
Choose the default audio format. Your options are as follows:
n

SPEEX—provides the smallest file size. Choose this option if your greatest concern is to
maximize storage space. When upgrading from 9.1 or lower, the default is SPEEX.

n

WAV-8—files are approximately four times larger than SPEEX files. Choose this option
if you want to compromise between greater audio fidelity and storage space.

n

WAV-16—files are approximately twelve times larger than SPEEX files. Choose this
option if you want the maximum audio fidelity and you are not concerned with storage
space.

Cleanup
The Database Cleanup Time field specifies when the DB Cleaner utility runs. This utility
deletes expired recordings from the database. The value provided must be between 00: and
23:59 in 1-minute increments. Choose a time when no uploads are occurring to reduce the
load on the system. Default = 00:05.

License
This section displays the available licenses and allows you to import licenses.
What appears in the License section after the initial installation depends on whether the
Synchronize Users with ACD check box is cleared or selected. If you select the Synchronize
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Users with ACD check box, you are running Quality Management with Unified CCX with
mixed-mode licensing enabled. Quality Management obtains the licenses from the Cluster
View Daemon (CVD) in Unified CCX and then displays the active license information in the
License section. Your licenses can be updated through Unified CCX Licensing.
Note: If a connection to the CVD cannot be made when initially running System
Configuration Setup, Quality Management will continue to try connecting to the CVD.
You will not be able go to the next window until Quality Management can successfully
connect to the CVD.

Note: If you add new license types (for example, change from only the QM license type
to QM and AQM license types), you must ensure Quality Management Administrator is
configured to support the new license types (for example, add a quality management
workflow and assign users to the AQM license).
Contact your sales representative to obtain a new license file.

Licensing Rules
The license type determines what Quality Management records.
When you log into Unified Workforce Optimization, you have access to all Quality Management
applications allowed by the license and roles assigned to you.
The license determines what is recorded, not what is viewed, in Unified Workforce
Optimization.
EXAMPLE: If Agents X and Y use AQM or AQMA license, they can record their
screens. If the supervisor for these agents only has a QM or QMA license, the supervisor
can still view the screen recordings made by these agents. For more information on
Licensing, see "Mixed Mode Licensing" in the Integration Guide.

Importing a License File
This task describes how to import a Cisco CR license file.
1. Click the Upload License button.
The Upload License File dialog box appears.
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2. Navigate to the folder where your updated Cisco CR license file is stored, and select
the file.
3. Click Upload File.
The Licensing Server uploads the Cisco CR license file.

Active Directory
The Active Directory section appears in the Enterprise Settings window only if your system is
configured to use Active Directory. Use the Active Directory section to configure Active
Directory domains.
n

There must be at least one domain configured

n

Each domain must have at least one user path configured

Domain Information
The connection information that you enter for Active Directory in the Domain Information dialog
box is verified using the entered credentials, and the user paths are validated when you click
OK in the Domain Information dialog box.
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Domain Information fields and buttons

56

Field

Description

Base DN

The location of all Active Directory users in the directory server
tree. This field is autofilled with a sample format with variable
names that you replace with the domain information.
Maximum number of characters allowed = 1000. If your
hostname has more than 3 parts, add additional DC=domain
statements to the beginning of the Base DN field.

Domain
Name

Defaults to the first part of the string entered in the Base DN
field. In most cases this is the domain name, but in some cases
you must edit the default.

System Configuration
Field

Description

Host
Name/IP
Address

The host name or IP address of the Active Directory server.

Port

The port used to access the Active Directory server. The field
is autofilled with the default port 389, or 636 if you are using
SSL (Secure Socket Layer).
Note: If you change the port to anything other than 389
or 636, clearing or selecting the Use SSL check box will
not change the port.
The Quality Management server must allow socket
communication on this port to be able to access the Active
Directory server for user authentication.

Display
Name

The name (not the login name, but the display name as
configured in Active Directory) of a user with read access to
the Active Directory database. Maximum number of
characters allowed = 1000.

User
Password

The user’s password.

User
Search
Base

The node in the Active Directory folder under which the user
resides. Maximum number of characters allowed = 1000.

Use SSL

Select this check box to use SSL for connection to Active
Directory. The check box is clear by default and indicates SSL
is not enabled. Clearing or selecting this check box changes
the default port number in the Port field.
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Field
Admin
Group

Description
The name of the security group in Active Directory. The users
assigned to this security group will be allowed to log in to
Quality Management Administrator and Unified Workforce
Optimization as an business administrator by default.
Note: All users in the Admin Group must belong to the
same domain specified in the Base DN field.

Note: AD Account users associated with the Security
Group setting are not given an administrator role by
default.
To assign the system administrator role to a user, see
Administrator Configuration.
Best practice: Create a security group with a unique
name in Active Directory and add the users who you
want to have system administrator privileges in Quality
Management Administrator and Unified Workforce
Optimization. Specify the name of that security group in
this field. This prevents any conflict with default security
groups in Active Directory.
Note that adding users to the Domain Admins group is
not appropriate in this instance because the users in the
Domain Admins group also have permission to make
changes in Active Directory.
To assign the telephony administrator role to a user, see User
Administration.
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Field

Description

Add
Certificate

Locate the Certificate Authority (CA) certificate for Active
Directory. Active Directory with SSL requires this certificate.
The certificate provides the Active Directory identity and public
key for SSL communication.
Contact your Active Directory administrator for the location of
the CA certificate for Active Directory. In many cases, the
Certificate Authority on the Active Directory machine issues
the CA certificate for Active Directory. If this is the case, you
can access the certificate from:
http://<Active Directory server IP address or
hostname>/certsrv
Note: Quality Management can only import
Distinguished Encoding Rules (DER) encoded binary
X.509 or Base-64 encoded X.509 formatted
certificates. These files typically have one of the
following extensions: der, pem, or cer.
Download the certificate from this website by clicking
Download a CA certificate, Certificate Chain, or CRL and
save it to a folder. Then click Add Certificate to import the
certificate.
Note: After you import the certificate and save your
changes, log out of Quality Management Administrator
and log back in to verify the certificate works.

View
Certificate

View the certificate associated with Active Directory.
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Field
User
Records
(OUs)

Description
One or more paths to user records (OUs). Click Add to add at
least one path, or Remove to remove an existing path.
Maximum number of characters allowed = 1000.
You must specify Active Directory paths from the most specific
to the least specific (from left to right in the path statement).
For example, if the Active Directory tree is:
ou=US
ou=Minnesota
ou=Minneapolis
ou=Users
Then the user record appears as follows:
ou=Users,ou=Minneapolis,ou=Minnesota,ou=US
Quality Management will search subtrees by default. For
example, you could write the user record path as follows, and
Quality Management will search all the subtrees under
Minnesota.
ou=Minnesota,ou=US

Add

Add a user record.

Remove

Remove a user record.

Edit.

Modify a user record.

OK

Save your changes.

Cancel

Exit without saving changes.

Managing Active Directory Domains
This task describes how to add or delete an Active Directory domain from the Enterprise
Settings window.
n
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To add an Active Directory domain, click Add in the Active Directory section. The
Domain Information window appears. Complete the fields and click OK.

System Configuration
n

To delete an Active Directory domain, select the Active Directory domain you want to
delete from the list in the Active Directory section, and then click Remove.

Integration Configuration
SMTP Configuration
SMTP Configuration allows you to configure the SMTP email connection.
Note: This feature is only enabled on the Base server.
Notifications can be sent to the Event Viewer or in emails to specified recipients. To use email
notification, enable the Use Email Notification check box and then configure up to 5 email
addresses.
Notification emails will be sent from the sender email address configured in the SMTP
Configuration dialog box. If you are using email notification, you must configure SMTP. This
can be done only from the Quality Management Base server.

61

System Configuration
SMTP Configuration fields

Field

Description

Host Name/IP
Address

Choose Host Name or IP Address, and then enter the hostname or
IP address of the SMTP server.

Port

The port used by the MANA service to communicate with the
SMTP server.

Use Authentication

Select this check box if authentication is needed to access the
SMTP server.

User

The username needed to access the SMTP server.

Password

The password needed to access the SMTP server.

Authorization Type

The type of authorization required. Your options are as follows:
n

NONE

n

BASIC

n

TLS

n

SSL

From Address

The email address from which all notifications will come.

Emergency Address

The email address where notification will be sent if the Quality
Management database is down when the MANA service attempts
to get its initial configuration. The notification email addresses
configured in the Monitoring and Notification window are stored in
the Quality Management database, and thus will not be functional
in the event that the Quality Management database is unavailable
when the MANA service first starts.
If the MANA service has already obtained a valid configuration
from the Quality Management database, and the Quality
Management database goes down while the MANA service is
running, the MANA service will use the valid configuration it
already has. As a result, the notification that the Quality
Management database is down will go to the configured email
address, not to the emergency address.
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Configuring the SMTP Settings for Email
Use this task to configure SMTP settings for email.
n

Click SMTP Configuration, complete the fields, and then click OK.

SNMP Configuration
SNMP Configuration allows you to configure the SNMP connection.
Note: This feature is only enabled on the Base server.
Notifications can be sent by Simple Network Management Protocol (SNMP). SNMP is an
application-layer protocol that provides a message format for communication between Quality
Management and a trap destination.

SNMP Configuration fields and buttons

Field

Description

Trap Destinations

The available trap destinations.

Add

Add a trap destination.

Remove

Remove a trap destination.

Edit

Edit a trap destination.

Configuring the SNMP Settings
Use this task to configure SNMP settings for notification.
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n

Click SNMP Configuration, choose one of the following options, and then click OK.
l

Click Add to add a new trap destination.

l

Select a listed trap destination and then click Edit to change the IP address.

l

Select a listed trap destination and then click Remove to delete IP address.

Restart the Windows SNMP service to enable your changes.
Note: You must restart the SNMP service any time you make a change in trap
destinations.

Report Logo Configuration
Report Logo Configuration allows you to customize the logo that appears in reports generated
by the Reporting application in Unified Workforce Optimization.
Custom logos must conform to the following specifications:
n

The logo must be 60 × 60 pixels

n

It must be in PNG format

n

The file must be named "logo.png"

To replace the default logo with your own custom logo:
1. Navigate to the C:\Program Files\Cisco\WFO_QM\Jetty\report_solutions\reports
folder, copy the original logo.png and save it to a backup folder.
2. Copy and replace the custom logo.png to the following folders:
n

C:\Program Files\Cisco\WFO_QM\Jetty\report_solutions\reports

n

C:\Program Files\Common Files\QM\config
Note: By copying your custom logo file into the Common Files folder, it will be
available even if you upgrade to a new version. PostInstall automatically copies it
from the Common Files folder to the correct folder within the Quality
Management file structure every time it is run.

3. Start System Configuration Setup (PostInstall.exe) or Quality Management Administrator.
4. On the Enterprise Settings window, click Report Logo Configuration.
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5. Click Select New Logo, browse to the location of your logo, and then click Select
Image.
6. Click Save.
7. Restart the Jetty service.
To restore the default logo:
1. On the Enterprise Settings window, click Report Logo Configuration.
2. Click Use Default Logo and then click Save.
3. Restart the Jetty service.

Allow Emailing of Reports
When selected, the Allow Emailing of Reports check box allows you to email a report to a
specific person or distribution list. For more information on creating a distribution list, see
Notification Distribution .

Session Timeout Options
You can configure Quality Management Administrator or Call Recording and Quality
Management in Unified Workforce Optimization for one of the following options:
n

Close all open popup windows and log off the user after a specified number of minutes of
inactivity (session timeout)

n

Allow a user to remain logged in indefinitely (default setting)

To configure the session timeout period, enter the desired number of minutes of inactivity
before timeout occurs in the minutes field.
Note: When you change the Session Timeout value for Quality Management
Administrator, you must restart Quality Management Administrator before the changes
can take effect.
If a user accessed one or more Call Recording and Quality Management applications, each
application displays a Timeout Warning dialog box 30 seconds before the application actually
times out. If the user does not respond to the Timeout Warning dialog box, the dialog box and
the application are closed and an alert is sent to the user stating that the application timed out
and was closed.
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When you are playing a customer conversation, the session remains in an active state. Unified
Workforce Optimization does not time out when you are playing a customer conversation.

Service Security Mode
If you configured the servers to run with Secure Socket Layer (SSL) and plan to use Hypertext
Transfer Protocol Secure (HTTPS), some traffic will continue through non-secure transport.
Specifically, voice and screen uploads will continue over non-secure transport as the data is
already encrypted.
Select the Allow secure / encrypted connections check box to enable secure (HTTPS)
connections for traffic other than voice and screen upload. When this check box is selected,
you must use HTTPS when connecting to Unified Workforce Optimization. Once enabled, you
will not be allowed to play back recordings or live monitor a user if you are using HTTP to
connect to Unified Workforce Optimization.
When the check box is selected, the useSSL flag for web, voice, and screen servers will be set
to true and their httpPort setting will use the statically defined value of 7001.
Note: You will need to manually block port 80 if required. See the Firewall
Configuration Guide for more information on port usage.

Important: The Automated Update features uses port 80. If you blocked port 80 and
you want to use the Automated Update feature, Cisco recommends that you enable port
80, run the Automated Update feature, and then disable port 80 after the updates are
installed.
When the check box is cleared, the useSSL flag for web, voice, and screen servers will be set
to false, and their httpPort setting will use port 80.

Administrator Configuration
Note: When you upgrade to 10.5 SR? or later, the only administrator that exists will be
the default administrator. The default administrator is a system administrator. Users
who were assigned the administrator role in the previous release will require additional
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configuration. After upgrading to 9.3(1), you need to assign your administrator users
based on the new hierarchical administrative roles.

The Administrator Configuration window allows you to assign the system administrator role to
users who belong to the Admin Group. See the Domain Information for a description of the
Admin Group and Administrator for a description of the administrator roles.
Important: Once you assign the system administrator role to a user in a non-Active
Directory environment, the default administrator user becomes obsolete and you can no
longer log in as a default administrator.

Note: You can only promote users to system administrator from System Configuration
Setup (PostInstall.exe) on the Base server.
If you are using Active Directory, the Administrator Configuration window will only display
users in the security group that have a complete configuration (including a Last Name).
If you are not using Active Directory, the Administrator Configuration window will display users
configured in the User Administration window.
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Administrator Configuration fields and buttons

Field or Button
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Description

Last Name

The user's last name.

First Name

The user's first name.

User ID

The user ID assigned to the user. The format of an
ACD user ID is <agent’s PG>.<agent’s ICM
Peripheral Number>.

System Configuration
Field or Button
Admin Role

Description
The administrator role assigned to the user. The
options are as follows:
n

System—the user is promoted to the system
administrator role.

n

None—the user is not a system administrator. The default is None.

To assign the business or telephony administrator
role to a user, see User Administration.
Windows Login

The user’s Windows user name.

Domain

The user's domain name.

Change Admin Role

Select one or more users and click the
Change Admin Role button to change the administrator role assigned to the users.

Managing Administrators
n

To promote one or more users to system administrators, select the users with the Admin
Role of None, click Change Admin Role, and then click Yes.

n

To demote one or more system administrators to users, select the users with the Admin
Role of System, click Change Admin Role, and then click Yes.

Site Settings
Use the Site Settings window to configure one or more sites and associate teams and
Recording Clusters with each site.
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When you install the Site Upload Server on a server, this is the first screen to appear in System
Configuration Setup (PostInstall.exe).
Note: The Site Settings window only appears when you install the Site Upload Server.
You can use the Site Settings window to do the following:
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n

View the current site configuration

n

Modify or remove a site

n

Add or remove teams from a site

n

Add or remove Encoding Servers from a site

n

Add or remove Recording Clusters from a site

n

Enable or disable automated software updates for client desktops associated with a
specific site

n

Change the default site

System Configuration
n

Specify when, where, and how many uploads can occur

n

Schedule uploading of peak and off-peak recordings from the agent desktops to the Site
Upload servers

Site Settings fields and buttons

Field

Description

Delete
Selected
Site

Remove an existing site.

Default
Site

The default site is assigned to new teams that have not been
associated with a site. In rare circumstances, it also becomes
the default site when a service cannot find a site for a
recording.

Site Name

The name of the site.

Enable
Automatic
Updates
for all QM
Clients

When selected, enables automated software updates for
client desktops associated with the selected site.

Peak
Hours
Begin

The time, in 24-hour format, when peak hours in the contact
center begin. Must be between 00:00 and 23:59 in 1-minute
increments. Default = 09:00.

Peak
Hours End

The time, in 24-hour format, when peak hours in the contact
center end. Must be between 00:00 and 23:59 in 1-minute
increments. Default = 17:00.

Max Peak
Hour
Uploads

The maximum number of recordings that can upload
simultaneously during peak hours. Must be a value from 1 to
100. This limit is set to conserve bandwidth on the network.
When one upload completes, another takes its place, but
there can be no more than the configured number uploading
at any one time. Default = 5.
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Field

Description

Max Off
Hour
Uploads

The maximum number of recordings that can upload
simultaneously during off hours (the hours not specified as
peak hours as defined by the Peak Hours Begin and Peak
Hours End fields). Must be a value from 1 to 200. This limit is
set to conserve bandwidth on the network. When one upload
completes, another takes its place, but there can be no more
than the configured number uploading at any one time.
Default = 100.

Storage
Location

You can change the storage location to any local or external
folder. You do not have to store recordings on the machine
that hosts the Site Upload Server.
If you change the storage location, you must run the Set
Recording Home Directory tool to restart the services.
Note: If you are using remote storage, the Media API
that is part of the Site Upload Server must run as a user
who has access to the location you choose for
recordings.
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IP
Address

The IP address of the machine that hosts the Site Upload
Server and the voice recordings, and the path where voice
recordings are stored.

Local
Storage
Location

Choose this option to store the voice and screen recordings
on the Quality Management server.

System Configuration
Field
External
Storage
Location

Description
Choose this option to store the voice and screen recordings
on an external server.
Note: If you change the storage location from local to
external storage in update mode, you must first
uninstall the PROXY Pro Gateway service on the
server that hosts the Site Upload Server (in the Control
Panel’s Add or Remove Programs, remove PROXY
Pro Gateway). When you run the Set Recording Home
Directory tool, the PROXY Pro Gateway service is
reinstalled automatically. See “Entering Configuration
Data in Update Mode” in the Server Installation Guide
for more information.

Storage
Location
Path

The path where voice and screen recordings are stored. Click
Browse and navigate to the storage folder.
Note: The default path is C:\Program Files\Common
Files\QM\Recordings. If you need to change the path,
do not specify the root directory (for example, D:\ or
E:\). Always include at least one folder in the path (for
example, D:\Cisco).

Browse

Locate a folder.
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Field
Username

Description
If you selected an external storage location, enter the
username required to access that location. If the user is a
domain user, enter the name with the format
<domain>\<username>.
For external screen storage and playback to work, you must
provide a domain user that has read and write access to the
local server and the external storage system.
This user must meet these requirements:
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n

The local server must know the user (the user is a
trusted domain user).

n

If the user is a domain user, the domain specified must
be trusted by the local server. This means the Voice
Record server that you are configuring has to be on a
domain that trusts or is trusted by the domain you are
entering.

n

The user must be able to log on as a service.

n

The user must have read and write access to both the
external drive location entered AND the location where
Quality Management is installed on the local server.

Password

If you selected an external storage location, enter the
password required to access that location.

Team

A list of assigned teams.

Endcoding
Server

A list of assigned Encoding Servers.

Recording
Cluster

A list of assigned Recording Clusters

Edit

Modify the assigned teams, Encoding Servers, or Recording
Clusters.
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Configuration Settings Used By Services
If you change the settings on the Site Settings window, the following table shows when your
changes take effect.
When services start using the changed configuration settings

Service

Configuration settings applied when...

Upload
Controller
service

The next End of Day applies the configuration settings. If you
want the changes to take effect immediately, restart the
Upload Controller service.

DB
Cleaner
service

The next cleanup time applies the configuration settings. If
you want the changes to take effect immediately, restart the
DB Cleaner service.

Media
webapp
(Jetty
service)

Restart the Jetty service.

Site Considerations
If you plan to use multiple recording storage locations, you can associate each recording
storage location to a site.
When configuring sites, consider the following:
n

A site is a single Site Upload server associated with a set of teams. A site can be
configured to be the system’s default site. The default site is used for teams that have not
been associated with a site or whenever a recording service cannot find a site for a
recording (this can happen in rare circumstances).

n

You can configure one or more sites for a Quality Management system and define the
teams that are assigned to each site.

n

When a site is taken down for maintenance or failure, the recordings created by the
agents while the site was down will be uploaded when the site recovers.

n

When upgrading from 9.0 8.8 or earlier, Quality Management will create a single site and
assign the Site Upload server, Upload Controller service, and all defined teams to that
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site. Peak and off-peak settings will also be moved to the site. Once Quality
Management is installed, you can add more sites.
n

When an agent plays a recording from the Recordings application, the Recordings
application will play back the recording from the Site Upload server that is associated
with the agent’s team.

n

For Desktop Recording, Quality Management records the agent’s calls while the agent is
logged in to the client desktop. When the agent logs out, the recordings are uploaded to
the Site Upload server that is associated with the agent’s team. It is possible to have two
different agents using the same computer at different times and have their recordings
uploaded to different Site Upload servers.

The following figure shows three sites—two external sites that communicate with the rest of
the system over a WAN and one site that communicate over a LAN. Each site has a Site
Upload server with an Upload Controller and a Recording Cluster. Each site has one or more
teams assigned to it and the users in those teams will upload to the proper site.
Multiple site configuration example
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EXAMPLE: The Base server is located in the United States (site 3) and a Site Upload
server is located in Germany (site 1) and all the German teams or groups are assigned
to the German site. When a German agent records a call, the recording is uploaded to
the German site recording storage location in Germany. When the agent plays back the
recording, the recording is retrieved locally and avoids wide area network (WAN) traffic.

Software Updates
Use the Automated Update feature to update the Quality Management Administrator and
Desktop Recording service. When you enable the Automated Update feature, every time a
client application starts, it checks the services for Quality Management to determine if a newer
version is available. If there is a newer version, the Automated Update feature automatically
installs the update on the client desktop.
Note: If you apply a Service Release (SR) update to the system, the best practice is to
disable the Automated Update feature first. After the SR update is installed, manually
test an updated instance of the Desktop Recording service, Unified Workforce
Optimization, and Quality Management Administrator to verify they work. When you are
satisfied they work, you can re-enable the Automated Update feature.
Use the Automated Update feature to update up to 500 client desktops. If your site has more
than 500 client desktops, Cisco recommends using push notifications.

Patches
When you install a patch on the server that includes patches for the client desktop, the patch
installs a webpage called Patches.htm on the server. If the automatic update feature is
disabled, you can download the patch for the client desktop from http://<Base
server>/TUP/QM/Patches.htm.

Managing Site Settings
n

To view the existing site configuration, click Site Settings.
The Site Settings window appears.
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n

To view a different site, click the tab associated with the site.
New sites appear in Site settings when you install Quality Management on the server
associated with the new site and configure the new site in the Site Settings window.

n

To remove a site, click the tab for the site you want to remove, click Delete Selected Site,
click Yes in the Confirm Delete dialog box, choose where you want to move recordings
from the deleted site, and then click OK.
The Manually Move Recordings dialog box appears. You need to manually move the
existing recordings from the server associated with the old site to the server associated
with the new site. The teams from the old site are now assigned to the new site and
future recordings for those teams will now be stored on the server for the new site.

n

To modify a site, select the site’s tab, complete the fields, and then click Save.

n

To change the default site, select a site from the Default Site drop-down list, and then
click Save.

n

To enable or disable automatic updates on client desktops associated with a site, click
the tab for a site, select or clear the Enable Automatic Updates for all QM Clients check
box, and then click Save.

n

To modify the current upload settings for a site, click the site’s tab, complete the fields
under Peak Uploads, and then click Save.

n

To change the recording storage location:
a. Complete the fields under Storage Location and then click Save.
b. Select Tools > Set Recording Home Directory to restart the services.

n

To modify the list of assigned teams, Encoding Servers, or Recording Clusters to a site,
select the site’s tab, click Edit under Team, Encoding Server, or Recording Cluster, and
choose one of the following options: select one or more teams, Encoding Servers, or
Recording Clusters from the Teams, Encoding Servers, or Recording Clusters list and
click the > button to move the teams to the Assigned Teams or Assigned Recording
Clusters list. To move all teams or Recording Clusters to the Assigned Teams or
Assigned Recording Clusters list click the >> button, and then click Save.
l
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Add teams, Encoding Servers, or Recording Clusters. Click Edit under the option
that you want to modify, select one or more items from the available list and click
the > button to move the selected items to the assigned list, or click the >> button
to move all items to the assigned list, and then click OK.
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l

Remove teams, Encoding Servers, or Recording Clusters. Click Edit under the
option that you want to modify, select one or more items from the assigned list and
click the < button to move the selected items to the available list, or click the
<< button to move all items to the available list, and then click OK.

Inclusion List
Quality Management uses the Inclusion List window to determine which calls to record and
which calls to ignore. Quality Management only records calls that match the extension patterns
in the Patterns to be Recorded list.

A tab appears in the Inclusion List window for each configured telephony group. You can
configure extension patterns for inclusion or exclusion for each telephony group.
The Patterns to be Recorded list contains extension patterns that will be recorded. By default,
the Patterns to be Recorded list displays an asterisk (*) in the Pattern column, Extension in the
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Type column, and Either in the Direction column. This indicates that all incoming and outgoing
calls on all extensions in the telephony group will be recorded. As soon as specific extension
patterns are configured in the Patterns to be Recorded list, recording is limited to those
extension patterns only.
The Pattern column lists the extension pattern that will be filtered in the Patterns to be
Recorded or Patterns to be Excluded from Recording lists. You can use the following wildcards
to configure ranges:
n

The asterisk (*) in a string can represent any quantity of any character, as long as the
other characters in the string match.

n

The question mark (?) in a string can be replaced by any character, but the length of the
string must be exactly as represented.

Extension patterns can be further filtered by selecting:
n

The direction of the call (for recorded calls only). Your options are:
l

Inbound—filters all inbound calls that match the extension pattern

l

Outbound—filters all outbound calls that match the extension pattern

l

Either—filters all inbound and outbound calls that match the extension pattern

l

Excluded—excludes all inbound or outbound calls that match the extension pattern.

See Gateway Recording Considerations and Cisco MediaSense Recording
Considerations for more information.
n

The type of call. Your options are:
l

l

l

l

Any—filters all called, calling, and extensions calls that match the extension
pattern
Called—fillers all calls received by the phone numbers that match the extension
pattern
Calling—filters all calls made by the phone numbers that match the extension
pattern
Extension—filters all extensions that match the extension pattern

To rearrange the order of extension patterns that appear in the Patterns to be Recorded list,
select an extension pattern from the list and use the Up or Down arrow buttons to move the
extension pattern to the desired location. Extension patterns are filtered starting at the top of
the list and continues down to the bottom of the list.
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The Patterns to be Excluded from Recording list displays extension patterns that will not be
recorded. Extension patterns that appear in the Patterns to be Excluded from Recording list
are filtered before any extension patterns that appear in the Patterns to be Recorded list. Only
extension patterns found in the Patterns to be Recorded list will be recorded.
You can also import or export an inclusion/exclusion list for a single telephony group. Changes
to the inclusion/exclusion list take effect the next time the CTI service polls for configuration
(five minutes at most). Importing or exporting a large inclusion/exclusion list is quick (Less than
five seconds). However, it might take up 30 seconds to save a large inclusion/exclusion list to
the database.
Any changes you make to the Inclusion List take window take effect at the next recording client
login.
Inclusion List buttons

Field

Description

Add

Add an extension pattern.

Remove

Remove an extension pattern.

Modify Type

Change the call type associated with an extension pattern.

Modify Direction

Change the direction associated with an extension pattern.

Import

Allows you to select the location and name of an
inclusion/exclusion file to import. The file must be in CSV
format (see CSV Format for more information). Importing an
inclusion/exclusion list overwrites the existing file. An import
does not merge changes.
Note: If the CSV file has errors in it, the import will fail
and the existing data will remain unchanged. An error
message will indicate why the import failed and identify
the record that failed if applicable.
After importing a CSV file, you must click Save to save your
changes.
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Field
Export

Description
Allows you to select the location and specify a name for the
exported inclusion/exclusion list. The file must be in CSV
format. Once exported, you can open the file in Microsoft Excel.

CSV Format
The CSV file containing the inclusion/exclusion list must use the following format:
Pattern

A number pattern with
optional * and ? wildcards

Type

One of the following types:

Bounds

One of the following
directions:

n

Extension

n

Calling

n

Inbound

n

Called

n

Outbound

n

Any

n

Either

n

Excluded

When creating an inclusion/exclusion list, remember the following points:
n

Exclusions are matched before inclusions, but exclusions can appear anywhere in the
CSV.

n

Within each group (inclusions and exclusions), patterns are matched starting from the
top and working down the list.

n

Additional columns after Pattern, Type, and Bounds are allowed in an imported CSV.
However, the additional columns will be ignored.

Gateway Recording Considerations
The considerations in this topic apply to the following Gateway Recording method:
n

Cisco CUBE Recording via SIP Recording

When the call direction cannot be determined, the Inclusion List will only match a Direction with
a value of Either. All calls, both inbound and outbound, appears as inbound. Cisco
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recommends setting the value of the Direction to Either when creating an exclusion for a
Gateway Recording method.

Cisco MediaSense Recording Considerations
If you are using Cisco MediaSense Recording, the Inclusion List affects which recordings are
uploaded to Quality Management. Initial recording decisions are based on the Cisco
MediaSense configuration.
When configuring the Inclusion List for Cisco MediaSense Recording, consider the following:
n

The entire call is recorded and saved on the Cisco MediaSense Recording cluster.

n

Quality Management only downloads Cisco MediaSense recordings that appears in the
Patterns to be Recorded list.

n

Quality Management does not download Cisco MediaSense recordings that appear in
the Patterns to be Excluded from Recording list.

n

When the call direction cannot be determined, the Inclusion List will only match a Direction with a value of Either. Cisco recommends setting the value of the Direction to
Either when creating an exclusion for Cisco MediaSense Recording.

Managing Extension Patterns
To manage extension patterns:
1. Select the appropriate telephony group cluster tab in the Inclusion List window.
2. Choose one of the following options:
l

Add an extension pattern. Click Add beneath the Patterns to be Recorded or
Extensions to be Excluded, type a number in the Add Pattern dialog box, click
OK, and then complete the remaining fields in the table.
You can enter the exact number or use the * or ? wildcards plus numbers to
configure a range of numbers. For example:
Enter This: To Record:
6124

Number 6124.
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Enter This: To Record:
61*

Any number that start with 61 and are of any
length.
EXAMPLE: 6124, 61555, 613

61??

Any number that start with 61 and are 4 digits
long.
EXAMPLE: 6124, 6125, 6126

l

l

l

l

l

Modify a call type. Select an extension pattern, click Modify Type, select the different type from the drop-down list, and then click OK.
Modify a call direction. Select an extension pattern, click Modify Direction, select
a different direction from the drop-down list, and then click OK.
Remove an extension pattern. Select the extension pattern in Patterns to be
Recorded or Extensions to be Excluded, click Remove, and then click OK.
Import an inclusion/exclusion list. Click Import, select the location, the file name
of the inclusion/exclusion list, click OK, and then click Save.
Export an inclusion/exclusion list. Click Export, select the location, type the file
name of the inclusion/exclusion list, and then click OK.

3. Click Save.

Excluding Extension Patterns
If you have a limited number of extension patterns you want to exclude from being recorded,
you can configure the Inclusion List to ignore only those extension patterns and record all
others.
EXAMPLE: If you want to record all extension patterns except for extensions 3411,
3412, and 3413, configure your inclusion list so that there is an asterisk in the Patterns
To Be Recorded list, and extensions 3411, 3412, and 3413 listed in the Patterns To Be
Excluded From Recording list.
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Extension patterns listed in the Patterns To Be Excluded From Recording list always take
precedence over extension patterns listed in the Patterns To Be Recorded section. You cannot
use the same extension pattern (specifically or through the use of wildcards) in both lists.
EXAMPLE: 12* cannot appear in both lists.

Monitoring and Notification
Use the Monitoring and Notification window to enable the Monitoring and Notification (MANA)
service.

Only one notification trigger requires configuration: Problem ID QM3002 under QM Task
Settings. This trigger compares data in the Unified CM’s Call Detailed Records (CDR) Report
(for Unified CM versions 8.x and 9.x) with the Quality Management database. Specifically, it
compares the call records in the Unified CM with the call records in Quality Management. If
there is a discrepancy, notification is sent.
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Note: The MANA CDR Report (QM3002 notification trigger) does not support devices
that are recorded by Cisco MediaSense. If your site is a mixed-recording environment
where Server Recording, Network Recording, or Desktop Recording and Cisco
MediaSense Recording are used together, the CDR Report will not be accurate since
Cisco MediaSense devices result in false positives.
By default, Problem ID QM3002 is disabled. The notification trigger does not have to be
configured unless you enable that problem ID in the Notification Distribution dialog box.
You can create multiple distribution lists. For each distribution list, you can choose to specify
the events that trigger notification.
EXAMPLE: You can set up a distribution list for global outages (all QM1000 level
errors) and all “JTAPI not associated with a device” (specific QM2002 error).
You can also configure the following information:
n

Distribution list of persons receiving notification, if you configure email as a means of
notification

n

Email address of the person(s) receiving notification, if you configure email as the means
of notification

n

Trap destinations receiving notification, if you configure SNMP as the means of
notification

n

If and how often a renotification of the problem should be sent out

n

Types of problems that will trigger notification

Note: You can only change the information in the Monitoring and Notification window
from the System Configuration Setup (PostInstall.exe) or Quality Management
Administrator on the Base server. The Monitoring and Notification window in Quality
Management Administrator on a client desktop is read-only.
Connection information is saved locally to the Base server so the emergency user can still be
notified using email if a major component (for example, the database) is down, and the other
email addresses are not available. This allows the Quality Management Administrator to edit
the emails and allows Monitoring and Notification to notify one user when the configuration is
not accessible.
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Monitoring and Notification fields and buttons

Field

Description

Use
Monitoring/
Notification
Service

Select this check box to enable the MANA service. If enabled,
at least one notification method (event viewer, SNMP, or
email) must be enabled as well. This check box is selected by
default.

Distribution
List

The available distribution lists.

Add

Add an distribution list.

Remove

Remove an distribution list.

Edit

Edit the selected distribution list.

Polling
Period

Sets the interval at which the MANA service checks for the
selected notification triggers. Default = 10 minutes, Minimum
= 0 minutes, Maximum = 1440 minutes (1 day). The timer
starts when the last polling task is complete.
Note: When you change the polling period, it takes
one polling cycle before the new polling period goes
into effect.

Never

Choose this option if you do not want to be renotified of a
problem after the initial notification.

Every N
Polling
Periods

Choose this option if you want to specify how frequently you
want renotification to occur after the initial notification and
specify the number of polling periods. For example, if you
choose to be notified every 3 polling periods, you receive the
initial notification on the first polling period the problem is
detected, no notification the next two polling periods, and
then another notification on the next polling period. This
pattern will continue as long as the problem is detected.
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Field
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Description

Every
Polling
Period

Choose this option if you want renotification to occur every
polling period after the initial notification.

QM Task
Settings

The fields listed in the QM Task Settings section are used to
configure QM3002.

Miss
Threshold

Percentage of missed CDRs required to trigger notification.

Minimum
Misses

Lowest number of missed CDRs required to trigger
notification.

Notify on
users
configured
in QM

When you select this option, Quality Management only
generates notifications about users who are configured in
Quality Management.

Notify on
users that
are logged
in

When you select this option, Quality Management only
generates notifications about users who are currently logged
in to Unified Workforce Optimization. This only applies to the
Desktop Recording service.

Display
Type

Choose one of the following options.
n

Summary Only—displays 1 row per agent with missed
CDR that meet the above criteria. See Summary Only
for an example.

n

Details (Tab Delimited)—displays each missed CDR in
tab delimited format. See Detail (Tab Delimited)for an
example.

n

Details (Plain Text)—displays each missed CDR in
text format. See Detail (Plain Text) for an example.
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Configuration Settings Used By Services
If you change the settings on the Monitoring and Notification window, the following table shows
when your changes take effect.
When services start using the changed configuration settings
Service
MANA service

Configuration settings applied when...
The next polling period applies the configuration settings.

Notification Distribution
The Notification Distribution dialog box allows you to create a distribution list, specify the
notification type for the distribution list, and assign the type of MANA messages that are sent to
the distributions list.

The MANA messages are classified as follows:
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n

QM1xxx—indicates a global outage that might affect recording for the entire system.

n

QM2xxx—indicates individual outages that might affect recording for individual users.

n

QM3xxx—indicates a possible configuration problem. The notifications might not point to
an actual issue, so you might want to turn these notifications off to avoid unnecessary
notifications.

n

QM4xxx—indicates a problem with MANA that prevents it from reporting problems.

Notification Distribution fields

Field

Description

Distribution
List Name

The name of the distribution list.

Notification
Type

The type of notification you want to use to send notification messages. Your
options are:

Email
Addresses

n

Event Viewer—use the Event Viewer for displaying notification
messages

n

Email—use email for sending notification messages

n

SNMP—use SNMP for sending notification messages

The list of email addresses to which notification is sent. Maximum = 5 email
addresses. A comma is required to separate two or more email addresses.
Example: jane.doe@acme.com, john.smith@acme.com,
robert.dee@acme.com

Note: This field is enabled when you select Email as your notification
type.

Available
Problems
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The list of problems that will not trigger notification. Move any problem that
does not require notification to the Available Problems list. By default only
QM3002 appears in this list.
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Field

Description

Enabled
Problems

The list of problems that will trigger notification. By default, all problems
except for QM3002 are enabled. You must configure QM3002 under QM
Task Settings in the Monitoring and Notification window before enable this
Call Detail Record (CDR) task.
Note: QM3002 is not supported with Cisco MediaSense Recording.
See Configuring the QM3002 Notification Trigger for more information.

Managing Notification Distribution Lists
Use this task to manage notification email addresses.
n

To add a distribution list, perform the following steps.
l

Click Add in the Notification Distribution section.

l

Type the name of the distribution list in the Distribution List Name field.

l

l

l

Type the email addresses that are included in the distribution list in the Email
Addresses field.
Move the type of problems you want sent to this distribution list to the Enabled
Problems list.
Click OK.

The new distribution list appears in the Distribution List.
n

To remove a notification distribution list, select the distribution list from the Distribution
List, click Remove, and then click OK.
The distribution list is removed from the Distribution List.

n

To edit a notification distribution list, select the distribution list from the Distribution List,
and click Edit. In the Notification Distribution dialog box, modify the distribution list that
you want to change, and then click OK.

Enabling or Disabling a Notification Trigger
When enabling the QM3002 notification trigger:

91

System Configuration
n

CDR must be correctly configured in the Unified CM Administration web application. For
Unified CM 8.x, see Serviceability > Tools. In these versions, there is no CDR database.
Instead, the CAR reports (CDR export) are used. Set up CAR so that it updates its
information as frequently as possible (less than 30-minute intervals). Create a CAR user
and enter that user in the Quality Management CDR Configuration dialog.

n

Archiving must be enabled in Quality Management.

This task describes how to enable and disable a notification trigger from the Notification
Distribution dialog box.
n

To enable a task notification trigger, choose a trigger from the Available Problems section and click >. The trigger moves to the Enabled Problems section.

n

To enable all task notification triggers, click >>. All triggers move to the Enabled Problems section.

n

To disable a task notification trigger, choose a trigger from the Enabled Problems section and click <. The trigger moves to the Available Problems section.

n

To disable all task notification triggers, click <<. All triggers move to the Available problems section.

Examples of Notification Configuration Problems
The following setup examples illustrate what happens when you configure the Notification
Trigger Configuration as described.
Setup
1

Miss Threshold:
50%
Minimum Misses: 5
Notify on users
configured in QM:
Enabled
Notify on users
logged in: Enabled
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Agent

Agent A has 8 matched calls and 2 missed calls. Agent A
is properly configured and was logged in for the whole
time.
Agent B has 6 matched calls, but 2 were made before he
was logged in. Agent B is configured properly.
Agent C has 2 matched calls and 8 missed calls. Agent C
is properly configured and was logged in the whole time.

Effect

Agent A: The missed percentage is 2/(8 + 2) = 20%. No
notification would be made because neither the Miss
Threshold nor the Minimum Misses criteria were met.
Agent B: No notification would be made because the
Minimum Misses criterion (5) was not met.
Agent C: The missed percentage is 8/(2 + 8) = 80%.
Notification is made because the Miss Threshold and the
Minimum Misses criteria were met.

Setup
2

Miss Threshold:
100%
Minimum Misses: 1
Notify on users
configured in QM:
Enabled
Notify on users
logged in: Disabled.
Agent

Agent A is configured in Quality Management but does not
have the Desktop Recording service installed or the
phone is not daisy-chained properly.

Effect

Notification will be made on Agent A’s extension, with the
agent listed as “Unknown” because there is no crossreference between the agent and extension until the
Desktop Recording service is configured.

Note: Matching the CDR or CAR Report with Quality Management is not 100%
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accurate. CDR data can be out of sync with Quality Management, or certain call
scenarios might yield false positives. It should not be used for compliance.

Note: Agent team association and whether a team is configured for archiving are
determined from the time the CDR task is run, not from the time of the call in question.
This could result in false positives or false negatives if a team's archiving status changes,
or if an agent's team membership changes during the period the CDR task is examining.
When a notification is received, look at the DNs/Agents that show missed calls. A large number
of agents with missed calls might indicate a Quality Management service failure. The possible
services with issues are:
n

Signaling service

n

Upload Controller

n

DB Proxy service (on the Database server)

A 100% miss percentage for a single agent might indicate a failure in the Desktop Recording
service. If notifications are occurring frequently with less than 100% missed for a small number
of agents, the thresholds might need to be adjusted to minimize unnecessary notifications.
Even a high threshold (100%) will notify on moderate and major outages.

Status
The Status window reports the version of the installed Quality Management components and
displays the status of the signaling servers by telephony group. Click refresh to see the latest
signaling server information.
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Configuration Settings Used By Services
If you change the product version, the following table shows when your changes take effect.
When services start using the changed configuration settings
Service

Configuration settings applied when...

Upload Controller service

Periodically check for a version mismatch.

System Configuration Setup Tools
System Configuration Setup provides a number of tools you can use to update your site
information. These tools are available through the Tools menu. These tools normally run during
the initial installation of Quality Management.
The Tools menu, in System Configuration Setup, only enables tools when the tools are
available on the server where you are running the System Configuration Setup tool.
The following table displays the available tools and the servers on which they are located.
Tool availability in the System Configuration Setup tool

Tool

Voice
Record
Site
&
Media
Base Database Upload CTI Monitor Encoding
Server Server Server Server Server Server

Start Local Services

x

x

Create Database
Catalogs

x

x

Generate Info for
MSI Clients

x

x

Download/Install
JTAPI
Encrypt Audio Files
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Tool

Voice
Record
Site
&
Media
Base Database Upload CTI Monitor Encoding
Server Server Server Server Server Server

Set Recording
Home Directory

x

Show Proxy
Networks
Administrator

x

Generate SSL
Certificates

x

Test CTI Service(s)

x

x

x

x

x

Test MediaSense
Subscription Service

x

x

x

x

x

Display Metadata
Encryption Key

x

x

x

x

x

x

Choose Monitor
Adaptor
Remove Recording
Services

x

x

x

x

Set Temporary
Recording Directory

x

x

x

x

Set Temporary
Encoding Directory

x

SIP Trunk Certificate
Change
IP Addresses or
Host Names

x

x
x

x

x
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Start Local Services
This tool offers a convenient way to start all the Quality Management that are on the local
computer. You can run this tool any time. However, you should notify users because restarting
services might cause outages.

Create Database Catalogs
This tool creates a new Quality Management database if one does not exist or updates an
existing database to the latest schema version without overwriting any existing data. You can
use this tool to recreate your Quality Management database if you have no backup database
and your database was corrupt and you deleted it. This tool populates a fresh database when
the Unified CCX and Data API sync with it.

Generate Info for MSI Clients
This tool updates the information required by the MSI client installation programs to
successfully install the Desktop Recording service, Recording Thin Client, and Quality
Management Administrator.

Download/Install JTAPI
Use this tool when you upgrade Unified CM. This tool downloads and installs JTAPI.

Encrypt Audio Files
This tool enables you to encrypt any unencrypted audio files. Run this tool only after you
upgrade all client desktops to the latest version of Quality Management. All audio files are
encrypted after you run this tool.

Upload Screen Recordings
Quality Management encrypts screen recordings after the recording ends and then uploads the
screen recordings through an encrypted connection to the storage server. After the upload to
the storage server completes, Quality Management decrypts the screen recording and stores
these recordings in their original format.
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When you play back a screen recording located on the storage server, Quality Management
encrypts the screen recording when streaming the file during playback.

Set Recording Home Directory
This tool allows you to restart services after you update the Site Settings window. Run this tool
when upgrading from the Basic license to the Advanced license.

Show Proxy Network Administrator
This tool displays the Gateway Administrator. Use this tool when you need to modify the
Screen Playback Gateway information.

Generate SSL Certificate
This tool generates a security certificate for the Media webapp and Unified Workforce
Optimization-generated reports. Use this tool if your certificate is corrupt or if the IP address of
the server changes (the user sees a Security Alert dialog box whenever the Media webapp or
Reports runs). This tool is available only when you run System Configuration Setup on the
Quality Management server (for reporting) and the Site Upload server (for Media webapp).
When you run the tool, you see a Security Alert dialog box. Click View Certificate to display the
Certificate dialog box, and then Install Certificate to install a new certificate.

Test CTI Services
This tool verifies that the local Recording CTI service or CUBE SIP CTI service has the correct
JTAPI and accepts connections. The tool makes a request to each running Recording CTI
service or CUBE SIP CTI service and, if all succeed, returns a success message. If any
requests fail, Quality Management reports the failure and lists which succeed. The reports are
available in Unified Workforce Optimization.
Note: This tool is not required for Cisco MediaSense Recording.
If you made any changes to the Recording CTI service or CUBE SIP CTI service in System
Configuration Setup, you must restart the Recording CTI service or CUBE SIP CTI service
before you run this test.
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Test MediaSense Subscription Service
This tool verifies that the running MediaSense Subscription Service has the correct connection
and authentication information and accepts connections. This tool makes a request to the
MediaSense Subscription Service and, if it succeeds, it returns a success message. If the
request fails, Quality Management reports the failure.
If you made any changes to the MediaSense Subscription Service in System Configuration
Setup, you must restart the MediaSense Subscription service before you run this test.

Display Metadata Encryption Key
This tool displays the customer-specific key used for Advanced Encryption Standard (AES)
encryption. This key can be used by external applications to access encrypted user-defined
metadata directly from the Quality Management database. You must provide the
administrator’s user name and password to access this information.

Choose Monitor Adaptor
This tool displays a dialog that asks for the IP address of the NIC card used for the Monitor
service and server-based monitoring. This might be different from the network IP address you
entered during System Configuration Setup.
The monitor adapter dialog pops up automatically during System Configuration Setup if
multiple NIC cards are on the box and the box hosts the Monitor service. You should choose
the IP address of the NIC card that you connected to the SPAN port on the switch.
Note: This tool is not required for Cisco MediaSense Recording.

Remove Recording Services
Use this tool to finalize the removal of Network Recording service and Monitor service servers
by removing them from database. Uninstall the services from the server before you use this
tool.
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Set Temporary Recording Directory
This tool allows you to choose a temporary storage location for recordings before they are
uploaded. You can change the temporary storage location at any time. When you change the
temporary storage location, System Configuration Setup moves the recordings to the new
location.

Set Temporary Encoding Directory
This tool allows you to choose a temporary storage location for encodings before they are
uploaded. You can change the temporary encoding location at any time. When you change the
temporary encoding location, System Configuration Setup moves the encodings to the new
location.

SIP Trunk Certificate
Use this tool to generate, upload, or download a SIP trunk certificate. A SIP trunk certificate is
required when your system is configured for Network Recording with Cisco Unified CM 8.0 or
later.
Note: This tool is not required for Cisco MediaSense Recording.

Generate SIP Trunk Certificate
Use this tool to generate a SIP trunk certificate. The SIP trunk certificate is saved to the
C:\Program Files\Common Files\QM\Certificates folder.

Upload SIP Trunk Certificate
Use this tool to upload a SIP trunk certificate from a flash drive or folder.

Download SIP Trunk Certificate
Use this tool to download the SIP trunk certificate to a flash drive or folder. Follow the upload
instructions in the Cisco Unified Communications Manager Administration Guide to upload the
certificate to Cisco Unified CM.
If you are using multiple Voice Record servers, copy the Certificates directory containing both
privacy-enhanced mail (PEM) files to the same location on the other Voice Record servers.

101

System Configuration

Change IP Addresses or Hostnames
This tool allows you to change the IP address or hostname for the Site Upload server (Site
Services), Voice Record server (Record Server), Monitor server, and Media Encoding server
(Encoding Server). During an upgrade, this feature runs automatically after the Quality
Management Quality Management database is initialized.
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Use the Record Server Configuration node in the Quality Management Administrator
application to configure devices for Cisco MediaSense Recording, Server Recording, and
Network Recording.
Note: You do not need to configure devices if you are only using Desktop Recording
(Endpoint).

Server Recording and Network Recording
Considerations
You can enable Server Recording and Network Recording for a device from the Record
Server Configuration node for the following types of agents:
n

Agents who work different shifts and share a desk (Hot Desking)

n

Agents who log into a phone (Extension Mobility)

n

Agents using Citrix or Microsoft Terminal Services thin clients (audio and screen recording)

n

Agents using just a phone, and no PC (audio recording only)

Note that Server Recording or Network Recording is not restricted to the time a user is logged
in. As long as the agent’s phone is configured for Server Recording or Network Recording, the
agent can be recorded.
If an agent’s phone is configured for Network Recording, supervisors and managers can
monitor a live call.
Note: You cannot monitor the default user, even if the default user is recorded using
Network Recording.
Server Recording and Network Recording have the following limitation:
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n

A device cannot be registered for Server Recording and Network Recording at the same
time. You can, however, change the configuration from Server Recording to Network
Recording, or from Network Recording to Server Recording.

VoIP Devices
The VoIP Devices window supports VoIP devices in the telephony groups (Unified CM
clusters) for Server Recording (SPAN) or Network Recording.
The first time you access the VoIP Devices window, it is empty. You must search the devices
configured in Unified CM for the ones you want to enable. See Enabling VoIP Devices for
Recording for more information.
The VoIP Devices window allows you to search for the devices configured in Unified CM and
enable the devices for Server Recording or Network Recording. You can then associate an
agent, a Monitor service server (Server Recording only), and a Recording Cluster with those
devices.
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VoIP Devices window fields and buttons

Field
Users Assigned
to Site

Find Devices of
Type

In Telephony
Group

Where

Matches

Description
The site’s IP address. You can filter knowledge workers by site.
You can choose from the following:
n

All Sites

n

<site’s IP address or hostname>

The type of device you want to locate. You can choose from the
following:
n

All Types

n

Cisco Phone

n

User Profiles

n

Remote Agent Port

The IP address for the telephony group. Your options are as
follows:
n

All Groups

n

<telephony group’s IP address or hostname>

The name of the device or extension for the device. You can
choose from the following:
n

Device Name—search devices by the name of the device.

n

Extension—search devices by the extension associated
with the device.

A string of text used to narrow the search for the device name or
extension. You can use wildcards * and question marks ? in this
field, in addition to a specific string.
Note: This field is case sensitive.
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Field
Find

Description
When clicked, locates every device that matches the search
criteria.
Note: The VoIP Devices window must be populated
before the Find button can display search results. See
Enabling VoIP Devices for Recording for more information.

Device Name

The name of the device.
If the device is a Cisco IP Communicator, type the MAC address
for the user’s PC. This text field is case-insensitive. The Device
Name must match the MAC address that packets travel through.

Device Type
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The type of device. The device types are:
n

All Types

n

Cisco Phone

n

User Profiles

n

Remote Agent Port

Telephony
Group

The IP address for the telephony group (Unified CM cluster).

Extension

The extension associated with the device. If a device has two
extensions associated with it, two entries appear in the search
results table. If you select the Enabled Check box for one
extension, Quality Management also selects the other extension.
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Field

Description

Agent or
Configure Agent

Allows you to assign one of the following login options to a device.
n

User Login Required—choose this option to configure the
device for Hot Desking. If you choose this option, the device
will not be recorded until an agent or knowledge worker
logs in using the Recording API.

n

Default Hoteling Agent—an agent logs into the device
using the login information for the default hoteling agent.

n

<Last name, first name, (user ID)>—choose this option to
assign a specific agent or knowledge worker or the default
hoteling agent to the device.

You can double-click the Agent field or click the Configure Agent
button when you want to associate a login option with a device.
Before you click Configure Agent, you must select one or more
devices.
See Considerations when Assigning Devices to Agents for more
information.
Monitor Server
or Configure
Monitor Server

Allows you to associate the IP address for the Monitor server with
this device. If a Monitor server is not applicable, the field displays
No Configuration.
EXAMPLE: You cannot associate a Monitor server with a
Remote Agent Port or User Profile.
You can double-click the Monitor Server field or click the
Configure Monitor Server button when you want to associate a
Monitor server with a device. Before you click Configure Monitor
Server, you must select one or more devices.

Signaling Group

Displays the signaling group associated with this device.
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Field
Recording
Cluster or Configure Recording
Cluster

Description
Allows you to assign the Recording Cluster to a device. If a
Recording Cluster is not applicable, the field displays No
Configuration.
EXAMPLE: You cannot associate a Recording Cluster
with a User Profile.
You can double-click the Recording Cluster field or click the
Configure Recording Cluster button when you want to assign a
Recording Cluster to a device. Before you click Configure
Recording Cluster, you must select one or more devices.
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Field
Recording Type
or Configure
Recording Type

Description
Allows you to assign recording type to a device.
You can double-click the Recording Type field or click the
Configure Recording Type button when you want to select a
recording type for a device. Before you click Configure Recording
Type, you must select one or more devices.
You can choose from the following options:
n

Event Notification—Choose this option when you are not
using Server Recording or Network recording but you
would like to use Live Monitoring and/or Screen Recording:

n

Server Recording—choose this option to use Server
Recording (SPAN).

n

Reconciliation—choose this option when the only type of
recording you are doing is reconciliation. You do not need
to choose this option to enable reconciliation, all calls are
reconciled. Choose this option when you are not using
Event Notification, server Recording, or Network Recording. This option is appropriate for MediaSense or Gateway
Recording.

n

Network Recording—choose this option to use Network
Recording.

EXAMPLE: Assign Event Notification to a device
configured for Cisco MediaSense Recording to allow Live
Monitoring and Screen Recording.
You cannot configure the recording type for a User Profile device.
Remove From
Configuration

When clicked, Remove From Configuration allows you to remove
one or more devices from the VoIP Devices table.
Note: You must select one or more devices before clicking
the button.
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Field

Description

Enable Unified
CM Devices for
Recording

When clicked, Enable Devices for Recording allows you to search
for devices in Unified CM and enable those devices for recording
in Quality Management.

Synchronize
Devices With
Clusters

When clicked, Synchronize Devices With Clusters allows you to
synchronize device changes from Unified CM with the list of
devices in the VoIP Devices window. It removes any devices that
were deleted in Unified CM and updates extensions for modified
devices.

Create/Edit
Default Hoteling
Agent

When clicked, Create/Edit Default Hoteling Agent allows you to
create or modify the following information for the default hoteling
agent:
n

First Name—the hoteling agent’s first name

n

Last Name—the hoteling agent’s last name

n

Windows Login—the login ID for the hoteling agent

n

Teams—the team assigned to the hoteling agent

This is a generic user profile. The agent does not log into the
phone using this user profile. It is assigned to a device in case an
agent does not log in.

VoIP Devices for Server Recording
For Server Recording with Unified CM clusters, associate the following items with the VoIP
device:
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n

An agent

n

The IP address for the Monitor server

n

The name of the Recording Cluster

n

A recording type of “Server Recording”
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VoIP Devices for Network Recording
For Network Recording with Unified CM clusters, associate the following items with the VoIP
device:
n

An agent

n

The name of the Recording Cluster

n

A recording type of “Network Recording”

Agent Considerations for Gateway Recording
When configuring VoIP devices using Gateway Recording for agents, consider the following:
n

Unified CM telephony group:
l

The Endpoint only Does Screen Recording check box must be selected in the
Unified CM Configuration dialog box (see Unified CM Configuration).
Note: If the Endpoint only Does Screen Recording check box is cleared,
the phone device will default to Desktop Recording (Endpoint).

n

ACD agent:
l

l

n

If the agent’s phone is daisy-chained you do not need to configure the device in
the VoIP Devices window.
If the agent’s phone is not daisy-chained the device must be configured in the
VoIP Devices window.

Knowledge worker:
l

l

The agent’s phone must be configured in the VoIP Devices window.
If the agent requires screen recording in a CUBE or MediaSense Recording environment, you need to assign Event Notification to the device and a Recording
Cluster that connects to a CTI server and has no Voice Record servers assigned
to it.

Recording Controls Considerations for Gateway Recording
When configuring VoIP devices using Gateway Recording, consider the following if you plan to
use Recording Controls:
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n

The Endpoint only Does Screen Recording check box must be selected in the Unified
CM Configuration dialog box (see Unified CM Configuration) when you configure the
Unified CM telephony group.

n

Recording Type must be set to either Event Notification or Reconciliation

Licensing and VoIP Device Configuration Considerations
When configuring VoIP devices and assigning licenses to users, note the following:
n

The CTI service checks for valid licenses every sync.

n

If a license becomes invalid or a user’s license is added, removed, or changed, the
change will take effect the next time the CTI service syncs.

n

If the license server is unavailable, the CTI service will use the last licensing state that it
successfully received.

Considerations when Assigning Devices
When using the Agent drop-down list or the Configure Agent button to a assign device to an
agent or a knowledge worker, consider the following:
n

Call Recording and Quality Management is licensed by the number of named
users. Named users are users who are configured and licensed.
Example: agents, knowledge workers, supervisors, managers, evaluators, and
archive workers
The total number of devices that you can assign to Default Hoteling Agent is equal to the
total number of licenses for your system.
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n

Assigning a device to Default Hoteling Agent does not use or consume a license, it just
puts a limit to the number of devices that can be assigned to Default Hoteling Agent. This
prevents a situation where Login commands are not processed when the Base server is
not available or there is an error when a user tries to log into the system. It ensures the
device is recorded no matter what the situation is.

n

Do not assign the Default Hoteling Agent to Extension Mobility profiles.

n

If you do not assign the device to Default Hoteling Agent and intend to use Hot Desking
you must choose User Login Required from the Configure Agent drop-down list. This
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ensures that the device will be recorded when someone logs into the device using Extension Mobility or the Login API command.

Guidelines for Configuring VoIP Devices
Consider the following when you configure a VoIP device for Server Recording or Network
Recording.
The VoIP Devices window only allows 64 characters in the fields. This affects the number of
extensions you can configure for a VoIP device. You can configure up to 12 extensions of 4
digits each for a VoIP devices and not exceed the 64 character limitation.
EXAMPLE: 5555,5556,5557,5558,5559,5560,5561,5562,5563,5564,5565,5566

Hot Desking
Hot Desking is a situation where one desk is shared between several people who use the desk
at different times. This work surface can be an actual desk or just a terminal link. Companies
use Hot Desking when not all the employees are in the office at the same time, or employees
are not regularly in the office for very long.
Hot Desking includes the following scenarios:
n

Using Extension Mobility

n

Sharing the same extension

n

Logging into the Recording API—see the API Programmers User Guide for more
information on the Recording API

Points to Remember
Remember the following points when you configure a device for Hot Desking:
n

When configuring Hot Desking for an agent with a Quality Management license or Call
Recording license, you must use the Login and Logout commands for the Recording
Controls API.

n

If an agent is already logged in to a different device, Quality Management logs the agent
out of the old device when the agent logs into the new device.

n

If you assign a device to an agent by selecting an option in the Agent column from the
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VoIP devices window:
l

l

The agent cannot use the Recording Controls API to log into the device (the login
will be ignored).
The agent can use the Recording Controls API to log into a different device.
Quality Management records both devices for the agent.

n

If an agent is on a call when another login request comes in, that call is ended. Quality
Management logs the agent out, creates a new user for that extension, registers the
device with the CTI, and records all subsequent calls for that extension.

n

If an agent issues a logout command using the Recording Controls API and there is an
active call for that extension, Quality Management ends the call, and logs out the user.

n

If an agent issues a login command using the Recording Controls API, and the username and extension matches the username and extension for an agent who is currently
logged in, Quality Management ignores the request.

n

The Desktop Recording service supports Hot Desking, provided the agents use their
own accounts to log in and log out of their client machine.

Synchronization Issues
The following list describes the synchronization issues with the devices listed in the VoIP
Devices window.
n

An agent configured for a device could be deactivated, lose the agent or knowledge
worker role, or become unlicensed. In these cases, the agent can no longer be recorded,
and Quality Management removes their association with their device. Every time the
VoIP Devices window appears and loads the data, the agents are automatically
synchronized. The VoIP Devices window displays a list of the invalid agents that will be
removed from their associated devices.

n

Someone modifies or removes a configured device in the Unified CM cluster. When you
click the Synchronize Devices with Clusters button, it updates the modified devices and
then displays a list of devices configured for Server Recording but no longer configured
in a cluster. You can choose to remove the devices from the VoIP Devices list.

Enabling VoIP Devices for Recording
Use this task to enable VoIP devices for recording.
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1. On the VoIP Devices window, click Enable Devices for Recording.
You must click this button before you do anything else on this window to populate the
list of VoIP devices.
2. Choose one of the following options.
l

To find all the devices in the available cluster, click Find.
Note: By default, the search criteria are set up to return every device in a
selected cluster when you click Find.

l

If the cluster has many devices, you can search for devices that match a certain
criteria. You can search by a combination of device type (Phone, Remote Agent
Port, User Profile, or All Types), cluster IP address, device name, or extension.
Note: You can type wildcard characters (* or ?) or specific numbers in the
Matches field. This field is case sensitive.
A list of all of the devices that are in the cluster appears.
If a device has two extensions associated with it, two entries appear in the
search results table. If you select the Enabled check box for one extension,
Quality Management Administrator also selects the other extension.

3. To sort by a particular column, click the column heading.
4. Choose one of the following options:
l

l

To select a specific device, click its row.
To select additional devices, press and hold the Ctrl key while clicking the other
rows.

5. When you are done selecting devices, click Check Selected, and then click OK.
The devices you selected appear on the list of VoIP devices

Filtering VoIP Devices
1. On the VoIP Devices window, choose a site from the Users Assigned to Site dropdown list.
2. Choose the type of device you want to locate from the Find Devices of Type drop-down
list in the Device Search pane.
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3. Choose the IP address for the cluster from the In Cluster drop-down list.
4. Enter the name of the device or extension for the device in the Where drop-down list.
You can use wildcards * and question marks ? in this field, in addition to a specific
string.
5. Click Find.
The VoIP Devices window displays a list of devices that match the search criteria.

Configuring Devices for VoIP
The general procedure for configuring a device for VoIP monitoring is as follows:
Note: To configure multiple devices, see Managing VoIP Devices.
1. Enable the devices for recording.
See Enabling VoIP Devices for Recording for more information.
2. Find the devices to be configured.
See Filtering VoIP Devices for more information.
3. Assign a device to a Recording Type.
4. Assign a device to an agent, the default hoteling agent, or User Login Required.
5. Assign a device to a Recording Cluster.
The Recording Cluster is not required for User Profiles.
6. Assign a device to a Monitor server.
7. Assign a device to a recording type.
8. Click Save.

Filtering by Site
n

To filter agents or knowledge workers by site, choose a site from the Users Assigned to
Site drop-down list.
The agents or knowledge workers associated with the selected site appear in the VoIP
Devices window.
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Extension Mobility for Network Recording and Server Recording
When configuring agents for extension mobility in a Network Recording or Server Recording
environment, you need to ensure the following:
n

A user profile is associated with each agent

n

Every phone an agent can log in to is associated with a Recording Cluster

When an agent logs in to a phone, their calls are recorded by the Recording Cluster assigned
to their phone.
When configuring agents for Extension Mobility, consider the following:
n

If the user is on a phone call when they log out of a device, the recording will stop.

n

If you change the user profile (for example, the extension) in Unified CM, you must click
the Synchronize Devices with Clusters button in the VoIP Devices window for the
change to take effect.

n

If you change the user profile in Unified CM and synchronize the databases in Quality
Management Administrator, current calls on that device might be stopped and restarted.

Configuring a User for Extension Mobility
Follow the steps as described in Enabling VoIP Devices for Recording to populate the list of
VoIP Devices.
1. From the VoIP Devices window, select a device assigned to the Extension Mobility profile (Device Type is User Profile) created in Cisco Unified CM, and then click Configure
Agent.
The Configure Agent dialog box appears.
2. Choose Default Hoteling agent or User Login Required from the Configure Agent
drop-down list.
To ensure all calls are recorded on the phone, choose the default Hoteling agent from
the Configure Agent drop-down list.
3. Assign the device to a Recording Cluster.
4. Assign the device to a Monitor server.
5. Assign the device to a recording type.
6. Click Save.
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Managing VoIP Devices
Follow the steps as described in Enabling VoIP Devices for Recording to populate the list of
VoIP Devices.
n

To synchronize device changes from Unified CM with the list of devices in the VoIP
Devices window, click Synchronize Devices With Clusters, and then click OK.
Whenever you modify a VoIP device in Unified CCX, the modifications do not go into
effect until the Unified CCX and Quality Management databases synchronize.

n

To assign multiple devices to a Monitor Server, select the devices from the list, click Configure Monitor Server, select the IP address for the Monitor Server from the drop-down
list, click OK, and then click Save.
l

Use Shift + Click to select contiguous rows in the list of devices.

l

Use Ctrl + Click to select non-contiguous rows in the list of devices.

n

To assign multiple devices to a Recording Cluster, select the devices from the list, click
Configure Recording Cluster, select the name of the Recording Cluster from the dropdown list, click OK, and then click Save.

n

To assign multiple devices to a recording type, select the devices from the list, click Configure Recording Type, select the appropriate recording type from the drop-down list,
click OK, and then click Save.

n

To assign the agent association for multiple devices, select the devices from the list, click
Configure Agent, choose the agent association from the drop-down list, click OK, and
then click Save.
You can only assign the following agents association to multiple devices.
l

l

n

Default Hoteling Agent—all recordings on the device will be associated with the
Default Hoteling Agent until another agent or knowledge worker logs into the
device.
User Login Required—the agent or knowledge worker logs into the device using
their own login information.

To assign a device to an agent, double-click the device’s Agent field, select the agent or
knowledge worker from the drop-down list, and then click Save.
You can type text in the drop-down field to filter the list of agents or knowledge workers
to show only agents whose first name, last name, or Windows login begins with the
entered text.
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If that agent or knowledge worker is already assigned to a device, you are asked if you
want to switch the association to the current device.
l

l

n

If you select Yes, the agent or knowledge worker will be assigned to this device
and removed from the other device.
If you select No, no association is made and you can select another agent or
knowledge worker to assign to this device.

To assign a device to a Monitor Server, double-click the device’s Monitor Server field,
choose the IP address for the Monitor Server from the drop-down list, and then click
Save
When configuring a Monitor Server, note the following:
l

l

The Recording Type must be Server Recording (SPAN)
You cannot associate a Monitor server with a Remote Agent Port (CTI port)
device because the server for the Monitor service must be found at run-time.

n

To assign a device to a Recording Cluster, double-click the device’s Recording Cluster
field, select the name of the Recording Cluster from the drop-down list, and then click
Save.

n

To assign a device to a recording type, double-click the device’s Recording Type field,
select the appropriate recording type from the drop-down list, and then click Save.

n

To create or edit the default hoteling agent, click Create/Edit Default Hoteling Agent,
complete the fields and then click OK.

n

To remove one or more devices, select the devices from the list, click Remove From Configuration, click Yes, and then click Save.
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Use the Personnel node to:
n

Create groups

n

Create knowledge worker teams

n

Assign teams to groups

n

Assign groups to managers

n

Link AD users to ACD users and non-ACD users (in Active Directory systems)

n

Configure ACD users

n

Create non-ACD users

n

Assign business administrator, telephony administrator, manager, evaluator, and
archive user roles to ACD users

n

Assign business administrator, telephony administrator, knowledge worker, supervisor,
manager, evaluator, and archive user roles to non-ACD users

User Roles and Privileges
Scope refers to the data (such as recordings and evaluations) that a user can view.
EXAMPLE: The scope of a supervisor who has one team of knowledge workers
consists of the recordings and evaluations for those knowledge workers. The scope of a
manager who has several groups of teams of agents and knowledge workers consists of
the data for all of those agents and knowledge workers
A role is a collection of privileges. A user can have one or many roles. When the user logs into
Unified Workforce Optimization, the user can access all roles and privileges assigned to that
user.
Example: If a user is assigned to both the evaluator and manager roles, the user has
access to all privileges assigned to the evaluator and manager roles.
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A privilege is the permission to perform a transaction. For example, managers have the ability
to access archive recordings for their groups.
Quality Management defines a user’s scope by roles and privileges.

Administrator
The administrator responsibilities are partitioned into the following hierarchical roles: system
administrator, telephony administrator, business administrator.
You can configure system administrators when you run System Configuration Setup
(PostInstall.exe). Configuring system administrators is a two-step process:
1. Create users in Quality Management Administrator.
Note: If you are using Active Directory, the users must be assigned to the Admin
Group. See the description of Admin Group in Domain Information for additional
information.
2. Assign users to the system administrator role in Administrator Configuration under
System Configuration Setup (PostInstall.exe).
Important: Once you assign the system administrator role to a user in a nonActive Directory environment, the default administrator user becomes obsolete
and you can no longer log in as a default administrator.
The system administrator is primary responsible for server configuration, IP changes,
integration points, and passwords. The system administrator can configure telephony and
business administrators.
A telephony partition is a group and/or team to which a telephony administrator is assigned. If
you want the telephony administrator to administer a specific set of groups or teams, you must
assign the manager or supervisor role to the telephony administrator, and then assign the
groups or teams.
Example: If you want a manager to be responsible for administering a specific group,
assign the telephony administrator role to the manager.
The telephony administrator is primary responsible for who is configured and/or recorded, the
workflows, and the type of devices and recording methods used in the assigned groups and
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teams within the telephony partition. The telephony administrator can also determine who has
the following privileges in Unified Workforce Optimization.
n

Accessing recordings

n

Evaluating recordings

n

Reporting on recordings

n

Exporting of recordings

The telephony administrator can configure business administrators within the telephony
partition.

The business partition is a group and/or team to which a business administrator is assigned. If
you want the business administrator to administer a specific set of groups or teams, you must
assign the manager or supervisor role to the business administrator, and then assign the
groups or teams.
Example: If you want a supervisor to be responsible for creating and configuring
evaluation forms and templates for assigned teams, assign the business administrator
role to the supervisor.
The business administrator is primarily responsible for creating and configuring evaluation
forms and templates for assigned groups and teams within the business administrator partition.
When managing administrators, consider the following points:
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n

In an Active Directory environment, the system, telephony, or business administrator
must have an AD Account user associated with the Security Group security setting.

n

In a non-Active Directory environment, the system administrator is created when you
installed/upgraded Quality Management.

n

Telephony and business administrators can be promoted to system administrators.

n

System, telephony, and business administrators can log in to Quality Management
Administrator.

n

Only the system administrator can log in to Unified Workforce Optimization to manage
the Dashboard. The system administrator does not require a license to log into Call
Recording and Quality Management. However, a Call Recording and Quality Management license is required if you want the system administrator to manage the Dashboard application in Unified Workforce Optimization.

The scope for each administrator role is shown in the following table.
Area

System
Window or feature

System Configuration or PostInstall.exe
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Telephony

Business

Administrator Administrator Administrator

System Database

X

Data Synchronization

X

Telephony Groups

X

Enterprise Settings

X

Site Settings

X

Recording Clusters

X

Mobile Agent Monitor

X

Inclusion List

X

X

Monitoring and Notification

X

X

Status

X

X

X

Personnel

Area

System
Window or feature

Record Server Configuration

Personnel

Recordings

Telephony

Business

Administrator Administrator Administrator

Mobile Agent Monitor

X

X

VoIP Devices

X

X

User Administration

X

X

Team Administration

X

X

Group Administration

X

X

Quality Management
Workflows

X

X

Evaluation Forms

X

X

X

Templates

X

X

X

Forms

X

X

X

Archive Workflows

X

X

Metadata

X

X

Export

X

X

Call Events

X

X

Desktop Configuration

X

X
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Area

System
Window or feature

Unified Workforce
Optimization

Telephony

Business

Administrator Administrator Administrator

Dashboard: configuring
dashboards by role

X

Dashboard: lock down
dashboard

X

Recordings

X

Live Monitoring

X

Recording Monitoring

X

Application Management

X

Reporting

X

Agents and Knowledge Workers
Agents and knowledge workers have the following privileges:
n

View their own quality scores and the aggregate quality scores for their team and group
on a dashboard

n

Export recordings within their scope, if enabled

n

Review evaluation results on their own scored contacts

n

Enter comments on their scored evaluations.

n

View their own historical reports

n

Access recordings of their own contacts, if enabled
Note: Agents who are not assigned to a team can still log into Unified Workforce
Optimization and access their customer conversations.

n
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Access all recordings marked as Training
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Supervisors
Supervisors have the following privileges:
n

View dashboard with their team’s and group’s quality scores and details of individual
agents within their team

n

Enter comments on their team’s scored evaluations

n

Evaluate contacts for their team, when an evaluation form is enabled for supervisors

n

Update their previously-scored evaluations

n

Export recordings within their scope, if enabled

n

Approve evaluations for agents in their teams, if required

n

Designate recordings in their teams to be retained as Training or HR recordings

n

View agent and team-level historical reports

n

Access customer conversations for their team

Managers
Managers have the following privileges:
n

View dashboard with their group’s quality scores and details of individual teams within
their group

n

Review evaluation results on all of their group’s scored contacts

n

Enter comments on their group’s scored evaluations

n

Evaluate contacts for their group, when an evaluation form is enabled for managers

n

Approve evaluations for agents in their groups, if required

n

Update their previously-scored evaluations

n

Export recordings within their scope, if enabled

n

Designate contacts for retention as Training contacts

n

View agent, team, group, and enterprise-level historical reports

n

Access customer conversations for their group

Archive Users
Archive users have the following privileges:
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n

Search and review customer conversations for all of the agents and knowledge workers
across the enterprise

n

Export customer conversations, if enabled

n

Access customer conversations for deleted users

Evaluators
Evaluators have the following privileges:
n

Select, review, and evaluate customer conversations for all groups

n

Review recordings and add comments to evaluations for agents and knowledge workers
in all groups

n

Approve evaluations, if required

n

Export recordings within their scope, if enabled

n

Update your previously-scored evaluations

n

Designate contacts for retention as Training or HR contacts

User Administration
The User Administration window allows you to:
n

Create and configure users.

n

Assign the telephony administrator, business administrator, knowledge worker,
supervisor, manager, evaluators, and archive user roles.

n

Make group and team assignments.

n

License the users using the license added from Site Configuration.

The User Administration window displays one of two versions, depending on whether or not
you configure your system to interface with Microsoft Active Directory.

Active Directory Systems
In an Active Directory system, there are three types of users:
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n

Active Directory Account. A user set up in Microsoft Active Directory. All users in
Quality Management must be in Active Directory. You can only configure a user in
Quality Management if that user has a last name in Active Directory.

n

ACD User. A user set up as an agent and/or supervisor and assigned to a team in the
ACD. You can assign an ACD user to manager, evaluator, and archive user roles in
Quality Management.

n

Non-ACD User. A user created in Quality Management.

Note: Whenever you modify a user in the ACD (for example, change a user’s name),
the modifications do not appear in Quality Management until synchronization occurs.
The synchronization process runs automatically at 10-minute intervals. If necessary, you
can manually synchronize these databases (see Synchronizing Databases for more
information).
You must link an ACD user to an Active Directory account within Quality Management to
assign roles to that user in Quality Management.
The User Administration window has tabs that sort users into categories according to their
roles and status within Quality Management. You can use Shift+click or Ctrl+click to select
items in a tab's table and then copy and paste the results to other applications. When more
than one user is selected, the User Properties panel and bulk modifications are disabled.
The following image displays the User Administration window for Unified CCX.
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The following table describes the buttons.
User Administration buttons

Tab
Link AD to ACD
Users

Description
Assign an ACD user to an Active Directory account.
Note: Once you link an Active Directory to an ACD account,
you can only unlink the Active Directory account by deleting
the user from the ACD system.

Create Users
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Add a non-ACD user. Non-ACD users are users that exist only in
Quality Management and Active Directory. Non-ACD users do not
exist in the ACD. Like ACD users, you must link non-ACD users to an
Active Directory Account to be part of the Quality Management
system.

Personnel
Tab

Description

License Users

Assign a user with a license. See License/Unlicense Users for more
licensing information.

Delete User

Remove a non-ACD user. See Deleting an ACD User for information
on deleting an ACD user.

Search

When clicked, locates every users that match the search criteria.

Add

Add an ACD team, QM team, or group to a list.

Remove

Delete an ACD team, QM team, or group from a list.

Save

Saves your changes.

Cancel

Cancels your current changes.

The following table describes the search fields. The search fields are disabled until you click the
Search tab. Use one or more filters when running a search. A search with no filters returns all
users.
The following filters can use the * wildcard at the beginning or end of a search string: Last
Name, First Name, Windows Login, and Extension. If the search string does not contain an *,
the results will display all results that contain the specified search string.
User Administration search fields

Tab

Description

Last Name

Filters the search by the user's last name.

First Name

Filters the search by the user's first name

Group

Filters the search by the name of the group.

Team

Filters the search by the name of the team.

Windows Login

Filters the search by the user's Windows login,

Extension

Filters the search by the user's extension.

The following table describes the tabs.
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User Administration tabs

Tab

Description

Linked Users

Active Directory users linked to an ACD or non-ACD users. This
includes the administrator.

Managers

ACD and Non-ACD users assigned to the manager role.

Evaluators

ACD and Non-ACD users assigned to the evaluator role.

Archive Users

ACD and Non-ACD users assigned to the archive user role.

Supervisors

ACD users assigned to the supervisor role or non-ACD users
assigned to the supervisor role.

Agents

Users assigned to the agent role in the ACD.

Knowledge Worker

Non-ACD users assigned to the knowledge worker role.

Unlinked ACD
Users

ACD users who are not linked to an Active Directory user.

Unassigned Users

Non-ACD users not assigned to the manager, evaluator,
knowledge worker, supervisor, or archive user roles. This tab only
lists non-ACD users, because ACD users always have at least one
role.

Administrators

Users assigned to the administrator role.

Search

Users found by the search feature.

The following table describes the information that appears about the users on each tab.
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User Administration tab columns

Column
License

Description
The license assigned to the user. The possible licenses are:
n

CR

n

CRA

n

QM

n

QMA

n

AQM

n

AQMA

A user must be licensed to be able to log into Unified Workforce
Optimization and be recorded.
Last Name

The user’s last name, as set up in the ACD or Quality Management.
The name appears as it is configured in Active Directory.
For Active Directory authentication, the first and last names are
displayed in their respective columns after you link a user. A report
that normally displays a user’s first and last name will display the
Active Directory first and last name.

First Name

The user’s name appears as it is configured in Active Directory.

User ID

The user ID assigned to the user. The format of an ACD user ID is
<agent’s PG>.<agent’s ICM Peripheral Number>.

Assigned Team

The team assigned to the agent.

Assigned Group

The group assigned to the agent.

Windows Login

The user’s Windows user name.
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Column
Administrator Role

Description
The administrator role assigned to the user. Use the Admin Role
drop-down list to assign the business or telephony administrator
role to a user. The possible values are as follows:
n

None—no administrator roles are assigned to the user.

n

Business—assigns the business administrator role to the
user.
Note: Only a system administrator or telephony
administrator can assign the business administrator
role to a user.

n

System—indicates the user is a system administrator.
Note: The Administrator Role drop-down list is
disabled when the user is a system administrator. See
Administrator Configuration for more information on
assigning users to the system administrator role.

n

Telephony—assigns the telephony administrator role to the
user.
Note: Only a system administrator can assign the
telephony administrator role to a user.

Domain

The domain assigned to the Active Directory user.

Extension

The extension associated with the Active Directory user.

When you select a user listed in any of the tabs, that user’s properties are displayed in the
lower section of the window. User properties are described in the following table.
User Properties fields

Column
License
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Description
The license assigned to the user.

Personnel
Column

Description

First Name

The user’s first name, as set up in the ACD or Quality Management.

Last Name

The user’s last name, as set up in the ACD or Quality Management

Assigned Team

The team assigned to the agent or knowledge worker.

User ID

The user ID assigned to the user. If the user is an ACD user, the
format is <agent’s PG>.<agent’s ICM Peripheral Number>. If the
user is a Quality Management user, the Quality Management
system assigns a number.

Roles

The roles assigned to the user. The available check boxes are as
follows:
n

Agent (available for ACD users only and disabled by default)

n

Knowledge Worker (available for non-ACD users only)

n

Supervisors (disabled by default for ACD users)

n

Evaluator

n

Manager

n

Archive User

Supervisor’s ACD
Team

Lists the ACD teams assigned to the supervisor in a Unified CCX
environment.

Supervisor’s QM
Team

Lists the QM teams assigned to the supervisor.

Manager’s Groups

Lists the groups assigned to the manager.

Using Bulk Linking
Use this task to link ACD users to Active Directory accounts when you initially set up Quality
Management.
1. From the User Administration window, click Link AD to ACD Users.
The Link AD to ACD Users dialog box appears.
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2. Select the Active Directory domain that your users are in from the Domain drop-down
list.
3. Select the path to your users from the UserPath list
You can select one or more user paths from this list.
4. Click Find.
The users who exactly match the search query appear in the list. The first five columns
display information from Active Directory. The last three columns display information
from the ACD.
5. Select the Active Directory accounts that you want to link to your ACD users, and then
click OK.
To link all users in the list, click Select All.
Note: If some ACD users have names that don’t exactly match their Active
Directory accounts, you have to link them individually.
The following figure displays selected users in the Link Active Directory to ACD Users
dialog box.
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The ACD users that you linked to Active Directory accounts appear on the Linked
Users tab.

Linking an ACD User to an Active Directory account
Use this task to link an ACD user to an Active Directory account.
1. From the User Administration window, click the Unlinked ACD Users tab.
2. Select the user you want to link, and then click Link User.The Link Selected User dialog
box appears with the user’s last name and first name already filled in with the first two
letters (plus an asterisk, which is a wildcard).
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Important: If the Active Directory account you are trying to link to an ACD user
is already assigned to the system administrator role, the following message
appears:
AD user <Doe, John> is already designated as a QM user.
Delete user <Doe, John> first.
Delete the user as instructed (see Deleting a Non-ACD User), create a new
non-ACD user (see Creating a non-ACD User using Active Directory or
Creating a Non-ACD User without Active Directory) and then reassign the
system administrator role to the user (see Managing Administrators).
In a non-Active Directory environment, you must ensure that there is a
replacement non-Active Directory user assigned to the system administrator
role because the default administrator role in a non-Active Directory
environment is no longer available the moment you assign a user to the system
administrator role in Administrator Configuration.
3. Optional: Select the Active Directory domain that your users are in from the Domain
drop-down list.
4. Optional: Select the path to your users from the UserPath list.
5. Enter your search criteria in one or more of the following fields:
l

Last Name

l

First Name

l

Windows Login Name

You can use an asterisk as a wildcard character. The asterisk matches any number of
characters.
6. Click Find.
The users who match the search query appear in the list.
7. Select the Active Directory account you want to link your ACD user with from the
search results, and then click OK.
The user you just linked now appears under the Linked Users tab.
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Assigning User Roles to an ACD User
Use this task to assign Quality Management user roles to an ACD user. You can assign an
ACD user to the following roles: manager, evaluator, and archive user.
1. Select the ACD user from the Linked Users tab in the User Administration window.
The user’s properties appear in the User Properties section of the window.
2. Select the desired role check box in the Roles section.
l

If you assigned the Manager role, you can now assign a group to the manager.
Click Add under the Manager’s Groups section and select the appropriate group.

You cannot assign the agent and/or supervisor role to an ACD user from Quality
Management Administrator. You can only assign agent and supervisor roles in Unified
CCX.
3. Optional. To assign an business or telephony administrator role to the user, click
Administrator Role and choose Telephony or Business.
4.
Note: To assign the system administrator role, see Administrator Configuration.
5. Click Save.

Switching Active Directory–ACD Links
Once you link an ACD user to an Active Directory account, you cannot unlink the ACD user.
You can switch a link from one Active Directory account to another Active Directory account by
following the procedure for linking an ACD user to an Active Directory account and selecting a
new Active Directory user to link to.
If that Active Directory account is already linked to an ACD user, the links will be switched. For
example, if:
n

ACD User 1 is linked to Active Directory Account 1

n

ACD User 2 is linked to Active Directory Account 2

and you want to link ACD User 1 to Active Directory Account 2, you can do so. The end result is
that the links will be switched:
n

ACD User 1 is linked to Active Directory Account 2

n

ACD User 2 is linked to Active Directory Account 1
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There are other linking/unlinking situations that can exist. When you attempt to link or unlink
various combinations of ACD, Active Directory, and Quality Management users, popup
messages appear telling you what you must do to accomplish the task, or if it is allowed in
Quality Management.

Creating a Non-ACD User
Use this task to create a non-ACD user.
1. From the User Administration window, click Create Users.
The Link New Users dialog box appears.
2. Optional: Select the Active Directory domain that your user is in from the Domain dropdown list.
3. Optional: Select the path to your user from the UserPath list.
4. Enter your search criteria in one or more of the following fields:
l

Last Name

l

First Name

l

Windows Login Name

You can use an asterisk as a wildcard character. The asterisk matches any number of
characters.
5. Click Find.
The users who match the search query appear in the list.
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6. Select the specific Active Directory account that you want to link, and then click OK.
The non-ACD user you created appears in the Linked Users tab.

Assigning Roles to a Non-ACD User
Use this task to assign roles to a non-ACD user. You can assign non-ACD users to the
following roles: knowledge worker, supervisor, manager, evaluator, and archive user.
1. Select the non-ACD user from the Unassigned Users tab.
The user’s properties appear in the User Properties section of the window.
2. Select the desired role check box in the Roles section.
l

If you assigned the Knowledge Worker role, you can now assign the knowledge
worker to a team using the enabled Assigned Team field. Select the appropriate
team from the drop-down list. The team can consist only of knowledge workers.
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Note: Quality Management does not record the knowledge worker until
you assign that user to a team.
l

l

If you assigned the Manager role, you can now assign a group to the manager.
Click Add under the Manager’s Groups section and select the appropriate group.
If you assigned the Supervisor role, you can now assign a team to the
supervisor. Click Add under the Supervisor’s ACD Teams and/or Supervisor’s
Quality Management Teams sections and select the appropriate team(s).

3. Click Save.

Non-Active Directory Systems
In a non-Active Directory system, there are two types of users:
n

ACD User. A user set up as an agent and/or supervisor and assigned to a team in
Unified CCX. You can assign an ACD user to manager, evaluator, and archive user
roles in Quality Management.

n

Non-ACD User. A non-agent user set up in Quality Management.

Note: Whenever you modify a user in Unified CCX (for example, change a user’s
name), the modifications do not appear in Quality Management until synchronization
occurs. The synchronization process runs automatically at 10-minute intervals. If
necessary, you can manually synchronize these databases (see Synchronizing
Databases for more information).
The User Administration window has tabs that sort users into categories according to their
roles and status within Quality Management. You can use Shift+click or Ctrl+click to select
items in a tab's table and then copy and paste the results to other applications. When more
than one user is selected, the User Properties panel and bulk modifications are disabled.
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The following table describes the buttons.
User Administration buttons

Tab

Description

Create
Users

Add a non-ACD user. Non-ACD users are users that exist only
in Quality Management and Active Directory. Non-ACD users
do not exist in Unified CCX. You must link non-ACD users to an
Active Directory Account to be part of the Quality Management
system.

License
Users

Assign a user with a license. See License/Unlicense Users for
more licensing information.

Delete
User

Remove a non-ACD user. See Deleting an ACD User for
information on deleting an ACD user.

Edit
User

Configure the user properties.
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Tab

Description

Search

When clicked, locates every users that match the search
criteria.

Add

Add an ACD team, QM team, or group to a list.

Remove

Delete an ACD team, QM team, or group from a list.

Save

Saves your changes.

Cancel

Cancels your current changes.

The following table describes the search fields. The search fields are disabled until you click the
Search tab. Use one or more filters when running a search. A search with no filters returns all
users.
The following filters can use the * wildcard at the beginning or end of a search string: Last
Name, First Name, Windows Login, and Extension. If the search string does not contain an *,
the results will display all results that contain the specified search string.
User Administration search fields

Tab

Description

Last Name

Filters the search by the user's last name.

First Name

Filters the search by the user's first name

Group

Filters the search by the name of the group.

Team

Filters the search by the name of the team.

Windows Login

Filters the search by the user's Windows login,

Extension

Filters the search by the user's extension.

The following table describes the tabs.
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User Administration tabs

Tab

Description

Configured
Users

All non-ACD users who have been set up in Quality
Management. This includes the administrator.

Managers

Non-ACD users assigned to the manager role.

Evaluators

Non-ACD users assigned to the evaluator role.

Archive Users

Non-ACD users assigned to the archive user role.

Supervisors

Non-ACD users assigned to the supervisor role.

Agents

Non-ACD users assigned to the agent role in Unified
CCX.

Knowledge
Worker

Non-ACD users assigned to the knowledge worker role.

Not
Configured
Users

Non-ACD users who have not yet been set up in Quality
Management.

Unassigned
Users

Non-ACD users not assigned to the manager, evaluator,
knowledge worker, supervisor, or archive user roles.

Administrators

Users assigned to the administrator role.

Search

Users found by the search feature.

Each tab displays information about the users that fall into its category, as shown in the
following table.
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User Administration tab columns

Column
License

Description
The license assigned to the user. The possible licenses are:
n

CR

n

QM

n

AQM

A user must be licensed to be able to log into Unified
Workforce Optimization and be recorded.
Last Name

The user’s last name, as set up in the ACD or Quality
Management.
When syncing users from the ACD, this field displays the
user’s entire name (first and last name), and the First Name
field remains empty. If you are using QM authentication, a
report that normally displays a user’s first and last name
only syncs the information from the agent’s name field and
displays the entire name in the Last Name field.
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First Name

The user’s first name, as set up in the ACD or Quality
Management.

User ID

The user ID assigned to the user. If the user is an ACD
user, the format is <agent’s PG>.<agent’s ICM Peripheral
Number>. If the user is a Quality Management user, the
Quality Management system assigns a number.

Assigned
Teams

The team assigned to the agent or knowledge worker.

Assigned
Groups

The group assigned to the agent.

Windows
Login

The user’s Windows user name.

Personnel
Column

Description

Administrator
Role

The administrator role assigned to the user. Use the Admin
Role drop-down list to assign the business or telephony
administrator role to a user. The possible values are as
follows:
n

None—no administrator roles are assigned to the
user.

n

Business—assigns the business administrator role to
the user.
Note: Only a system administrator or
telephony administrator can assign the
business administrator role to a user.

n

System—indicates the user is a system
administrator.
Note: The Administrator Role drop-down list
is disabled when the user is a system
administrator. See Administrator
Configuration for more information on
assigning users to the system administrator
role.

n

Telephony—assigns the telephony administrator role
to the user.
Note: Only a system administrator can assign
the telephony administrator role to a user.

Extension

The extension associated with the user.

When you select a user listed in any of the tabs, that user’s properties are displayed in the
lower section of the window. User properties are described in the following table.
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User Properties fields

Column

Description

License

The license assigned to the user.

First Name

The user’s first name, as set up in the ACD or Quality
Management.

Last Name

The user’s last name, as set up in the ACD or Quality
Management.

Assigned
Team

The team assigned to the agent or knowledge worker.
Note: The Assigned Team drop-down list only
displays teams containing knowledge workers.
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User ID

The user ID assigned to the user. Quality Management
assigns a number to the user ID.

Windows
Login

The user’s Windows user name.

Admin Role

The administrator role assigned to the user. The possible
values are as follows:
n

None—no administrator roles are assigned to the
user.

n

Business—assigns the business administrator to
the user.

n

Telephony—assigns the telephony administrator to
the user.

Personnel
Column
Roles

Description
The roles assigned to the user. The available check boxes
are as follows:
n

Agent (available for ACD users only and disabled
by default)

n

Knowledge Worker (available for non-ACD users
only)

n

Supervisors (disabled by default for ACD users)

n

Evaluator

n

Manager

n

Archive User

Supervisor’s
ACD Team

Lists the ACD teams assigned to the supervisor.

Supervisor’s
QM Team

Lists the QM teams assigned to the supervisor.

Manager’s
Groups

Lists the groups assigned to the manager.

Configuring an ACD User
Use this task to configure Unified CCX user for Quality Management. An ACD user is not a
part of Quality Management system until you configure the ACD user in Quality Management
Administrator.
An ACD user can only be assigned the agent role or supervisor role in Unified CCX. You can
only assign ACD teams to a supervisor in Unified CCX.
Enter the ACD user’s Windows login name and Quality Management login password to
configure an ACD user in Quality Management.
1. On the Not Configured Users tab, locate and select the user you want to configure.
2. In the User Properties section, click Edit User and enter the user’s Windows Login and
Quality Management Password.
The Windows login name must be unique, but users can have the same first and last
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names. It must be between 1 and 64 characters long, cannot consist entirely of spaces,
and cannot include these characters: / \ [ ] : ; " | = , + * ? < > ( )
3. If necessary, assign the user the Evaluator, Archive User, and/or Manager role by
selecting the check boxes next to those roles.
l

l

If you assigned the Manager role, you can now assign a group to the manager by
clicking Add under the Manager’s Groups section and selecting the appropriate
group.
If you assigned the Supervisor role, you can now assign a team to the supervisor
by clicking Add under the Supervisor’s ACD Teams section and/or Supervisor’s
QM Team and selecting the appropriate team.

4. Click Save.
The ACD user is removed from the Not Configured User tab and appears under the
tab for each role that you assigned to the ACD user. For instance, if you assigned the
ACD user to the evaluator role, the ACD user appears under both the Agents tab and
the Evaluators tab.
Note: The ACD users initially appear under the Agents and/or Supervisors tabs
and non-ACD users under the Unassigned Users tab.

Creating a Non-ACD User
This task describes how to create a non-ACD user. A non-ACD user exists only in Quality
Management. The non-ACD user does not exist in Unified CCX. A non-ACD user can be an
evaluator, manager, supervisor, knowledge worker, and/or archive user, but not an agent.
1. Click Create User.
The Create User dialog box appears.
2. Complete the fields, and then click OK.
The Windows login name must be unique, but users can have the same first and last
names.
The Roles section is enabled. You can assign a role to the new user at this time, or do it
later.
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A user ID (Windows Login) is assigned to the new user and the user appears under the
tab for each role that you assigned the user, or under the Unassigned Users tab if you
did not assign any roles to the user.

Assigning Roles to a Non-ACD User
You can assign the Knowledge Worker, Supervisor, Evaluator, Manager, and Archive User
roles to a non-ACD user from any tab on which that user is listed.
1. Select the non-ACD user from any tab on which the user is listed.
The user’s properties appear in the User Properties section of the window.
2. Select check box for the desired role in the Roles section.
n

If you assigned the Knowledge Worker role to the user, you can now assign the
knowledge worker to a non-ACD team using the enabled Assigned Team field.
Select the appropriate non-ACD team from the Assigned Team drop-down list.
The non-ACD team can consist only of knowledge workers.
Note: Quality Management does not record the knowledge worker until
you assign that user to a team.

n

If you assigned the Supervisor role, you can now assign the supervisor to a team
by clicking Add under the Supervisor’s ACD Teams or Supervisor’s QM Team
and selecting the appropriate teams. The selected team can be an ACD or nonACD team.
Note: You must first assign the non-ACD user to the knowledge worker
role before you can assign that non-ACD user to the Supervisor role.

n

If you assigned the Manager role, you can now assign a group to the manager by
clicking Add under the Manager’s Groups section and selecting the appropriate
group.

3. Optional. To assign an business or telephony administrator role to the user, click
Administrator Role and choose Telephony or Business.
Note: To assign the system administrator role, see Administrator Configuration.
4. Click Save.
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License/Unlicense Users
The License/Unlicense Users dialog box displays a list of users and available licenses. You can
use this dialog box to:
n

Assign a license to one or more users.

n

Unlicense one or more users.

Users must be licensed to log into Unified Workforce Optimization and to be recorded. A user’s
license status is displayed in the User Administration window.
The total number of licensed users is displayed on the User Administration interface to the right
of the Delete User button. The number displayed updates as soon as the users are licensed or
unlicensed.
Users’ license status can be changed only after they have been linked to an AD user (in AD
systems) or configured (in non-AD systems).
The number of licenses you have is configured when your system is installed. More information
about managing your licenses can be found in License.

Changing a User’s License Status
1. From the User Administration window, click License Users.
The License/Unlicense Users dialog box appears. It displays a list of all linked users
and the available licenses.
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2. Select the users whose license status you want to change.
l

Use Shift + Click to select contiguous rows in the list of users.

l

Use Ctrl + Click to select non-contiguous rows in the lists of users.

Use Ctrl + Click to select non-contiguous rows in the list of users.
3. Select the license type you want to assign to the selected users and click OK. The possible recording types are:
l

AQM

l

AQMA

l

QM

l

QMA

l

CR

l

CRA

l

Unlicensed—removes a license from a user.

The license is assigned to the users. The users can log into Unified Workforce
Optimization and the users can be recorded.
Note: Changes in license status go into effect the next time the user attempts to
log in.

Deleting a Unified CCX User
You cannot delete Unified CCX user from Quality Management Administrator. You can only
delete Unified CCX user from the Unified CCX system. However, you can change Unified
CCX user to unlicensed, which means that the user cannot log in to Unified Workforce
Optimization and the user will not be recorded.

Deleting a Non-ACD User
Use this task to delete a non-ACD user.
1. Select the non-ACD user you want to delete on one of the tabs in the User Administration window.
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2. Disable all roles assigned to the non-ACD user, remove any team associations and
group associations, and then click Save.
3. Click Delete User.
A dialog box asks you to confirm that you want to delete the selected non-ACD user.
4. Click Yes.
The non-ACD user is deleted.

Team Administration
The Team Administration window enables you to:
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n

View the agents, supervisors, and group belonging to a selected team.

n

Assign non-ACD supervisors to a team of ACD agents.

n

Create, rename, and remove non-ACD teams.

n

Assign knowledge workers, ACD supervisors, and non-ACD supervisors to teams.

Personnel
Assign agents and ACD supervisors to teams in Unified CCX. You cannot change team
assignments in Quality Management Administrator.
You cannot assign knowledge workers to the same team as agents. Knowledge workers must
belong to a non-ACD team made up only of knowledge workers.
You can assign non-ACD supervisors to an ACD team and ACD supervisors to a non-ACD
team.
You cannot create, rename, or remove an ACD team. Create and maintain ACD teams in
Unified CCX.

Managing Teams
n

To configure an ACD team, choose an ACD team from the Team drop-down list, add or
remove QM supervisors, and then click Save.
When a team is created in Unified CCX, you can only change the QM Supervisors
assigned to the team.

n

To add a non-ACD-team, click New, type the team’s name in the field, and then click OK.
Add knowledge workers, ACD supervisors, and QM supervisors to the new team by
clicking Add underneath each section, selecting the desired names from the list, and
then clicking OK. When the new team is complete, click Save.
The team’s name must conform to the following rules.

n

l

The team’s name must be unique.

l

A team’s name cannot be longer than 32 characters.

To assign people to a non-ACD team, choose the team from the Team drop-down list.
Add knowledge workers, ACD supervisors, and QM supervisors to the new team by
clicking Add underneath each section, selecting the desired names from the list, and
then clicking OK. When the update is complete, click Save.
Use Shift + Click to select adjacent people and Ctrl + Click to select non-adjacent
people.

n

To remove people from a team, select the people you want to remove from a section (for
example, Assigned Knowledge Workers, Assigned ACD Supervisors, or Assigned QM
Supervisors), click Remove underneath the section, and then click OK.

n

To rename a team, select the team you want to rename from the Team drop-down list,
click Rename, type the new name in the field, and then click OK.
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n

To delete a team, select the team you want to delete from the Team drop-down list, click
Delete, and then click Yes.
Remove the team from the quality management workflow before you delete the team.
Note: You cannot delete a team if the team is assigned to a quality management
workflow. You can delete a team if the team is assigned to an archive workflow.

Group Administration
Groups contain teams and managers assigned to the groups. From the Group Administration
window, you can:
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n

Create, rename, and delete a group.

n

Add and remove teams from a group.

n

Add and remove managers from a group.

Personnel

Managing Groups
n

To add a group, click New, type the group’s name in the field, and then click OK. Add
teams and managers to the group by clicking Add underneath each section, selecting
the desired names from the list, and then clicking OK. When the new group is complete,
click Save.
The group’s name must conform to the following rules.

n

l

The group’s name must be unique.

l

A group’s name cannot be longer than 32 characters.

To add teams to a group, select the group from the Group drop-down list, click Add
under the Assigned Teams section. Select the team or teams you want to assign to the
group from the list of available teams, and then click OK. When the group is complete,
click Save.
Use Shift + Click to select adjacent teams and Ctrl + Click to select non-adjacent teams.
Note: A team can belong to only one group. If you assign a team to a group and it
already belongs to another group, Quality Management will ask you to confirm
moving the team from one group to another group.

n

To remove teams from a group, select the group from the Group drop-down list, select
the teams you want to remove from the group, and then click Remove. When the group
is complete, click Save.

n

To add managers to a group, select the group from the Group drop-down list, click Add
under the Assigned Managers section. Select the manager or managers you want to
assign to the group from the list of available managers, and then click OK. When the
group is complete, click Save.

n

To remove managers from a group, select the group from the Group drop-down list,
select the managers you want to remove from the group, and then click Remove. When
the group is complete, click Save.

n

To rename a group, select the group you want to rename from the Group drop-down list,
click Rename, type the new name in the field, and then click OK.

n

To delete a group, select the group you want to delete from the Group drop-down list,
click Delete, and then click Yes.
Remove teams assigned to the group, from the quality management workflow before
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you delete the group.
Note: You cannot delete a group if any teams in that group are assigned to a
quality management workflow. You can delete a group if the teams in that group
are assigned to an archive workflow.

158

Recordings
The Recordings node allows you to configure when a customer conversation is recorded.
There are two types of recordings: those made for quality management purposes, and those
made for archiving purposes. Quality management recordings can include voice and screen
recordings. Archive recordings are voice only.
Quality management recordings and archive recordings use workflows to determine which
recordings of inbound and/or outbound calls (“calls of interest”) to save for evaluation or
archival purposes. You can assign teams to a workflow. Some examples of why you would
record calls of interest are:
n

Tracking the performance of specific agents

n

Helping train new agents

n

Monitoring calls during a sale period

n

Monitoring calls during specific times of day

n

Monitoring calls from specific customers or specific phone numbers

Quality Management saves recordings that are at least 5 seconds long. Quality Management
does not consider a recording of less than 5 seconds a valid recording. For quality
management purposes, you can change the minimum duration in the WHAT rule for the quality
management workflow classifier. You cannot change the minimum duration for an archive
workflow.
Quality Management does not support voice or screen recordings that are longer than 12
hours. If you think a call will last longer than 12 hours, you need to stop recording the call before
the call reaches the 12 hour mark, and then start a new recording.
Quality Management displays the time associated with a contact as the time the contact
occurred at the agent’s location, expressed in 24-hour HH:MM:SS format.
EXAMPLE: If the agent is located in Chicago, the time associated with any recorded
contacts made by that agent is Chicago local time.
The contact also displays the abbreviation for the local time zone. If the time zone associated
with the contact is unknown to Quality Management, then Quality Management displays the
time in Greenwich Mean Time (GMT).
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Use the Recordings node to:
n

Configure recording retention periods for a workflow

n

Create quality management workflows for a team

n

Create and maintain evaluation forms

n

Create archive workflows for a team

n

Configure and manage user-defined metadata

n

Allow specific roles to export recordings

n

Configure thresholds for talkover and silence events

n

Control the columns that appear in the <user name> - ID tab in the Media Player under
the Recordings application in Unified Workforce Optimization

Cisco MediaSense Recording Considerations
A workflow is configured to save recordings based on certain rules as they apply to individual
contacts (sessions). Using Cisco MediaSense Recording might result in more than one contact
for a single call.
EXAMPLE: If an agent places a call on hold, two contacts are created that will be
evaluated individually for a workflow. In this instance, a single call could produce a
“shortest call” contact (before the hold) and a “longest call” contact (after the hold).
Alternatively, a single call recorded by Cisco MediaSense Recording might result in one
of multiple contacts (sessions) being uploaded. It is also possible that some sessions in a
single call might not be uploaded based on the rules configured for the quality
management workflow.
For this reason, Cisco recommends you choose the 100% QM Logging option when you
configure quality management workflows to guarantee the entire call appears in the Recording
application for Unified Workforce Optimization.
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Recording Retention
The administrator determines the amount of time contacts are retained for quality management
workflows and archive workflows.

Recording Retention Periods and Workflow
The retention period for recorded calls is specified at the workflow level. The age of a call is
based on the day the call was recorded. This value is not updated by any actions performed on
the recorded call. The expiration date is the last day of the retention period.
Teams assigned to a workflow will share the same retention period.
EXAMPLE: Two teams associated with one workflow might handle calls that require
call recordings to be kept for 7 years. A team associated with another workflow might
handle calls that require call recordings to be kept for only a year.
The length of time that quality management recordings are retained and configured is under
the Quality Management > Workflows node and the length of time archive recordings are
retained and configured is under the Archive > Workflows node.

Recording Retention Rules
Quality Management observes the following rules when determining retention time.
n

Every quality management workflow has individual retention periods for HR, Scored,
Tagged, Training, and Unscored calls.

n

Every archive workflow has individual retention periods for Archive and Tagged calls.

n

Different calls might be retained for different retention periods, depending on the
workflow retention period assigned to the call.

n

If a call is marked as Tagged, the screen recording file will be deleted at the end of the
quality management Tagged retention time. The audio file will be deleted at the end of
the longer retention time for the quality management Tagged or archived Tagged
retention time. Quality Management deletes metadata associated with a call when the
longest of the quality management Tagged, archived Tagged, or metadata retention
times is reached. By default, call data is stored for 13 months.
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The following example shows how Quality Management handles Tagged retention
when both archive and quality workflows exist:
l

A contact is recorded for both quality management and archiving. It is also marked
as Tagged by the user.
o

Quality management Scored retention time is two months

o

Quality management Tagged retention time is 6 months

o

Archive retention time is one year
Metadata retention time is thirteen months

o
l

l

Archive Tagged retention time is ten years

After 6 months, the screen recording is deleted and is no longer available.
After ten years, the audio recording and metadata are deleted and no longer
available.

Time

Data

Applications in Unified Workforce
Optimization where you can access
the data

For 6 months

Screen recording

Recordings

For 10 years

Audio recording

Recordings

For 13 months

Metadata

Recordings

n

A quality management workflow retention period is assigned at the End of Day (EOD).

n

Once the retention period is assigned to a call, the call’s retention period can only be
changed by changing the retention times in the workflow in which the retention periods
were originally assigned.
Note: Remember that reducing a retention period after it has been initially set can
result in the deletion of recordings, and that increasing a retention period will
result in a larger use of storage space. Changing these values should be
considered carefully.

n
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Once the retention period is assigned to a call, the call’s retention period will not be
changed if a team is moved from one workflow to another workflow. Subsequent calls
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associated with the new workflow will use the retention period assigned to the new
workflow.
n

When you delete a workflow, any calls assigned to that workflow retains the last known
retention times for the deleted workflow.

Quality Management Workflow Retention
Quality management contacts are retained according to the limits shown in the following table.
Recording retention periods for quality management workflows
Recording Type

Retention Period

Scored

1 day—unlimited (default = 30 days)

Unscored

1 day—unlimited (default = 30 days)

HR

1 month—unlimited (default = 6 months)

Training

1 month—unlimited (default = 6 months)

Tagged

1 month—unlimited (default = 120 months)

Metadata

13 months1

Archive Workflow Retention
Archive workflow contacts are retained according to the limits shown in following table.
Contact retention periods for archive workflows
Recording Type

Retention Period

Archive2

1 month—Unlimited (default = 84 months)

Tagged

1 month—Unlimited (default = 120 months)

1You cannot change the recording retention period for metadata.
2Audio recordings only.
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Recording Type

Contact
Information

Retention Period

13 months minimum in both the Dashboard and Reporting
applications

About Workflows
A workflow allows you to specify rules and classifiers to designate the types of contacts you
want to record. There are two types of workflows:
n

quality management workflow—specifies the types of calls you want to save for quality
management recordings

n

archive workflow—specifies the types of calls you want to save for archive recordings

Changes to a workflow take effect immediately.
The following list describes when workflow processing occurs:
n

Beginning of Call (BOC)—this occurs when Voice Recording services get a message
that recording has started.
Note: This does not occur for screen recordings or Cisco MediaSense
Recordings. They only insert contacts after the recording is complete (EOC).

n

End of Call (EOC)—this occurs when the Recording Services are complete and the
recording has been converted, and the duration and derived metadata has been
discovered.

n

Non-Call Evaluation—this occurs when a user creates a non-call evaluation from the
Recordings application in Unified Workforce Optimization.

n

Metadata Reconciliation—this occurs when metadata is sent to the Server API to assign
metadata to a contact.

n

Quality Workflow Processing—This occurs after EOD for each configured quality
workflow.

Workflow Prerequisites
Before you create a workflow, you need to:
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n

Set up users and groups

n

Assign teams to a group (required for quality management workflow; not required for an
archive workflow)

n

Create an active evaluation form (quality management workflow only)

How Multiple Classifiers in a Workflow are Executed
You can set up multiple classifiers for a workflow. They are executed in the order they are listed
(from top to bottom) in the workflow navigation tree. This enables you to create classifiers that
are subsets of more general classifiers.
To change the order of classifiers in the navigation tree, select the classifier and use the Up and
Down arrow buttons to move it up or down in the navigation tree.

Classifiers and Rules Example for a Quality Management Workflow
Classifier 1:
n

Called number = 20??

n

Inbound

n

Rule 1: record new employee J. Smith

n

Rule 2: record random calls for Team A

Classifier 2:
n

Called number = * (all)

n

Outbound

n

Rule 1: record longest call of the day and shortest call of the day for Team B

In this example, a call must meet the called number condition and then the call direction
condition of Classifier 1 to go on to evaluate the rules. If the call does not meet the called
number condition, the workflow moves on to Classifier 2.
If the call meets the called number and call direction condition of Classifier 1, the workflow then
goes on to evaluate the rules in top-down order. If none of the rules are met, the call will not be
marked for quality management (although it might be uploaded for archiving if an archive
workflow is configured).
Once a contact matches a classifier (and does or does not match any of those classifier’s
rules), the workflow will not move on to another classifier.
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Classifier execution order in a quality management workflow

Qualifiers Example for an Archive Workflow
Classifier 1:
n

Called number = 20??

n

Inbound

Classifier 2:
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n

Called number = * (all)

n

Outbound

Recordings
In this example for an archive workflow, a call must meet the called number condition and then
the call direction condition of Classifier 1. If the call does not meet the called number condition,
the workflow moves on to Classifier 2.
Once a contact matches a classifier, the workflow will not move on to another classifier.
Classifier execution order in an archive workflow

Configure a Classifier to Allow Agents to Selectively Tag Calls
When you configure archive or quality management workflows, calls are automatically
recorded from the beginning. To allow agents to selectively tag calls for recording using the
Tag command, choose the Don’t Record option to disable uploading of recorded calls when
configuring a classifier for the workflow.

Configure a Do Not Record Classifier
You can exclude specific phone numbers or area codes from recording by choosing the Don’t
Record option.
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EXAMPLE: You can choose to exclude outbound calls to California.

Quality Management Workflows
This topic describes the Workflow Administration window and provides tasks to create and
maintain quality management workflows.
Note: Quality Management workflows are only available if you have quality
management licenses.

Points to Remember
When a non-contact call is created or an Archive contact is marked for quality in Unified
Workforce Optimization, the contact assumes the retention times for unscored and scored
contacts configured in the quality management workflow for that agent's team. If you plan to
use the Create Contact or Mark for Quality features, Cisco recommends placing all users
under a quality management workflow in order to set the retention periods for these contacts. If
no additional quality recordings are required the quality management workflow classifier can
be set to exclude recording on all numbers so the quality management workflow will not cause
any additional recording.

Workflow Administration
Use the Workflow Administration window to create quality management workflows based on
team. The quality management workflow includes specific rules and classifiers to designate the
types of contacts you want to record. These calls will be recorded for evaluation and review.

168

Recordings

Field
Workflows

Description
Lists the existing workflows. To modify the workflows that appear in this
list, choose one of the following options.
n

New—add a new workflow to the list

n

Rename—change the name of an existing workflow

n

Delete—remove a workflow from the list

Rename and Delete are enabled when you select an active archive
workflow from the list.
Name

The name of the quality management workflow.
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Field
State

End of Day

Description
The status of the workflow. The Possible states are as follows:
n

Active—The entire workflow can be modified.

n

Inactive—The modifiable parts of the workflow are limited to the
fields under Settings and Recording Retentions. An inactive
workflow is a default workflow that is not associated with any
agent. That is, the columns (Agent, Team, and so on) remain
blank in the search results.

The End of Day (EOD) is when the uploading process begins for the
workflow. Recording still continues, but those recordings are uploaded
after the next EOD. Enter the time for the end of the work day in 24hour format.
If the EOD is changed, the new EOD goes into effect immediately and
the Data API service will process calls using the new EOD time. If the
EOD changes after the Upload Controllers gets the original EOD, the
Upload controller might wait to upload recordings until after the original
EOD time has passed.

Immediate Voice
Upload

When this check box is selected, audio recordings associated with this
workflow are immediately uploaded after the recording completes.
When the check box is clear, the normal upload setting rules are in
effect. This option applies to all recording types.
If you change the Immediate Voice Upload option during the day, the
change does not go into effect until the quality management workflow is
reloaded after the End of Day.
For Desktop Recording, it is possible that audio recordings waiting for
upload can be lost if an agent’s PC crashes. Enabling immediate
uploading prevents this problem.
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Field
Immediate
Screen Upload

Description
When this check box is selected, screen recordings associated with this
workflow are immediately uploaded after the recording completes.
When the check box is clear, the normal upload setting rules are in
effect. This option applies to all recording types.
If you change the Immediate Screen Upload option during the day, the
change does not go into effect until the quality management workflow is
reloaded after the End of Day.
For Desktop Recording, it is possible that screen recordings waiting for
upload can be lost if an agent’s PC crashes. Enabling immediate
uploading prevents this problem.

Allow Evaluators
to Change Form

Choose this option if you want to allow evaluators to select the
evaluation form they want to use.

Extend Screen
Recording (in
seconds)

The number of seconds screen recording continues to record after-call
work after a call is dropped.

Recording
Retentions

Set the length of time you want the various types of recordings to be
retained.

Teams Assigned
to Groups

Teams assigned to groups appear in this list.

Assigned Teams

Teams assigned to this quality management workflow appear in this
list. A team can belong to only one quality management workflow at a
time.

If another call starts before the configured time period is over, the
recording for the current call stops automatically so that recording for
the new call can start.

Classifier Configuration
Use the Classifier Configuration: <workflow name> window to create, rename, or delete
classifiers for a quality management workflow.
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Field/Option

172

Description

Evaluation
Form

Select the form you want to use to evaluate the recorded
calls.

Record

Select this option to record calls, and then choose from the
following options:
n

100% Recording Logging

n

Inbound

n

Outbound

Recordings
Field/Option

Description

100% QM
Logging

Select this option if you want to configure a classifier that
does not use rules, but rather records all calls defined by
the classifier. If you clear this check box, you must
configure at least one rule for a Ringing Event. See Setting
up Rules for a Classifier's Ringing Event for more
information.

Inbound
and/or
Outbound

Select which calls to be recorded—inbound, outbound, or
both. You must select at least one call direction.

Don’t Record

Use this option if you want agents to selectively tag calls for
recording using the Tag command.
This option allows you to exclude specific phone numbers
or area codes from recording. For example, a workflow for
a team has 2 classifiers in the following order:
n

Do not record a call for this workflow if the Calling
Number begins with 612* because the area has
rules against recording calls.

n

Record all calls with a Calling Number of *.

The first classifier excludes all calls that originate from a
number that starts with 612* from recording. The second
classifier records all calls that are not excluded by the first
classifier.
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Field/Option
Numbers

Description
Select the type of number you want to use to filter the calls,
Called Number or Calling Number.
If the call is inbound, the Called Number is the route point
number if the call was routed, or the agent extension if the
call was direct dial. The Calling Number is the original
number from which the caller is dialing.
If the call is outbound, the Calling Number is the agent’s
extension, and the Called Number is the number of the
customer/client.
Note: If you add phone numbers to the Called
Number section, then select Calling Number from
the Numbers drop-down list, the phone numbers
you added will be deleted. The reverse is also true.
If you add phone numbers to the Calling Number
section, then select Called Number from the
Numbers drop-down list, the phone numbers you
added will be deleted.
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Field/Option
Called/Calling
Number

Description
Click Add to specify the phone numbers you want to filter
for in the Numbers field. You can enter:
n

Specific numbers
EXAMPLE: 6125551212

n

Number ranges using wildcards
EXAMPLE: 612*, where the * wildcard
stands for any number of digits, or
612555????, where the ? wildcard stands for
1 digit

n

The * wildcard to record all calls

The numbers you enter cannot contain dashes or
parentheses, and must be between 1 and 16 characters
long.

Creating a Quality Management Workflow
You must assign a team to a group before you can assign that team to a quality management
workflow. If you did not assign that team to a group, the team does not appear in the Teams
Assigned to Groups section.
Note: A team can belong to one archive workflow and one quality management
workflow.
Use this task to create a new quality management workflow.
1. In the navigation tree, select Recordings > Quality Management > Workflows.
The Workflow Administration window appears.
2. Next to the Workflows section, click New.
The Workflow Name dialog box appears.
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3. Enter a unique name for the new quality management workflow, and then click OK.
The quality management workflow now appears in the Workflows section.
4. Select the quality management workflow from the Workflows list.
5. Enter the time for the end of the work day in 24-hour format.
If the options are changed during the day, they do not go into effect until the quality
management workflow is reloaded just before the End of Day.
6. Select Immediate Voice Upload if you want to upload an audio recording immediately
after the recording is completed.
7. Select Immediate Screen Upload if you want to upload an audio recording immediately
after the recording is completed.
8. Select the Allow Evaluators to Change Form check box if you want to allow evaluators
to choose the evaluation form they want to use.
9. Specify the time, in seconds, the screen recording should continue after the call ends.
10. Set the length of time you want the various types of recordings to be retained.
If you want recordings to be retained indefinitely, select the Unlimited check box
associated with the recording type. The minimum amount of time a recording can be
retained is one day for Scored and Unscored recordings and 1 month for Tagged, HR,
and Training recordings.
11. Assign teams to the quality management workflow.
A team can belong to only one quality management workflow at a time. If a team that
you want to assign to this quality management workflow already belongs to another
quality management workflow, it will automatically be reassigned to this quality management workflow. Quality Management Administrator displays a warning message
telling you that it reassigned the team from another quality management workflow.
12. When you finish configuring the quality management workflow in this window, click
Save.

Setting up Classifiers for a Quality Management Workflow
Use this task to set up classifiers for a quality management workflow.
1. Under the Quality Management > Workflows node, select the workflow you just created.
The Classifier Configuration: <workflow name> window appears.
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2. In the Classifiers section, click New to create a new classifier.
The Classifier Name dialog box appears.
3. Enter a name for your new classifier, and then click OK.
The new classifier is now listed in the workflow navigation tree.
4. Select the new classifier in the workflow navigation tree.
5. In the Classifier Settings section, select one of the following options.
l

Record—Select this option to upload recorded calls and then choose from the
following options: 100% QM Logging, Inbound, or Outbound. Then choose the
type of number (Called Number or Calling Number) you want to include from the
Numbers drop-down list and then click Add and enter the included numbers.
Note: You must select at least one call direction (Inbound or Outbound).

l

Don’t Record—Select this option to exclude specific phone numbers or area
codes from recording. Choose the type of number (Called Number or Calling
Number) you want to exclude from the Numbers drop-down list and then click
Add and enter the excluded numbers.

6. Click Save to save the classifier settings.
If you did not select 100% QM Logging, you must now configure at least one rule for a Ringing
Event. See Setting up Rules for a Classifier's Ringing Event for more information.
Note: The following message appears if a rule is not configured or you do not choose
100% QM Logging:
Classifier <name> must have at least one rule or 100% QM logging enabled.

Configuring Actions for the Ringing, Answered, and Dropped Events
Each event in the workflow navigation tree is associated with one or more optional actions as
follows.
n

Ringing event: Screen Recording Upload

n

Answered event: Start Voice Recording

n

Dropped event: Stop Voice Recording
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Quality Management Administrator enables action settings by default.
Use this task to configure actions for ringing, answered, and dropped events.
1. Under Ringing Event, choose Actions and select the Screen Recording Upload check
box if you want to upload screen recordings after the call ends.
Screen Recording Upload is not available at the CR or QM license level.
2. Under Answered event, choose Actions, and select the Start Voice Recording check
box if you want to start voice recording when the call is answered.
3. Under Dropped Event, choose Actions and select the Stop Voice Recording check box
if you want to stop audio recording when a call is dropped:
4. Click Save to save the action settings.

Modifying a Quality Management Workflow
Use this task to modify a quality management workflow.
1. Select Recordings > Quality Management > Workflows in the navigation tree.
The Workflow Administration window appears.
2. Choose one or both of the following options.
l

l

Select the workflow from the Workflows section to modify the assigned teams or
the workflow settings.
Select the workflow under the Workflow node in the navigation tree to modify the
workflow’s classifiers, rules, and actions.

3. When you finish your changes, click Save.
Quality Management Administrator saves the changes to the modified workflow.
Note: The modified workflow goes into effect after the agents assigned to the
workflow log out and log back in to their Windows session, or after the
configured End of Day. The quality management workflow information is
updated before upload occurs so that any changes during the day will take
effect.

Setting up Rules for a Classifier’s Ringing Event
You must set up at least one rule for a Ringing Event if you have configured the classifier
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without 100% QM Logging.
Rules do not apply to classifiers that are configured with 100% Recording Logging.
Use this task to set up rules for a classifier’s ringing event.
1. In the workflow navigation tree, under the classifier, select Ringing Event.
The Rule Configuration window appears.
2. Click New to add a new rule.
The Rule Name dialog box appears.
3. Enter a name for the new rule, and then click OK.
Quality Management Administrator adds the new rule to the workflow navigation tree
underneath the Ringing event and the What, Who, and When tabs appear (see the
following figure).
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Note: As with classifiers, multiple rules may be set up and ordered from least to
most specific.
4. On the What tab, select the calls you want to record.
5. Click the Who tab.
The Who tab on the Rule Configuration window appears.
6. Select Agent or Team from the Select Who drop-down list.
7. In the Available Agents/Available Teams section, select the agent or team you want the
workflow to apply to, and use the arrow buttons to move those agents or teams to the
Assigned section.
8. Click the When tab.
The When Tab on the Rule Configuration window appears.
9. Select when the workflow runs from the Select When drop-down list. Your choices are:
l

Set of Dates—select specific dates

l

Weekly—select the days of the week

l

Date Range—select a start and stop date

10. When you are finished configuring the workflow rules, click Save.

Deleting a Quality Management Workflow
Before you delete a quality management workflow, please consider the following information:
n

Once a workflow is deleted, you cannot adjust the retention times for calls associated
with the workflow or reactivate the workflow.

n

Quality management workflow settings are updated before upload. If you delete a quality
management workflow, the calls associated with the quality management workflow are
not uploaded.
1. Select the workflows node under Recordings > Quality Management > Workflows in
the navigation tree.
The Workflow Administration window appears.
2. Select the workflow from the Workflows pane and click Delete.
The Confirm Deletion dialog box appears.
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3. Click Yes to confirm the deletion.
Quality Management Administrator deletes the quality management workflow and the
status of the workflow changes to Inactive. The deleted workflow goes into effect after
the agents assigned to the workflow log out and log back in to their Windows session,
or after the configured End of Day.

Evaluation Forms
This topic described evaluation forms.
Note: Evaluation forms are only available if you have quality management licenses.
The Evaluation Forms node allows you to:
n

Create and maintain evaluation forms

n

Configure who can evaluate contacts that use a specific form

n

Configure who can approve evaluations that use a specific form

New forms are created based on one of the read-only templates that come with Quality
Management Administrator.
When you create a new evaluation form, you specify one of the following evaluation types:
PERCENTAGE-BASED SCORING (PERCENTAGE)
The evaluation is scored based on a percentage. Sections and Questions are weighted
(0-100%) and the final score is a percentage.
Example: If an agent scores 4 out of 5 questions correctly and the questions are evenly
weighted, the agent's final score is 80%.

POINT-BASED SCORING (POINTS)
The evaluation is scored based on a point system. Point-based scoring is often used in
incentive-based performance. Agents accumulate points and when they have enough
points they can cash the points in for tangible rewards (much like credit card points). In
this environment, 0 is the normal score and points are awarded for going above and
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beyond the normal expected outcome. Points can also be subtracted for poor service.
The evaluation form allows you to assign positive or negative scores to questions.
Example: If an agent positively demonstrates understanding during a call, the value is
10 points. If the agent fails to demonstrate understanding during a call, the value is -5
points.

Best Practices for Agent Evaluations
This section describes best practices for agent evaluations using Quality Management.

Goal of Quality Management
The goal of quality management is to establish consistency throughout the contact center. So
no matter what agent a customer calls on any given day, they get a consistently excellent user
experience. This allows you to:
n

Reduce labor costs through efficiencies

n

Identify customer needs and expectations

n

Improve customer satisfaction

Quality Management Training Process
The quality management training process is a continuous improvement cycle.

The quality management training process requires you to:
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n

Collect call recordings—Quality Management selects and processes phone calls
identified in the workflow.

n

Evaluate the call recordings—Supervisors or evaluators review and score the selected
recordings against Key Performance Indicators (KPIs).

n

Create reports based on evaluations that:

n

l

Compare the performance of agents, teams, and the entire organization

l

Identify initiatives for quality improvements and training

Refine agents’ performance by:
l

Using quality calls for training

l

Reevaluate agents to gauge training effectiveness and measure skills

l

Repeat or select the next quality management initiative

Determining Type of Calls to Record or Evaluate
Quality Management provides a two-level filter: you decide what calls you want to record, and
from those recorded calls, you then decide what calls you want to evaluate.
Quality Management has a unique workflow-based recording decision process that allows you
to create sophisticated criteria or triggers so that you can sort through all calls in the contact
center and identify those calls determined most likely to provide value when evaluated.
Quality Management:
n

Eliminates time sifting through irrelevant calls—using workflows allows you to eliminates
the time required to choose which calls to evaluate from a long list of unsorted calls. An
evaluator might spend an inordinate amount of time choosing calls to evaluate at
random. The workflow process allows you to identify relevant calls for evaluation.

n

Manages storage use—using workflows also allows you to manage your storage use.
The Advanced license includes the screen recording feature, which takes up significant
recording space at a rate of one megabyte per minute of recorded material. So you need
to be judicious when choosing which calls you want to record to manage storage space
on your Voice Record server.

The following list provides examples of criteria you can build into your workflow criteria.
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n

First call of the day—you can base your criteria on time management.
EXAMPLE: You can choose to record the first call of the day, or the first two calls
of the day. Or you can choose to record the first call after lunch.

n

Longest or shortest call—you can choose to record the two or three longest calls or
shortest calls of the day for each agent. This allows you to understand some of the
components of long calls, or simply understand why the call handle times exceed the
norm. You can also set up a workflow to record three or four of the shortest calls of the
day to determine why you get 15 or 20 second calls.

n

Peak hour—you can choose to record several calls during peak hours.
EXAMPLE: You could choose to record 3 calls at random during your peak hour
period between 1–2pm, so you can get a good assessment of how agents are
handling callers. Are they providing the same quality while there are callers in
queue?

n

Specific (new) agents—if you are concerned about an agent’s performance, or you have
a new agent, you can record 100% of the agent’s calls for a specified period (for
example, two weeks). This allows you to understand their activities and get them up to
speed with the rest of your agents.
Specific customer or account ID—you can choose to add custom metadata fields at the
time of the recording. The information can include a customer ID, account ID, or
transaction code. The metadata field allows you to provide data like:
l

Did this call result in a sale? Yes/No.

What was the dollar value of the sale?
The date can come from the IVR data or the Enterprise data managed through CAD.
l

n

Identifying KPIs
You need to identify the business goals for the contact center for the current year and
incorporate those goals into the Key Performance Indicators (KPIs).
Example: Your contact center’s business goals could be to increase revenue, improve
customer satisfaction, or reduce overall cost.
A KPI can have a positive or negative impact on your contact center's business goals.
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Example: If an agent turned an unhappy customer into a happy customer, the agent
had a positive impact on the your contact center's business goals. If another agent lost a
potential sale, that would have a negative impact on your contact center's business
goals.
When you know what your business goals are you can incorporate those goals as answers to
questions in the evaluation form and assign KPIs to those questions. This allows you to align
your agents’ goals with the business goals for the contact center. You can then use the
evaluation forms to measure your agent’s performance against your contact center’s business
goals.
When you break down the business goals, you need to identify the areas of challenges and the
metrics you have for success in meeting those business goals. For example, you can break the
business goals into:
n

First Contact Resolution (FCR)

n

Sales process and skills

n

Product knowledge—you can use call evaluation to identify agents who do not have
sufficient product knowledge, and then provide training to improve their product
knowledge. For example, you might want to consider the following questions when
evaluating an agent:
l

Does the agent have deep product knowledge?

l

Is this a critical indicator or a challenge area?

n

Agent proficiency with tools—agents sometimes have to deal with a wide variety of tools
when they deal with a customer. For example, order entry tools, agent productivity tools,
database tools, or custom software tools designed for the organization. You can use the
evaluation to monitor agent proficiency with your contact center’s tools, and then provide
training to improve their tool proficiency.

n

Average call duration—some calls are longer than others. You can use the evaluation to
understand what impact factors result in longer calls, and then provide solutions that
result in fewer long calls, and improve the average call duration.

Guidelines for Evaluation Forms
Consider the following when you create an evaluation form:

185

Recordings
n

Identify the activity type you want to evaluate, and create an evaluation form for that
specific contact.
Example: Call recording, live monitor of voice or screen, counter work, chat, or
other social media
This allows Quality Management to accurately report non-call activities in the Dashboard
and Reporting applications.

n

Clearly outline factors to rate performance.
Example: How does the agent perform when greeting a customer, handling an
application, empathizing with a caller, using tools during order entry, or closing a
call? You can rate an agent's performance for each action.

n

Align the evaluations with the contact center’s business goals and available training.
l

l

Do not create an evaluation form that covers every possible scenario.
Focus on a few critical areas, like how an agent resolves a customer issue or
implements new initiatives.
EXAMPLE: If your call center’s focus is on capitalizing up-sell
opportunities, then make that the focus of your evaluation.

An evaluation that is aligned with the contact center’s business goals provides
quantitative measurements of agents while related training and incentive programs are
rolled out.
n

Do not go overboard when creating an evaluation.
l

Try to limit your evaluation to three or four measurements.

l

Identify the top three or four KPIs you want to evaluate for this quarter or year.

l

Limit the total number of questions to 20 to 30 in the evaluation form so you can
quickly complete the form.
You can always add additional sections in the form, or better yet, replace existing
questions when you resolve issues like greeting customers or handling an
application.
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l

l

l

l

l

n

Identify the key categories. Allow no more than 10 categories.
Identify questions associated with each category. Allow no more than 10
questions per section. Yes/No questions are preferred.
Organize your form for ease of evaluation. Match the questions to the call flow to
enable evaluations on the fly.
When using percentage-based scoring, apply weighting and scoring where
relevant.
Identify key points of “failure.” If the question fails, the entire evaluation fails.

Ensure the areas you are measuring have corresponding training materials or actions.
Establish a training or mentoring program to improve agent performance and address
inadequacies.

The goal is to improve the proficiency for the entire contact center and help agents struggling in
specific areas to gain a level of proficiency.

Guidelines for Evaluation Form Questions
Consider the following tips when writing evaluation form questions.
n

Avoid long or complex questions, and do not include questions within a question.
l

Limit the scope of a question to a single measurable event.
EXAMPLE: Did the agent greet the customer with their first and last
name?

l

l

n

Make the question clear to both the evaluator and the agent on how the agent
performed.
Simple questions allow managers and supervisors to investigate the root cause of
an agent’s low score.

Use questions that require a yes or no answer whenever possible.
l

l

Yes or no questions provide clear and concise answers.
Yes or no questions require less documentation and collaboration efforts to get
consistent evaluation measurements. These types of answers are less subjective.

Numerical ranges require documentation criteria for each number in the range. This
makes collaboration efforts between multiple evaluators difficult.
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n

Organize your questions by placing them into distinct categories or sections.
l

l

Categorizing questions allows you to produce detailed reports about agent and
team performance in each category.
Match questions and sections to the flow of a typical call to make it easier for
evaluators to score agent performance.
EXAMPLE: You could create three sections named Greeting, Order Entry,
and Closing.

l

n

When using percentage-based scoring, indicate the relative importance of
questions and sections by assigning them different weights.

l

Use no more than 10 sections in an evaluation form.

l

Use no more than 10 questions in a section.

Decide whether there are any key points of “failure.”
l

Mark questions that address critical behavior (such as courtesy) as KPIs. If such a
question is scored negatively, the entire evaluation fails.

Maximizing Quality Management Value through Effective Evaluations
The evaluation is the net result you get out of a quality management recording solution. It starts
with the recording but it is really the evaluation where you can separate the excellent agent
behavior and identify the areas where agents need improvement.
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n

Prioritize your initiatives—start with the highest value/highest priority.

n

Establish a level of success—this is the desired behavior.

n

Create a log of measurements and compare scores over time—pick an evaluation form
and stay with it for at least a quarter so you can measure improvement over time and
verify if your training and coaching is improving performance over this time period.

n

Review agent evaluations and play back calls to determine root cause—find out where
you are having problems and improve training through root cause analysis.

n

Make agent, team, and organizational comparisons—measure progress at all levels.

n

Move on when you have established success—when you no longer have problems in
one section of the evaluation, for example agent greetings, you can remove it from the
evaluation. As your contact center’s business goals change you can add new sections to
the form to continually improve the performance of your agents.
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Evaluation Form Templates
The Evaluation Form Templates window lists the templates that you can use to create an
evaluation form in the Evaluation Form Administration window.

The following table describes the default templates.
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Evaluation form templates

Template Name
Blank Template

Description
Configured for mixed question types that are scored on a scale of 0
to 5 or answered with Yes or No. The template has no pre-existing
sections or questions.
Use this template for percentage-based scoring.

Template 0–5

Configured for questions that are scored on a scale of 0 to 5. The
template comes with pre-existing sections and questions.
Use this template for percentage-based scoring.

Template Mixed
Questions

Configured for mixed question types that are scored on a scale of 0
to 5 or answered with Yes or No. The template comes with preexisting sections and questions.
Use this template for percentage-based scoring.

Template Points
Form

Allows you to choose the question types as either scored on a scale
of 0 to 5, answered with Yes or No, or customized.
Use this template for point-based scoring.

Template Yes-No

Configured for questions that are answered with Yes or No. The
template comes with pre-existing sections and questions.
Use this template for percentage-based scoring.

Evaluation Form Administration
The Evaluation Form Administration window lists available evaluation forms. From this window
you can create, rename, delete, and copy evaluation forms. An evaluation can be based on an
existing template or a blank form.
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Creating an Evaluation Form
Use this task to create a new evaluation form.
1. In the navigation tree, select Recordings > Quality Management > Evaluation Forms >
Forms.
The Evaluation Form Administration window appears.
2. Click New.
The Evaluation Form Configuration dialog box appears.
3. Select the type of score calculation that you want to use. Your options are:
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n

Percentage—Select this option if you want to use percentage-based scoring.

n

Points—Select this option if you want to use point-based scoring.

4. Choose an evaluation form template from the drop-down list. Your options are:
n

Percentage: Template 0-5, Template Yes-No, Blank Template, or Template
Mixed Questions

n

Points: Template Points Form

5. Type a unique name for the evaluation form and then click OK.
Quality Management adds the new evaluation form to the list of forms at the top of the
Evaluation Form Administration window.
You can now configure the newly-created evaluation form by completing the information on
each tab on the lower part of the window.

Details Tab
The Details tab displays a form’s properties. It appears at the bottom of the Evaluation Form
Templates window and the Evaluation Form Administration window.
Details tab fields

Field
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Description

Description

A descriptive name of the form or template. The default description is
the name of the template used to create the form.

Original Author

The name of the person who originally created the form or template.
The default is Administrator.

Last Author

The name of the person who last modified the form or template. The
default is Administrator.

Recordings
Field
Needs
Improvement
Percentage

Description
The evaluation score range that indicates the agent’s performance
needs improvement. The lowest value is 0. If you change the highest
value, all other score ranges change accordingly.
Example: A value from 0 to 74% is a below average score that
indicates the agent needs additional coaching.
This field only appears if the evaluation form uses percentage-based
scoring.

Meets Expected
Percentage

The evaluation score range that indicates the agent’s performance
meets expectations. If you change the highest and lowest value, all
other score ranges change accordingly.
Example: A value from 75 to 89% can be considered an
adequate or average score.
This field only appears if the evaluation form uses percentage-based
scoring.

Exceeds
Expected
Percentage

The evaluation score range that indicates the agent’s performance
exceeds expectations.
Example: A value from 90 to 100% is an above average score
that indicates an agent performed beyond the normal expected
outcome.
This field is not editable. The value in this field it depends on the values
set in the lower two score range fields. The maximum value is 100.
This field only appears if the evaluation form uses percentage-based
scoring.
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Field
Needs
Improvement
Points

Description
The evaluation points range that indicates the agent’s performance
needs improvement.
Example: Negative values are subtracted for poor service. In
this instance, a value from -1 to -50 is a below average score
that indicates the agent needs additional coaching.
The minimum integer value can be less than 0. Note that the minimum
value for this range is determined by the total of all minimum values
that you assign to questions. If you change the highest value, the
lowest value for Meets Expected Points changes accordingly.
Note: You cannot change the value in this field until you create
questions and assign maximum and minimum values to those
questions.
This field only appears if the evaluation form uses point-based scoring.

Meets Expected
Points

The evaluation points range that indicates the agent’s performance
meets expectations.
Example: A value from 0 to 2 can be considered an adequate
or average score.
If you change the value, all other score ranges change accordingly.
Note: You cannot change the value in this field until you create
questions and assign maximum and minimum values to those
questions.
This field only appears if the evaluation form uses point-based scoring.
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Field
Exceeds
Expected Points

Description
The evaluation score range that indicates the agent’s performance
exceeds expectations.
Example: Positive values are awarded for exceptional service.
In this instance, a value from 3 to 50 is an above average score
that indicates an agent performed beyond the normal expected
outcome.
This field is not editable. Note that the maximum value for this range is
determined by the total of all maximum values that you assign to
questions.
Note: The maximum value in this field does not change until
you create questions and assign maximum and minimum values
to those questions.
This field only appears if the evaluation form uses point-based scoring.

Status

The default status is Editable. Do not change the status of an
evaluation form to Active until you finished modifying the evaluation
form. You can only change the status for an evaluation form listed in
the Evaluation Form Administration window. You cannot change the
status for an evaluation form template in the Evaluation Form
Templates window. See Form Status for more information about
statuses.

Configuring an Evaluation Form’s Details
1. Select the form in the list of forms at the top of the Evaluation Form Administration window.
2. Select the Details tab, and complete the fields.
The form’s properties appear in the tabbed section at the bottom of the window.
3. When done, click Save.
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Form Status
A form’s status determines if it is available for use and if it can be modified. The following table
describes the possible states.
Status

Description

Editable

The form can be modified, renamed, and deleted. It is not yet available for
evaluators to use.

Active

The form is available for use by evaluators, supervisors, or managers.
Everything that does not effect the score in the evaluation can be modified,
including:
n

Details tab (including ranges)

n

Settings tab

n

Sections tab (including names and chart results, but not weights or
number of sections)

n

Question tab (including text, description, and answer label, but not
number of questions, KPI, or weights)

An active form cannot be deleted.
Inactive

The form is no longer available for use by evaluators, supervisors, or managers.
It will be deleted automatically as soon as all evaluations based on it are
removed from the database.

The following figure displays normal life cycle of an evaluation form.
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Once you have changed a status to the next in line, you cannot go back to the previous status.
Also, you cannot skip a status.
EXAMPLE: You cannot go from Editable to Inactive.

Changing a Form’s Status
1. In the navigation tree, select Recordings > Evaluation Forms > Forms.
The Evaluation Form Administration page appears.
2. Select the form whose status you want to change from the list of forms at the top of the
page.
3. On the Details tab, in the Status section, select the desired status (in accordance with
the normal form lifecycle), and then click Save.

Settings Tab
The Settings tab displays the configuration settings for evaluation, approval, and alerts. It
appears at the bottom of the Evaluation Form Templates window and the Evaluation Form
Administration window.
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Settings tab fields

Field

Description

Comments are
Editable

When selected, allows users to edit any existing comment created by a
person within the user’s scope.
Example: An agent can only edit their own comments. A
supervisor can edit the comments made by agents within the
supervisor's scope and the supervisor’s own comments.

All Managers
Evaluate

When selected, allows all managers to be able to evaluate contacts that
use this evaluation form and that are made by agents in their group.

All Supervisors
Evaluate

When selected, allows all supervisors to be able to evaluate contacts
that use this evaluation form and that are made by agents in their team.

Evaluation
Approval
Needed

Select one or more of the following roles if you want to require
evaluation approval for contacts that use this evaluation form.
n

Evaluator

n

Manager

n

Supervisor

Managers and supervisors can approve evaluations for agents in their
teams or groups. Evaluators can approve evaluations for agents from
all groups. Note that the user who triggers the alert does not receive the
alert.
When you select one or more of these roles, Quality Management
Administrator enables the Alert when Evaluation Needs Approval check
box.
When you clear one or more of these check boxes, any evaluations in
the Needs Approval state automatically changes to the Scored state for
the selected roles.
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Field
Alert when
Evaluation is
Scored

Description
When selected, an alert is sent when an evaluation is scored and
Quality Management Administrator automatically selects the following
options.
n

Agent’s Manager(s)—Quality Management sends an alert to the
agent’s manager(s) when an evaluation is scored.

n

Agent’s Supervisor(s)—Quality Management sends an alert to
the agent’s supervisor(s) when an evaluation is scored.

n

Agent/Knowledge Worker—Quality Management sends an alert
to the agent or knowledge worker when their evaluation form is
scored.

Example: If you only want Quality Management to send an alert
to Agent’s Supervisor(s), clear the Agent's Manager(s) and
Agent/Knowledge Worker check boxes.

Alert when
Evaluation
Needs Approval

When selected, an alert is sent when an evaluation needs approval.
When you select this check box, Quality Management Administrator
automatically selects the following options.
n

Evaluator(s)—Quality Management sends an alert to evaluator
(s) when an evaluation needs approval.

n

Agent’s Manager(s)—Quality Management sends an alert to an
agent’s manager(s) when an evaluation needs approval.

n

Agent’s Supervisor(s)—Quality Management sends an alert to
an agent’s supervisor(s) when an evaluation needs approval.

Example: If you only want Quality Management to send an alert
to the Agent's Supervisor(s), clear the Evaluator(s) and Agent's
Manager(s) check boxes.

199

Recordings

Configuring an Evaluation Form’s Settings
1. Select the form in the list of forms at the top of the Evaluation Form Administration window.
2. Select the Settings tab, and complete the fields as desired.
The form’s settings appear in the tabbed section at the bottom of the window.
3. When done, click Save.

Sections Tab
The section tab allows you to specify the number of sections that appear in the evaluation form.
There can be a maximum of 10 sections in a form. Sections are automatically numbered from 1
to 10.
You can use these default sections as they are in the evaluation form, or customize them to suit
your needs by renaming them or deleting them.
You can also specify which sections appear in the chart results for point-based scoring.
If you are using percentage-based scoring, remember the following points when assigning
weight to a section:
n

You can assign a weight to each section that can affect how an evaluation is scored. The
score weight percentages assigned to the sections must add up to 100 percent.

n

You can assign zero (0) to a section weight if there is more than one section in the Evaluation form. All questions within the 0-weight section must add up to 100 percent. The
questions scored in a 0-weight section are not included in the overall score. You might
want to create a 0-weight section when you want to track questions that should not affect
the overall score.

Sections tab fields and buttons

Field
Weigh
Sections
Evenly
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Description
When you click this button, the values in the Score Weight Percentage
columns are assigned the same weight.
This button only appears if the evaluation form is associated with
percentage-based scoring. The button is disabled when the form is
Active.
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Field

Description

Number

The number assigned to the section.

Name

The name of the section.

Chart Results

Choose the starting gradient color that will be associated with this section
in a chart for a point-based evaluation form. The ending gradient color is
predefined based on the starting gradient color. If you choose None, the
section will not appear in the chart.
Note: This field can be changed on an active evaluation form.

Score Weight
Percentage

Adjust the weight of each section. The weights of all the sections must
add up to 100%. The weight for each section will show a percentage
value that includes up to 2 decimal places.
This field only applies to percentage-based scoring.

Understanding How Sections are Weighted
Note: This topic only applies to percentage-based scoring.

Example: Assume the completed form has two sections called Greet and Assess. The
Quality Management administrator who set up the evaluation form determined that the
score of the Greet section would contribute 40% towards the overall score and the score
of the Assess section would contribute 60%. A section weight is indicated on each
section tab. The sum of all of the section weights must be 100.
These weights are applied after all sections are scored to arrive at the overall score (as a
percentage) for the evaluation.
The overall score is calculated as follows:
n

Section score (as a percentage) × section weight = weighted section score

n

Sum of all weighted section scores = total score (as a percentage)

In this example:
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n

Greet section = 60% x 0.4 = 24%

n

Assess section = 80% x 0.6 =48%

n

24% + 48% =72% overall score

Managing Sections
1. Choose one of the following options:
n

To add a new section, click New under the Sections tab, type a name for the new
section, and then click OK.
The Question tab appears the first time you add a new section.

n

To rename a section, select the section, click Rename, type the new name in the
Section Name dialog box, and then click OK.

n

To delete a section, select the section and click Delete, click Yes to dismiss the
Delete Section dialog box.

2. If this form uses percentage-based scoring, change the score weights for each section
until they add up to 100% or click the Weigh Sections Evenly button.
3. Click Save.

Questions Tab
The Questions tab allows you to the questions and answers associated with a section. When
configuring questions and answers, note that you can:
n

Enter up to 100 questions per form with a limit of ten sections per form.

n

Use a combination of answer of Yes/No or 0-5 scale, or custom answers on a questionby-question basis. A minimum of two answers per question is required.
EXAMPLE: Your evaluation can include not only Yes/No questions about an
agent’s mandatory skills but also 0-5 scale questions about the agent’s soft skills.

If you use the Template 0–5, Template Mixed Questions, or the Template Yes-No to create
your new form, you already have questions set up. You can use these default questions as they
are in the evaluation form, or customize them to suit your needs by adding, editing, or deleting
questions.
If you used the Blank Template or Template Points Form, you must create your own questions.
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The Questions tab appears at the bottom of the Evaluation Form Templates window and the
Evaluation Form Administration window when you add a section.

The Questions tab displays up to ten subordinate tabs. The names of these tabs are defined in
the Sections tab. See Sections Tab for more information.
Questions tab fields and buttons

Field

Description

Weigh
Questions
Evenly

When you click this button, the values in the Score Weight columns are
assigned the same weight.

Number

The number assigned to the question.

Question

A question in the evaluation form. You can enter a combined maximum of
500 characters in the Question and Description fields.

Description

A comment associated with the question in the evaluation form. The text
in this field should explain the scoring criteria so that evaluations are
scored consistently. When a user moves the cursor over the question in
the evaluation form in Unified Workforce Optimization, a popup dialog
displays the text in this field to the user.

Type

Click the Options button to define the answers to the questions. See
Configure Question Options for more information.

This button only appears if the evaluation form is associated with
percentage-based scoring. The button is disabled when the form is
Active.
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Field
KPI

Min

Description
Indicates whether or not the question has been marked as a Key
Performance Indicators (KPI) question. The valid values in the KPI field
are:
n

Yes

n

No

The minimum score for this question determined when the question
options were configured. Positive or negative numbers can appear in this
field.
This field only appears if the evaluation form is associated with pointbased scoring.

Max

The maximum score for this question determined when the question
options were configured. Positive or negative values can appear in this
field.
This field only appears if the evaluation form is associated with pointbased scoring.

Score Weight

Adjust the weight of each question. The weights of all the questions in a
section must add up to 100%. The weight for each question will show a
percentage value that includes up to 2 decimal places.
EXAMPLE: 12.55%
See Understanding How Questions are Weighted for more information.
This field only appears if the evaluation form is associated with
percentage-based scoring.

Understanding How Questions are Weighted
NOTE: This information applies only to percentage-based scoring.
The maximum score for a section is 100%, no matter how many questions it contains.

204

Recordings

Example: In a section with 3 questions, question 1 has a weight of 50%. Questions 2
and 3 each have a weight of 25%. This means question 1 is worth a maximum of 50
points and questions 2 and 3 are each worth a maximum of 25 points.
If a 0-5 question has a weight of 50%, then points are given for each possible score as follows:
n

20 = 10 points

n

40 = 20 points

n

60 = 30 points

n

80 = 40 points

n

100 = 50 points

If a 0-5 question has a weight of 25%, then points are given for each possible score as follows:
n

20 = 5 points

n

40 = 10 points

n

60 = 15 points

n

80 = 20 points

n

100 = 25 points

If a Yes/No question has a weight of 50%, then points are given for each possible score as
follows:
n

No = 0 points

n

Yes = 50 points

If a Yes/No question has a weight of 25%, then points are given for each possible score as
follows:
n

No = 0 points

n

Yes = 25 points

The following tables show the results for several sections in a sample evaluation form.
Scored example for a 3 question section

Question Weight

Type

Score Weighted Score

1

50

0-5

80

40

2

25

0-5

60

15
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Question Weight
3

25

Type
Yes/No

Score Weighted Score
Yes

25

Section Score

80%

Scored example for a 4 question section

Weight

Type

Score Weighted Score

1

60

0-5

60

36

2

15

0-5

80

12

3

20

Yes/No

No

0

4

5

Yes/No

Yes

5

Section Score

53%

Scored example with N/A as an answer to one of the
questions

Question Weight

Type

Score Weighted Score

1

60

0-5

N/A

-

2

15

0-5

80

12

3

20

Yes/No

No

0

4

5

Yes/No

Yes

5

Section Score

42.5%

Note: An answer of N/A removes that question from the total possible. So for this
example, Quality Management bases the score of 43% on a score of 17 out of a total of
40.
The formula used for weighting questions considers the underlying scoring system used today.
The following example shows this scoring system.
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Yes/No Question No

Yes N/A

Score

0

100

-

Possible

100

100

-

0-5 Question

0

1

2

3

4

5

N/A

Answer

0

20

40

60

80

100

N/A

Possible

100

100

100

100

100

100

-

In the current scoring system, the maximum score per question for a Yes/No question is 100
points. For a 0-5 question the maximum score per question is 100. N/A is ignored.
So the formula used to calculate the weighted score for a single question is:
(Actual score/ Maximum score) * Weight = Weighted score
Here are some example calculations for weighted question scores:
Question
type

Maximum
score

Actual
score

Weight

Formula

Weighted
score

0-5

100

60

40%

(60/100) * 0.40

24%

0-5

100

40

17%

(40/100) * 0.17

6.8%

Yes/No

100

No

30%

(0/100) * 0.30

0%

Yes/No

100

Yes

45%

(100/100) * 0.45

45%

Managing Questions
1. Choose one of the following options:
n

To add a question, select a section tab under the Questions tab, click New, type
the question in the New Question dialog box, and click OK.

n

To add a description to a question, double-click the Description field, and type an
explanation of the question.

n

To define the possible answers to the question, double-click the Type field,
complete the fields in the Configure Question Options dialog box, and then click
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Done.
The KPI Order tab appears the first time you define an answer type as KPI.
n

To delete a question, select the question you want to delete, click Delete, and
then click Yes to dismiss the Delete Question dialog box.
Quality Management Administrator removes the question from the list.

2. If this form uses percentage-based scoring, change the score weights for each
question until they add up to 100% or click the Weigh Questions Evenly button.
3. Click Save.

Configure Question Options
The Configure Question Options dialog box allows you to configure the list of possible answers
for a question by:
1. Choosing one of the question option templates. These templates define the type of
answers that will be used for a specific question. You can choose from the following
options:
n

Yes-No—answers to questions are either yes, no, or not applicable.

n

0-5—answers to questions are based on a scale from 0-5 or not applicable.

n

Custom—allows you to create your own answers.

2. Adding or deleting questions.
3. Arranging the order in which answers appear by selecting an answer and using the up
or down arrows to move the answer to the correct location. In Quality Management
Workforce Optimization, the drop-down list for the question will display the answers in
the order shown in the Configure Questions Options dialog box.
Configure Question Options fields

Template Name
Question Option
Template

Description
The template associated with this question. Your options are:
n

Yes/No—The answer is in the form of yes, no, or N/A.

n

0 - 5—The answer is scored on a scale of 0 - 5 or N/A.

n

Custom—You determine the answer and how it is scored.

See Configure Question Examples for examples.
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Template Name

Description

Label

The text for the answer.

Type

The type of answer. The options are:

Value

n

Additive—Points for this option are added together to get the
final score, assuming no Key Performance Indicator (KPI)
options are selected. In Unified Workforce Optimization the
additive total will appear in Section Scores. KPI and Not
Applicable are excluded from this score in Sections Scores so
you can see what the score would have been had a KPI
answer not been selected.

n

Not Applicable—Ignore this answer by not including it in any
totals. For point-based scoring, this is similar to assigning a 0
point value. However, the Section Scores ignores this question. For percentage-based scoring, the question is removed
from the total possible points.

n

KPI—Changes the final score to be the value specified by this
option. This type of answer is used for questions that have a
negative or positive impact on the score. The KPI Order tab
appears the first time you define a answer type as KPI. See
KPI Order for more information.

The integer value associated with this answer. Essentially, this is
how much the answer is worth.
Percentage-based scoring—This is a whole number value. The valid
range of whole numbers are from 0 to 100.
Example: 20
Point-based scoring—This is an integer value that consists of natural
numbers (1, 2, 3...), zero (0), or the negatives of natural numbers (-1,
-2, -3, ...).
Example: -10
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Template Name
Default

Description
When selected, this check box indicates this is the default answer for
the question on the evaluation form.
Example: If an evaluator skips a question on the evaluation
form and clicks Complete to submit the completed evaluation,
the default answer for the skipped question appears in the
completed evaluation form.
A default answer is required.

Configure Question Examples
The following examples shows how to configure answers for each question option template.
In the following examples, any values that are greater than 100 or less than 0 apply only to
point-based scoring. Note that when creating an evaluation form for percentage-based
scoring, the range of values are limited to 0 to 100.
Example 1: If you want your answers to use a scale from 0-5 or Not Applicable (N/A),
select 0-5 from the Question Option Template drop-down list.

210

Recordings

Example 2: If you want answers to use Yes, No, or N/A, select Yes/No from the
Question Option Template drop-down list. You can also assign a Key Performance
Indicator (KPI) to one of the answers if the answer has a negative impact to your contact
center's business goals.
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Example 3: You can create a Custom template with +, 0, and - labels.
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Example 4: You can use the Custom template to add Yes or No answers and then
assign a KPI to the Yes answer and a value greater than 100 if you want to reward an
agent for a positive KPI result.
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Example 5: You can use the Custom template to add Yes or No answers and assign a
KPI to one of the answers.
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Example 6: You can use the Custom template to add descriptive words in the Label
column.
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Example 7: You can use the Custom template to add descriptive words in the Label
column and assign KPI to multiple answers.
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KPI Order
A KPI answer has an absolute impact on the final score. If multiple KPI answers are defined,
the KPI answers will be prioritized to determine which KPI answer will be used to determine
the final score. The KPI Order tab ranks KPI questions in order of priority.
Settings tab fields

Field

Description

Section

The name of the section where the KPI was found.

Question

The question in the evaluation form that has a KPI answer.

Option

The answer to the question that is associated with the KPI.
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Field
Order

Description
The order in which KPI answers are prioritized in the evaluation form. 1 is
the highest priority.
To change the priority order of a KPI question, select the KPI item from
the list and use the up or down arrows to move the KPI item to the correct
location.

Archive Workflows
This topic describes the Archive Workflow Administration window and provides tasks to create
and maintain archive workflows.

Allowing Access to Archived Recordings
Use this task to allow agents and knowledge workers access to their archived recordings.
1. In the navigation tree, select the Recordings > Archive node.
The Archive Recordings Administration window appears.
2. To allow agents or knowledge workers access to their own archived recordings, select
the Allow Agents To Access Archive check box.
3. Click Save.
The Recordings application appears in the Unified Workforce Optimization when
agents and knowledge workers log on.

Archive Workflow Administration
Use the Workflow Administration window to create archive workflows based on team. The
archive workflow includes specific rules and classifiers to designate the types of contacts you
want to record. These calls will be recorded for archive purposes, unless later tagged as quality
management calls.
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Field

Description

Archive
Workflows

Lists the existing archive workflows. To modify the workflows
that appear in this list, choose one of the following options.
n

New—add a new workflow to the list.

n

Rename—change the name of an existing workflow.

n

Delete—remove a workflow from the list.

Rename and Delete are enabled when you select an archive
workflow from the list.
Name

The name of the archive workflow.
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Field
State

End of
Day

Description
The status of the workflow. The Possible states are as follows:
n

Active—The entire workflow can be modified.

n

Inactive—The modifiable parts of the workflow are
limited to the fields under Archive Uploads and
Recording Retentions.

The End of Day is when the uploading process begins.
Recording still continues, but those recordings are uploaded
after the next End of Day. Enter the time for the end of the
work day in 24-hour format.
If the options are changed during the day, they do not go into
effect until the archive workflow is reloaded just before the
End of Day.

Immediate
Voice
Upload

When this check box is selected, audio recordings associated
with this workflow are immediately uploaded after the
recording completes. When the check box is clear, the normal
upload setting rules are in effect. This option applies to all
recording types.
If you change the Immediate Voice Upload option during the
day, the change does not go into effect until the archive
workflow is reloaded after the End of Day.
For Desktop Recording, it is possible that audio recordings
waiting for upload can be lost if an agent’s PC crashes.
Enabling immediate uploading prevents this problem.
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Recording
Retentions

Set the length of time you want the various types of recordings
to be retained.

Available
Teams

Available teams appear in this list.
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Field

Description

Assigned
Teams

Teams assigned to this archive workflow appear in this list. A
team can belong to only one archive workflow at a time.
Note: A team can belong to one archive workflow and
one quality management workflow.

Creating an Archive Workflow
Use this task to create a new archive workflow.
1. In the navigation tree, select Recordings > Archive > Workflows.
The Archive Workflow Administration window appears.
2. Next to the Archive Workflows section, click New.
The Archive Workflow Name dialog box appears.
3. Enter a name for the new archive workflow, and then click OK.
The workflow now appears in the Archive Workflows section.
4. Select the archive workflow in the Archive Workflows section.
5. In the Archive Upload section, enter the time for the end of the work day in 24-hour
format.
6. To upload audio recordings as soon as a call is completed, select the Immediate Voice
Upload check box in the Archive Upload section.
7. Set the length of time you want to retain recordings marked by agents.
l

Tagged—recordings that have been marked by an agent for retention.

l

Archive—all other recordings.

8. Assign teams to the archive workflow.
A team can belong to only one archive workflow at a time. If a team you want to assign
to this archive workflow is already assigned to another archive workflow, it is
automatically reassigned to this archive workflow. A warning message is displayed
telling you that the team is being reassigned from another archive workflow.
9. When you are done configuring the archive workflow in this window, click Save.
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Setting Up Classifiers for an Archive Workflow
Classifiers are filters that determine which calls are recorded. Use this task to set up classifiers
for an archive workflow.
1. Under the Archive > Workflows node, select the workflow you just created.
The Archive Workflow Classifier Configuration window appears.
2. In the Classifiers section, click New to create a new classifier.
The Classifier Name dialog box appears.
3. Enter a name for your new classifier, and then click OK.
The new classifier now appears in the classifier navigation tree.
4. In the Classifier Settings section, select one of the following options.
n

Record—select this option to upload recorded calls.
If you select Record, you must select the call direction you want to record
(Inbound, Outbound, or both). You must select at least one call direction.

n

Don’t Record—select this option to exclude specific phone numbers or area
codes from recording.

5. Select the type of number you want to use to filter the calls.
n

Called Number—if the call is inbound, the Called Number is the route point
number if the call was routed, or the agent extension if the call was direct call. If
the call is outbound, the Called Number is the number of the customer/client.

n

Calling Number—if the call is inbound, the Calling Number is the original number
from which the caller is dialing. If the call is outbound, the Calling Number is the
agent’s extension.
Note: If you add phone numbers to the Called Number section, then
select Calling Number from the Numbers drop-down list, Quality
Management Administrator deletes the phone numbers you added. The
reverse is also true. If you add phone numbers to the Calling Number
section, then select Called Number from the Numbers drop-down list,
Quality Management Administrator deletes the phone numbers you
added.

n

222

Line—The extension the agent used to answer the call.
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6. Click Add to specify the phone numbers you want to filter.
The Number dialog box appears.
7. Enter the numbers you want to filter. You can enter:
n

Specific numbers
EXAMPLE: 6125551212

n

Number ranges using wildcards
EXAMPLE: 612*, where the * wildcard represents any number of digits,
or 612555????, where the ? wildcard represents a single digit.

n

The * wildcard to record all calls

The numbers cannot contain dashes or parentheses, and must be between 1 and 16
characters long.
8. Click Save to save the classifier settings.

Managing Archive Workflows
n

To edit an existing archive workflow, select the workflow you want to modify under
Archive > Workflows, complete your changes, and then click Save.
Quality Management Administrator saves the changes to the modified workflow.
The modified workflow goes into effect after the agents assigned to the workflow log out
and log back in to their Windows session, or after the configured End of Day.

n

To delete an archive workflow, select the workflow you want to delete under Archive >
Workflows, click Delete, and then click Yes to dismiss the Confirm Deletion dialog box.
Quality Management Administrator deletes the archive workflow and the status of the
workflow changes to Inactive. The deleted workflow goes into effect after the agents
assigned to the workflow log out and log back in to their Windows session, or after the
configured End of Day.
Note: Once a workflow is deleted, you cannot adjust the retention times for calls
associated with the workflow or reactivate the workflow.
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User-Defined Metadata
Administrators can add up to 30 user-defined metadata fields. The metadata can be captured
from Unified CCX, Cisco Agent Desktop (CAD), and other applications to pass the data to the
Quality Management API.
The CAD IPC Action can also be used to pass data to Quality Management. See the Cisco
CAD Desktop Administrator User Guide for more information.
Use the User-Defined Metadata window to create and maintain metadata fields. You can
define up to 30 metadata fields.
These metadata fields appear in the Contact Information tab on the Media Player in Unified
Workforce Optimization in the same order they appear in the User-Defined Metadata window.
You can configure the order in which the metadata appears by selecting a row and using the
Up and Down arrows to move the selected metadata.
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Field
Display Name

Description
The metadata field name appears in the search results and the
contact information.
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Field
Key Name

Description
A unique identifier for the metadata field. APIs use the unique
identifier for the metadata field.
The unique identifier allows a maximum of 39 characters. The Key
Name field does not allow the following characters.
n

space

n

& (ampersand)

n

= (equal sign)

Important: The key name must be unique. If you create a key
name for a metadata value that duplicates an existing field
name, you will not be able to add a search filter for that key
name under the Recordings application in Unified Workforce
Optimization. See Reserved Words for a list of words that
cannot be used as key names.

Type

Encrypted

Identifies the type of information contained in the metadata field. The
available types are:
n

Text

n

Number

n

Date

n

HyperLink

When selected, this check box indicates Quality Management
encrypts the metadata when stored. The Exportable check box is
disabled if you select the Encrypted check box.
Note: You cannot search for encrypted metadata in Unified
Workforce Optimization.

Exportable
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When selected, this check box indicates you can export the metadata
via an API or Unified Workforce Optimization. This check box is
selected by default.
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Field
Read Only

Description
When selected, this check box indicates the metadata is read only.

Reserved Words
Important: The key name must be unique. If you create a key name for a metadata
value that duplicates an existing field name, you will not be able to add a search filter for
that key name under the Recordings application in Unified Workforce Optimization.
The following words are reserved for Quality Management and cannot be used as a key name
for a metadata value.
n

acd_login_status

n

agent_displayId

n

ani

n

approved_by

n

assocCallIdCount

n

call_duration

n

call_line

n

call_state

n

called_number

n

calling_number

n

contact_type

n

date

n

direction

n

dnis

n

evaluation_calibration

n

evaluation_date

n

evaluation_form_name

n

evaluation_score
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n

evaluation_state

n

evaluator_name

n

first_name

n

from_address

n

group_name

n

hasScreen

n

hasVoice

n

hr

n

id

n

isInbound

n

last_name

n

license

n

line

n

pc_hostname

n

phone_extension

n

qm_login_status

n

quality_reason

n

recording_last_failed

n

recording_last_failed_cause

n

recording_last_screen_status

n

recording_last_successful

n

recording_last_voice_status

n

recording_type

n

screen_recording_ip

n

silence_average_duration

n

silence_max_duration

n

silence_min_duration

n

silence_percent_of_call
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n

silence_total_duration

n

silence_total_events

n

site_name

n

subject

n

talkover_average_duration

n

talkover_max_duration

n

talkover_min_duration

n

talkover_percent_of_call

n

talkover_total_duration

n

talkover_total_events

n

team_name

n

testfield

n

time

n

to_address

n

training

n

tz

n

voice_recording_ip

Managing Metadata Fields
n

To add a metadata field, select the Recordings > Metadata node, click Add, complete
the fields, and then click OK to dismiss the Add/Edit Metadata Information dialog box.

n

To edit a metadata field, select the Metadata field you want to edit from the User-Defined
Metadata window, click Edit, complete your changes, and then click OK to dismiss the
Add/Edit Metadata Information dialog box.
Your changes appear in the list of metadata fields on the User-Defined Metadata
window.

n

To delete a metadata field, select the Metadata field you want to remove from the UserDefined Metadata window, click Remove, and then click Yes to dismiss the Confirm
Deletion dialog box.
Quality Management Administrator deletes the metadata.
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n

To sort the order in which the metadata appears, select a row, use the Up or Down
arrow to move the metadata row to where you want it to appear. Repeat this step until all
metadata rows appear in the desired order.

Interface Settings
Interface settings allows you to configure the default time format at the global level and enable
export permissions.
Quality Management Administrator enables the Live Screen Monitoring feature by default. You
can choose to disable Live Screen Monitoring the Interface Settings window.
Quality Management Administrator disables the recordings export feature by default. From the
Interface settings window, you can enable the export of recordings by role.
Customer conversations are stored in a format that can be played only by Quality
Management. However, recordings can be exported from the Recordings application in
Unified Workforce Optimization. The recordings can be exported in the following formats:
n

WAV format (uncompressed audio)

n

MP4 (compressed audio/video)

These formats are playable in other playback software (such as Windows Media Player).

Call Events Administration
The Call Events Administration window allows you choose the type of recording events you
want Quality Management to mark in a recording. When enabled, a Unified Workforce
Optimization user can search for recordings that have the specified silence or talkover events
from the Recordings application.
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Field
Save
TalkOver
Events

Description
When selected, Quality Management saves information about
talkover events. The Save TalkOver Events check box is clear
by default.
A talkover event is a time when both parties on the call are
talking simultaneously.
Changes to this event configuration take effect after the next
End of Day.

TalkOver
Event
Minimum
Duration

The minimum amount of time in seconds for a talkover event.
Quality Management only saves information about talkover
events with a duration that is equal to or greater than the
number of seconds specified in this field. You can specify from 1
to 3600 seconds (1 hour). The default is 10 seconds.
This threshold setting is used during after-call processing and
applies to all calls. If you change this setting, all previously
processed calls use the older threshold settings.
Using a low threshold (for example, 3 seconds) stores more
information about events than a high threshold (for example, 30
seconds). If you specify a 30 second threshold, a user cannot
search for recordings with talkover events that are under 30
seconds. Quality Management does not save information about
talkover events below the specified minimum duration.

Save
Silence
Events

When selected, Quality Management saves information about
silence events. The Save Silence Events check box is clear by
default.
A silence event is a time when neither party on the call are
talking.
Changes to this event configuration take effect after the next
End of Day.
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Field

Description

Silence
Event
Minimum
Duration

The minimum amount of time in seconds for a silence event.
Quality Management only saves information about silence
events with a duration that is equal to or greater than the
number of seconds specified in this field. You can specify from 1
to 3600 seconds (1 hour). The default is 10 seconds.
This threshold setting is used during after-call processing and
applies to all calls. If you change this setting, all previously
processed calls use the older threshold settings.
Using a low threshold (for example, 3 seconds) stores more
information about events than a high threshold (for example, 30
seconds). If you specify a 30 second threshold, a user cannot
search for recordings with silence events that are under 30
seconds. Quality Management does not save information about
silence events below the specified minimum duration.

Improving Detection of Silence and Talkover Events
The adaptive Voice Activity Detector (VAD) algorithm uses is very robust and accurate under
normal phone call situations. In this case, normal means:
n

Minimal to no background noise for both parties on a call

n

Good audio quality

n

One party for each side of a call

n

Each party speaks at normal volume

The adaptive VAD algorithm has been proven to be 90% accurate through testing under
moderately noisy conditions. It can handle background noise (for example, white noise) quite
well. Rapid changes in volume and frequency of any background noise can cause inaccuracies
as the algorithm adapts to the noise. A constantly changing background noise (for example, a
radio playing loudly) will prevent the adaptive VAD algorithm from working, and the results will
be inaccurate.
Set minimum threshold values for silence and talkover events that are meaningful to your call
center. The threshold values define the granularity of the searches you can run on recorded
calls.
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EXAMPLE: If you set the minimum duration for a Save Talkover Event to 10 seconds,
the user cannot search for recordings with any talkover events of 5 seconds or less
because Quality Management only saves talkover events that are 10 seconds or
greater. If your users require greater granularity when searching for a silence or talkover
event, then lower the value for the minimum duration of the event.
If your call center does not fit the definition of normal given above (for example, there is a lot of
background noise), it might be better to use shorter minimum durations for silence events to
account for the noise interfering with correctly identifying silence events. In a noisy
environment, it might not be possible to have a 20-second silence event since a background
noise will usually break a contiguous period of silence during a call. For a noisy call center,
consider setting the minimum duration of a silence event to 3 seconds for better results. A noisy
call center usually results in less overall accuracy for the identification of silence events.
Another tactic you can use to identify silence events in a noisy call center is to modify your
search. For example, instead of searching for recordings with a single occurrence of a silence
event that is 25 seconds or greater, consider searching for recordings with five or more
occurrences of silence events that are 6 seconds or greater. This type of filtering takes into
account the shorter, but more frequent silence events that can be found in a noisy environment.

Handling Pause and Hold when Searching for Silence or Talkover
events
When a user searches for a silence or talkover event, Quality Management does not include
pause and hold events in the search. If a silence event occurs just prior to a pause or hold
event, Quality Management saves information about the silence event if the event meets or
exceeds the minimum threshold for the event. Quality Management does not look for silence or
talkover events when a call is paused or on hold.

Configuring Recording Events
Use this task to configure silence and talkover events.
1. In the navigation tree, select the Recordings > Call Events node.
The Call Events Administration window appears.
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2. To save information about talkover events, select the Save TalkOver Events check box,
and enter the duration of the event in seconds in the TalkOver Events Minimum Duration box.
3. To save information about silence events, select the Save Silence Events check box,
and enter the duration of the event in seconds in the Silence Events Minimum Duration
box.
4. Click Save.
The Recordings application in Unified Workforce Optimization allows users to search
for recordings with silence and talkover events in a customer conversation.

Desktop Configuration Administration
Desktop Configuration Administration controls the fields that appear in the Recordings
application for Unified Workforce Optimization for all roles.
The available fields appear under the following categories:
n

Organization Fields

n

Evaluation Fields

n

Date Fields

n

Contact Fields

n

Analysis Fields

n

User Defined Metadata Fields
When you add a new metadata field, it appears in the Show Columns list by default,
unless modified by the Quality Management Administrator. On upgrade, the existing
metadata files appear in the Available Columns list, unless modified by the Quality
Management Administrator.

Field
Available
Columns
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Description
Lists the columns that will not appear in the Recordings table in Unified
Workforce Optimization. Fields in the Available Columns list always appear in
alphabetical order.

Recordings
Field
Show
Columns

Description
Lists the columns that will appear in the Recordings Applications under
Contacts table in Unified Workforce Optimization and the search fields. You
can configure the order in which fields appear in this list using the arrow keys.
Note: Agents, knowledge workers, and supervisors can only view and
search columns that appear in the Show columns. Managers,
evaluators, and archive users can search all columns.

Organization Fields
The Organization Fields tab lists the available fields. All fields appear in the Show Columns list
by default.
Field

Definition

Agent
ID

The agent’s ID. Only the Agent ID field can be moved between
Available Columns and Show Columns.

First
Name

The agent’s first name. This field always appears in the Show
Columns list.

Group
Name

The name of the group. This field always appears in the Show
Columns list.

Last
Name

The agent’s last name. This field always appears in the Show
Columns list.

Team
Name

The name of the team. This field always appears in the Show
Columns list.

Evaluation Fields
The Evaluation Fields tab lists the available fields. All fields appear in the Show Columns list by
default.

235

Recordings
Field

Definition

% Score

The evaluation score given to the contact.

Approved By

The name of the manager or supervisor who approved
the evaluation.

Date Evaluated

The date when the customer conversation was
evaluated.

Evaluation
Calibration

The contact evaluation is marked for calibration.

Evaluation
Form

The name of the evaluation form used to score the
customer conversation.

Evaluator
Name

The name of the evaluator.

Date Fields
The Date Fields tab lists the available fields. All fields appear in the Show Columns list by
default.
Field

Definition

Date

The contact date. This field always appears in the Show Columns
list.

Time

The time of the contact. This field always appears in the Show
Columns list.

Time
Zone

The time zone where the contact was recorded. Only the Time
Zone field can be moved between Available Columns and Show
Columns.

Contact Fields
The Contact Fields tab lists the available fields. All fields appear in the Show Columns list by
default.
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Field

Definition

Associated Call
Count

The number of associated contacts for this call.

Call Duration

The duration of the contact (length of time between call answered and
call dropped) in HH:MM:SS.

Call Inbound

The call is inbound. The valid values in the Call Inbound field are:
n

Yes

n

No

Called Number

The number of the phone that received the call. Displays “unknown” if
the called number is unlisted or blocked. This field always appears in the
Show Columns list.

Calling Number

The number of the phone that made the call. Displays “unknown” if the
calling number is unlisted or blocked. This field always appears in the
Show Columns list.

Contact Type

The type of contact. The valid values in this field are:

Has Screen

Has Voice

n

Call—a contact with a call recording

n

Non-Call—a contact without call recording

The contact has a screen recording. The valid values in the Has Screen
field are:
n

Yes

n

No

The contacts has a voice recording. The valid values in the Has Voice
field are:
n

Yes

n

No
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Field
HR
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Definition
The contact has been marked as an HR contact. The valid values in the
HR field are:
n

Yes

n

No

ID

The contact’s ID.

Line

The extension the agent used to answer the call. This field always
appears in the Show Columns list.

Reason

The reason the contact was recorded as set in the recording rule
(Archive, First, Last, Longest, Shortest, Random, Logging, Tagged,
Performance, and New Employee).

Recording Type

The recording type associated with this device. The valid value in the
Recording Type field are:
n

Server Recording—contact was recorded using Server
Recording (SPAN).

n

Network Recording—contact was recorded using Network
Recording.

n

Multiple Registration—contact was recorded using Multiple
Registration method. This method allows you to
programmatically add participants to an existing call.

n

Single Step Conference—contact was recorded using Single
Step Conferencing method. This method allows you to choose up
to three devices at a single, softphone-enabled extension.

n

Unknown—contact was recorded prior to 8.7 or the recording
type could not be determined.

n

Endpoint—contact was recorded using Endpoint recording.

n

MediaSense Recording—contact was recorded using Cisco
MediaSense Recording.

Recordings
Field

Definition

State

The current evaluation state of the recording. The valid values in the
State field are:
n

Scored—contacts that are claimed by an evaluator, fully scored,
and, if approval is required, are approved.

n

Unscored—contacts that are as yet unclaimed by an evaluator
and unscored.

n

In Progress—contacts that are claimed by an evaluator but which
are not yet completely scored

n

Needs Approval—contacts that are claimed by an evaluator, are
fully scored, and are awaiting approval.

This field always appears in the Show Columns list.
Training

The contact has been marked as a training contact. The valid values in
the Training field are:
n

Yes

n

No

Analysis Fields
The Analysis Fields tab lists the available fields. Only Silence Events and Talk Over Events
appear in the Show Columns list by default.
Field

Definition

AVG Silence

The average silence time in HH:MM:SS.

AVG Talk Over

The average talkover time in HH:MM:SS.

MAX Silence

The duration of the longest silence event that was
detected in HH:MM:SS.

MAX Talk
Over

The duration of the longest talkover event that was
detected in HH:MM:SS.
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Field

Definition

MIN Silence

The duration of the shortest silence event that was
detected in HH:MM:SS.

MIN Talk Over

The duration of the shortest talkover time that was
detected in HH:MM:SS.

PCT Silence

The percentage of detected silence time.

PCT Talk Over

The percentage of detected talkover time.

Silence Events

The number of detected silence events.

Talk Over
Events

The number of detected talkover events.

TOT DUR
Silence

The total duration of silence time in HH:MM:SS.

TOT DUR Talk
Over

The total duration of talkover time in HH:MM:SS.

User Defined Metadata Fields
The user-defined metadata fields appear in the Available Columns list by default. Text is the
only metadata field that appears in the Available Columns list by default until you configure your
own metadata fields. See User-Defined Metadata for information on adding your own
metadata fields.
The Date field always appears in the Show Columns list.

Assigning Columns
1. In the navigation tree, select the Recordings > Desktop Configuration node.
The Recordings Contact Information tab on the Desktop Configuration Administration
window appears.
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2. Choose one of the following tabs:
l

Organization Fields

l

Evaluation Fields

l

Date Fields

l

Contact Fields

l

Analysis Fields

l

User Defined Metadata Fields

3. Choose one of the following options to configure the fields that will appear in Unified
Workforce Optimization.
l

To move all columns to the Available Columns list, click <<.

l

To move all columns to the Show Columns list, click >>.

l

l

l

l

To move multiple contiguous columns to the Available Columns list, click the first
column and shift-click the last column you want from the Show Column list and
then click <.
To move multiple contiguous columns to the Show Columns list, click the first
column and shift-click the last column you want from the Available Column list
and then click >.
To move multiple non-contiguous columns in the Available Columns list to the
Show Columns list, use the Ctrl key to select each column, and then click >.
To move multiple non-contiguous columns in the Show Columns list to the
Available Columns list, use the Ctrl key to select each column, and then click <.

Columns in the Available Columns list always appear in alphabetical order.
4. Click Save.

Recording Visibility Administration
Recording Visibility Administration controls how long customer conversations are visible in the
Recordings application by role. When the time expires for a customer conversation, that
recording is no longer available to the user.
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Note: Specifying how long customer conversations are visible does not effect retention
time. The customer conversation is not deleted when the visibility setting expires. The
customer conversation will still be available based on its retention time, but it will not be
visible to the user for playback in the Recordings application.
When configuring visibility of customer conversations by role, note the following:
n

The state of a recording has no impact on the visibility
Example: Scored, Unscored, In Progress, or Needs Approval

n

Tagging a contact for HR or Training does not override the visibility setting

n

If a user is assigned multiple roles, the longest visibility setting is used

n

All references to the contact remains in reports, and dashboard widgets
Field

Days

Unlimited
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Description
The number of days the customer conversation is visible in the Recordings
application by role. The time is defined by the date and time when the call
was recorded and the date and time when user logged into Unified
Workforce Optimization to view and play back the customer conversation.
This field is enabled when the Unlimited check box is cleared. The defaults
are as follows:
n

Agent—7 days

n

Knowledge Worker—7 days

n

Supervisor—14 days

n

Manager—21 days

n

Evaluator—14 days

n

Archive User—21 days

When selected, the customer conversations are always visible. If you clear
the check box, you must specify the number of days the customer conversations will be visible in the Recordings application.
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